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Workflow
Welcome to the HX Edit Pilot’s Guide. This guide contains details of the HX Edit v.3.70 
application’s features and functionality with Line 6® Helix® devices (Helix, Helix Rack, 
and Helix LT), as well as with HX® devices (HX Stomp™, HX Stomp XL, and HX 
Effects™). All behaviors are the same on Mac and PC computers unless otherwise 
noted. It is recommended that you also read the Owner’s Manual for details on using 
your particular device.

What’s in it for Me?
HX Edit is a simple, but powerful, editor, preset librarian, and IR manager application. It 
allows you to easily customize, backup, and manage your tone presets and setlists, as 
well as manage the Impulse Responses on your Line 6 Helix or HX device.

HX Edit version 3.70  is the editor/librarian software for use with all Helix (Helix, Helix 
Rack and Helix LT) or HX (HX Stomp XL, HX Stomp, and HX Effects) devices that are 
running firmware version 3.10 (or later).* For best performance, it is recommended to 
use the latest available versions for your HX Edit application, drivers, and device 
firmware (as well as for the Helix Native software, if you’re using it). If for any 
reason you wish to use an earlier firmware in your device, or an earlier HX Edit software 
version, you’ll need to be sure the release versions of the firmware and software match 
for full functionality.

*IMPORTANT! Your Helix or HX device must be running a firmware version no earlier 
than 3.00 to be able to use it with HX Edit version 3.70 (the latest available firmware 
and HX Edit version are recommended). 
If you’re currently using HX Edit v3.00 or later, simply connect your Helix or HX Device 
to your computer with an active Internet connection and launch HX Edit. Its integrated 
Updater will find and walk you through installing the latest HX Edit and device 
firmware versions in minutes—see “Updater & Additional Resources” on page 84.

NOTE: Each Helix or HX device model offers a different set of inputs, outputs, and signal 
flow capabilities. Throughout the following chapters, we’ve indicated HX Edit app 
functionality that is specific to your Helix or HX device type.

Marketplace
Be sure to visit the Line 6 Marketplace online shop, where you’ll find 3rd-party add-on 
assets that further enhance the functionality of your Helix and HX devices, as well 
as Helix Native plugin! As of this writing, professionally crafted presets and IRs are 
available—check back often on Marketplace for product news and announcements. An 
Internet connection is required for the computer on which you’ll be using the HX Edit 
app to authorize it for the use of Marketplace premium assets. Please see “Marketplace 
& Account Options” on page 54.

Workflow Overview
Once the HX Edit app is launched, it automatically syncs all presets and IRs from your 
Helix or HX device’s internal memory. You’ll see your device’s presets & IRs displayed 
in the Librarian panels at the left. This allows you to export presets and IRs to create 
a virtually unlimited library on your computer, and then import them onto your device 
at any time. These Librarian panels also allow you to easily rename and reorder your 
presets and IRs, and the Create & Restore Backup feature makes it simple to create full 
backups that can be restored to your Helix or HX hardware in minutes.

You will also see your currently loaded preset’s contents displayed in the Editor panels 
on the right. This allows you to load & fully customize your presets, configure bypass & 
controller assignments, and create & edit snapshots. While connected, communication 
between the application and your connected device’s internal memory is instantaneous. 
Changes you make to any parameters in the Signal Flow or Inspector Windows, as 
well as any changes to presets, setlists, and IRs within the Librarian, are immediately 
reflected on the device, and vice-versa.
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This interactive communication allows you to tweak your presets and setlists in real-
time, without the need to send/receive or manually sync to the device.

WARNING: Be careful when overwriting presets or IRs—these changes cannot be reverted! 
You can use the Create & Restore Backups feature to back up your Helix or HX device’s 
contents before making changes. See “Creating & Restoring Complete Device Backups”.

Computer Connectivity
To put the HX Edit application to work, connect your Helix or HX device to your 
computer’s USB 2 (or higher) port. 

NOTE: If on Windows®, be sure to have the latest Line 6 drivers installed for your device. 
No driver installation is necessary on Mac computers.

It is highly recommended to install all included drivers when running the latest Windows HX 
Edit application installer—all drivers are already selected to be installed by default. The 
latest HX Edit application installer is available at line6.com/software/.

http://line6.com/support/manuals/
https://line6.com/marketplace/
https://line6.com/software/
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Exit any other Line 6 applications that may be running. With your Helix device 
powered on, launch HX Edit.

•	 Mac: Go to Applications > Line 6 > HX Edit

•	 Windows: Go to the Start button menu > All Apps (or Programs) > Line 6 > HX 
Edit

Upon launch, the application will detect Helix hardware and automatically retrieve and 
display its onboard presets, IRs, and Favorites. This may take a moment to download 
all of the preset information. 

Multi-Device, Multi-Window Support
The HX Edit application supports the use of multiple-connected Helix/HX devices 
simultaneously, where each device displays its own full application window. The 
separate windows can be resized and/or positioned on your screen independently, 
making it easy to reference and edit presets and settings, as well as copy presets and 
IRs between the multiple USB-connected devices. Please also see “GUI Overview” on 
page 9.

TIP: You can also use the Copy and Paste commands or drag and drop to copy a block 
and its current settings from one HX Edit device window to another!

To access the separate application windows for each connected device, simply go to 
the HX Edit Devices menu, select the desired device to display, and bring its HX Edit 
window to the foreground—a checkmark at the left of a device here indicates the device 
window that is currently in the foreground. If any of your devices become disconnected, 
its entry within this menu displays “Not connected” to indicate this.

The Devices menu, showing two connected devices, and the Helix Floor window in the foreground

You’ll see an indicator at the bottom of each application window displaying its connected 
Helix/HX device type—or a warning that no device is detected.

Device indicator at bottom of the HX Edit main window

Each device’s HX Edit window also includes its own Command Center and Global EQ 
floating windows as well (for devices that include these features)—see “The Command 
Center Window” on page 46 and “Global EQ Window” on page 50.

NOTE: On macOS computers, closing all open device windows does not exit the HX Edit 
application. As is common with multi-window supporting macOS apps, you’ll need to use 
the Quit HX Edit command from the main HX Edit menu (or better, just train yourself to use 
the Cmd+Q shortcut).
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Preset Compatibility
This guide covers version 3.70 of the HX Edit application. The easiest way to ensure the 
best performance and compatibility between HX Edit and your Helix or HX device is to 
make sure to have the latest updates. The HX Edit application will automatically check 
for, and walk you through installing, the latest firmware update for your connected Helix 
or HX device (see “Updater & Additional Resources” on page 84). An active Internet 
connection is required. 

Helix preset files are transferable between Helix devices (Helix, Helix Rack and Helix 
LT), as well as with the Helix® Native plugin software.* Additionally, HX Edit and Helix 
Native both include Preset Translation functionality, and Helix Native further includes 
selectable Hardware Compatibility modes. As covered throughout this chapter, these 
features allow many presets to be shared between any Helix and HX (HX Stomp XL, HX 
Stomp, and HX Effects) type devices, and with Helix Native. 

*IMPORTANT! Presets saved or exported from HX Edit, Helix/HX devices, and Helix 
Native version 3.50 (or later versions) are not compatible with earlier versions. We highly 
recommend exporting and keeping backup copies of all your presets before updating to 
the latest software or firmware version.

TIP: It is also possible to Copy and Paste, or drag and drop individual blocks, along with their 
current settings, between Helix Native and HX Edit, as well as between multiple HX Edit device 
windows—see “Block Copy and Paste” on page 7.

Preset Compatibility with Helix Native Plugin
All your Helix and HX device presets, setlists, and bundles are compatible between 
the HX Edit app (v3.50 or later) and Helix Native plugin (v3.50 or later), by way of the 
Helix Native Hardware Compatibility mode (HC mode) functionality. As noted above, 
presets exported or saved with Helix/HX device firmware and Helix Native v3.50 are not 
compatible with earlier versions. 

Once a preset (or setlist or bundle) is exported from your device using HX Edit, 
upon import, Helix Native determines the device type from which it was created and 
automatically changes the plugin’s HC mode to match the device, thus fully supporting 
the complete tone. Likewise, presets exported from Helix Native plugin’s matching HC 
mode are fully compatible with your Helix or HX device.

Helix Native also offers Preset Translation functionality (also offered in HX Edit—see 
the next section). When loading a preset into Helix Native as the current tone (such as 
by dragging a preset from the HX Edit Presets Library or a computer folder directly into 
the Helix Native Signal Flow), a prompt is offered to either change the plugin’s HC mode 
to match the preset’s source format, or to attempt to translate to match the current 
plugin HC mode. 

This preset compatibility is the foundation of the Line 6 “Studio to Stage” concept, 
allowing you to load, edit and transfer your tones between HX Edit and Helix Native 
plugin! Note that Helix Native plugin maintains its own Preset & IR libraries, independent 
of the presets and IRs that reside within your Helix hardware. For more information, 
please see the Helix Native Pilot’s Guide.

TIP: If you also own Helix Native plugin - be sure to reference the “Helix compatible” 
version number (found in the Helix Native software’s About box) to determine the 
recommended Helix/HX device firmware version you should use for maximum preset 
compatibility. It is highly recommended to always use the latest available device firmware 
and HX Edit and Helix Native software.

Since the different Helix device types include different physical inputs and outputs, 
some variances exist among settings, as well as for their support of block types & 
controllers, which may affect the sharing of presets between devices, or between HX 
Edit and Helix Native plugin. The following sections in this chapter provide details about 
sharing presets and settings.

Preset Translation
When importing a preset into the HX Edit Presets Library, the application automatically 
detects the source device from which it was created (Helix, HX Effects, HX Stomp, or 
HX Stomp XL).

NOTE: As covered in the previous section, if the preset attempting to be imported was 
exported from Helix Native, the Hardware Compatibility mode of the preset determines its 
source device type format.

If the HX Edit app window’s currently connected device is different that the preset’s 
source device, the app will attempt to translate the preset to the current device format. 
If translation is successful, the preset is imported into the current device’s library. 

Presets cannot be translated if created with a source device (or Helix Native HX mode) 
which includes features or capabilities that exceed those of the current device (e.g., 
greater signal path count, exceeds maximum block count or type, etc.) If the preset 
cannot be translated, an error window lets you know the preset is not compatible and 
why, and import is cancelled. For example, if attempting to import a Helix exported 
preset which includes an Amp model into an HX Effects device (HX Effects includes no 
support for Amp models), translation is not possible and the following error is displayed.

Error message displayed when a preset cannot be translated on import

https://www.line6.com/manuals
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Feature Comparison Table
The following table shows the primary feature differences that affect preset translation between the Helix and HX hardware types. Additionally, Helix Native offers a HC mode Off 
option. When this Off mode setting is in us in Helix Native, the preset has fewer restrictions for block types and DSP limits. Therefore, presets exported from this Off mode can exceed 
the capabilities of any Helix or HX device. You can consult this table to determine if a preset from one source device (or Helix Native HC mode) will be able to be translated to other 
devices. See the Preset Translation Compatibility table for more info. 

HC Mode / Device Feature Comparison

Feature
Off

(Helix Native only) 
Helix HX Stomp XL HX Stomp HX Effects

Included 
Models* Full set of v.3.70 Helix models. Full set of v.3.70 Helix models,  

except 6 Switch Looper.

Blocks Per Path Capacity 16 16 8 8 9

Max. Block Type Per Path None

2 Amps,
2 Single Cabs or 1 Dual Cab.* 

2 Single 1,024 IRs, 1 Single 2,048 IR, or one Dual IR.
1 Poly Pitch effect.†

Max. DSP Limit None Same as Helix device. Same as  
HX Stomp XL device.

Same as  
HX Stomp device.

Same as  
HX Effects device.

Snapshots 
Per Preset 8 8 4 3 4

Preset Library 
(independent per HC mode)

8 Setlists for up to 1,024 Presets.
4 Presets per Bank. 

Bundle support included.

1 Setlist for up to 128 
Presets.

4 Presets per Bank.

1 Setlist for up to 126 
Presets.

3 Presets per Bank.

1 Setlist for up to 128 
Presets. 

4 Presets per Bank.

IRs Library
Favorites Library 

(shared between HC modes)
Holds up to 128 each, User IRs & Favorites 

* Legacy and factory IR-based Cab type blocks’ max. counts are mutually exclusive—you can combine these amounts of both types on the same path (permitting you do not exceed the path’s DSP limit). 
The factory IR-based Cab and IR type blocks share the max. count of 2 Single or 1 Dual per path. Also see “DSP Limit and Model Availability” on page 35.

† Poly Pitch type effects are those that utilize polyphonic pitch processing: Delay - Poly Sustain, Modulation - Poly Detune and Pitch/Synth - Poly Pitch, Poly Wham, Poly Capo, and 12-String.

NOTE: Likewise, if importing multiple presets at once, a setlist, or a bundle, where one or more presets are not able to be translated to the current device, the non-translatable presets display an 
error window and are not imported, while the eligible presets are successfully translated and imported.

Input and output block options and controller support also differ among the Helix and HX device types (e.g., HX devices include no Variax input or EXP 3 pedal options as Helix 
devices do). These non-compatible features do not prevent preset translation. Typically, non-compatible input and output block settings are translated to the common Main In or Main 
Out, and non-supported controller assignments are removed from the preset.
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Preset Translation Compatibility Table
The following table provides an overview of the preset translation capabilities from each source device (or each source Helix Native HC mode).

Created With: HC Mode Off 
(Helix Native) 

Helix 
(Floor, Rack, LT) HX Stomp XL HX Stomp HX Effects

Helix Native  
HC mode = Off

If does not exceed Helix 
block count and DSP 

limits

If does not exceed HX 
Stomp XL Block and Path 

count, and DSP limits.
Snapshots greater than 4 

are discarded.

If does not exceed HX 
Stomp Block and Path 
count and DSP limits.

Snapshots greater than 3 
are discarded.

If does not exceed HX 
Effects Block type and 

Path count, and DSP limits.
Snapshots greater than 4 

are discarded.

Helix 
(Rack, Floor, LT)

or
Helix Native

HC mode = Helix

If does not exceed HX 
Stomp XL Block and Path 

count, and DSP limits.
Snapshots greater than 4 

are discarded.

If does not exceed HX 
Stomp Block and Path 
count and DSP limits.

Snapshots greater than 3 
are discarded.

If does not exceed HX 
Effects Block type and 

Path count, and DSP limits.
Snapshots greater than 4 

are discarded.

HX Stomp XL
or

Helix Native
HC mode = HX Stomp XL

Snapshots greater than 3 
are discarded.

If does not exceed HX 
Effects Block type and 

Path count and DSP limits.

HX Stomp
or

Helix Native
HC mode = HX Stomp

If does not exceed HX 
Effects Block type and 

Path count and DSP limits.

HX Effects
or

Helix Native
HC mode = HX Effects

Snapshots greater than 3 
are discarded.
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Feature Compatibility
The following sections provide details on the compatibility of the major features between 
device types, and between HX Edit and Helix Native.

HX Edit Backup Files
The HX Edit application includes a feature that creates Helix Backup (.hxb) files to 
restore a Helix or HX device’s presets, IRs, and global settings (see page 27). Helix 
Backup files are specific to each device type and, therefore, cannot be opened or 
utilized in HX Edit when a different source device is connected.

Helix Native plugin does not currently include this backup functionality and, therefore, 
does not support creating or opening Helix Backup .hxb files.

Block Copy and Paste
Using the Copy Block and Paste Block commands, you can copy and paste any 
block type between any presets within HX Edit, as well as between multiple HX Edit 
windows (with any Helix or HX device connected) and any instance of the Helix Native 
plugin. It is also possible to drag and drop any processing block to move it within the 
current preset, or to copy it into any other HX Edit device window. Restrictions apply 
when copying, pasting, and moving some block types, depending on the source Helix/
HX device (or source Helix Native HC mode) and the destination. Please see “Cutting, 
Copying, Pasting, and Clearing Blocks” on page 32.

Snapshot Copy and Paste
The current Snapshot, along with all its settings, can be copied and pasted using the 
Copy Snapshot and Paste Snapshot commands either within the current HX Edit 
preset or within the current Helix Native preset. Also, see “Configuring & Managing 
Snapshots” on page 24.

Command Center Copy and Paste
Within the Command Center window, once a command assignment is created for any 
footswitch, EXP Pedal, or other controller, you can use the Command Center’s Copy and 
Paste command options to copy assignments between controllers, as well as between 
controllers within other HX Edit presets within the current HX Edit device window.* 

Helix Native plugin does not include the Command Center, therefore, it is not possible 
to copy Command Center assignments between HX Edit and Helix Native. See “The 
Command Center Window” on page 46.

*TIP: As of firmware version 3.0, HX Stomp devices include the Command Center feature 
too!

Input & Output Block Settings
When Importing a Helix/HX hardware-exported Preset into HX Edit with a different 
device type connected - During preset translation, the Input and Output block settings 
are changed to “Multi” or “Main” if the connected device does not support the original 
options (also see “Preset Translation” on page 4).

When Importing a Helix Native-exported Preset into Helix/HX Hardware - All input 
and output blocks that were set to “Host” will default to the “Multi” setting within the 
Helix devices, and to the “Main” setting in HX devices. Any input block set to “None” will 
remain as set to “None” within the hardware. 

When Importing a Helix/HX hardware-exported Preset into Helix Native Plugin - All 
input and output blocks that were set to physical inputs and outputs (other than “None”) 
will default to the “Host” setting within the plugin. Any input block set to “None” will 
remain set to “None” within the plugin. 

Hardware Blocks (Send, Return, FX Loop & Looper)
When Importing a Helix Hardware-exported Preset into Helix Native - These 
hardware block types are only functional within Helix/HX devices. Within Helix Native, 
these blocks offer no routing functionality, and their parameters are not editable. 

Impulse Responses
Impulse Response (IR) files are able to be utilized within IR blocks of all Helix and HX 
devices, as well as by the Helix Native plugin in any HC mode. If you are to be sharing 
Helix presets between Helix Native plugin and Helix or HX devices, it is a good idea to 
build and maintain your IR libraries similarly on each to allow the same IR files to be 
utilized for your presets that include them—see page 16.

NOTE: IRs, including those from the Line 6 Marketplace online shop and 3rd party vendors, 
are supported by all Helix and HX devices, as well as by Helix Native plugin. Any of your IRs 
can be imported and exported, as well as dragged and dropped, between HX Edit and Helix 
Native IR library windows.

Favorites
Favorites that you’ve created on your Helix or HX device, as well as Favorites files (.fav) 
exported from HX Edit, are compatible with any Helix or HX device and Helix Native 
plugin—wherever as the specific model type is supported. See page 20.
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Controller Assignments
Controller assignment types vary between Helix and HX devices, for example, a Helix 
Floor preset may include an EXP 3 controller assignment, which Helix LT and HX 
devices do not include. Therefore, if a preset is imported and translated to a different 
device in HX Edit, non-supported assignments are discarded. 

The Helix Native plugin does not utilize any hardware-based bypass, footswitch or 
EXP controller, Variax or Powercab parameter assignments, or Command Center 
assignments that may exist within HX Edit-exported presets. Any such assignments 
that are supported only by Helix/HX hardware remain intact within your presets, but are 
essentially ignored by Helix Native.* Snapshot and applicable MIDI In type assignments, 
however, are supported in both Helix hardware and Helix Native plugin.) Helix Native 
plugin includes its own functionality to create plugin parameter - Automation Controller 
type assignments, which are similarly ignored when Helix Native presets are imported 
into the HX Edit application. 

*TIP: Helix Native includes a Preferences option to show or hide existing hardware-based 
assignments within its Automation/Controller Assign tab.

NOTE: By default, all controller assignments created for Footswitch, Variax knob, and MIDI 
type controllers are also automatically enabled for Snapshots assignment as well. 
Optionally, you can set the parameter’s Snapshot Control option to Off to disable it from 
being assigned to Snapshots—see page 40.

MIDI In Bypass & Controller Assignments
Using HX Edit, you can create MIDI In Bypass Assignments to remotely toggle the 
bypass state of most block types, and MIDI In Controller Assignments to remotely 
control most Helix parameters, via external MIDI controller devices or MIDI software. 
MIDI In assignments saved within HX Edit-exported presets are supported when 
imported into other Helix/HX devices, as well as in Helix Native plugin. See “Creating a 
Bypass Assignment” on page 40.

DSP Limit
In order to maintain preset compatibility with Helix and HX devices, each HC mode 
within the Helix Native plugin incorporates DSP limits on its presets, matching the limits 
of the respective hardware devices (also see the following Preset Spillover section). 
The exception to this rule is when the “Off” HC mode setting is in use in Helix Native. 
This mode effectively removes the DSP limits on presets, as well as several other 
restrictions. For this reason, presets exported from the Helix Native - HC Off mode 
may not be translatable in HX Edit for any device. See “Preset Compatibility with Helix 
Native Plugin” on page 4. 

Preset Spillover Mode
Helix Floor, Rack, and LT devices include the Preset Spillover Mode (accessible in the 
device’s Global Settings > Preferences) which, when activated, dedicates 50% of its 
DSP to providing full “spillover” for the decay of delay and reverb tails, as well as a 
smooth transition across a preset change. To achieve this processing, the device limits 
its signal flow to Path 1 (with Path 2 visibly removed). Therefore, if the connected Helix 
device has Preset Spillover Mode active, when loading any Helix preset, only its Path 
1 blocks and settings are visibly loaded and audible (as shown in the following HX Edit 
image), and any existing bypass or controller assignments for path 2 blocks are non-
functional. 

The Signal Flow shows one main path when Preset Spillover Mode is active

Note that a preset’s existing Path 2 blocks remain part of the preset, even if the preset is 
saved while Spillover is active, so you’ll see them appear on Path 2 for the preset when 
Spillover is turned Off. Considering this behavior, the best practice is to start with empty 
New Presets when you have Preset Spillover On and utilize them for the Spillover mode 
only, and you’ll not need to concern yourself with Path 2 blocks or settings!

NOTE: When in Spillover mode, you’ll need to ensure that your preset’s Path 1A and Path 
1B Output blocks are set to physical Helix outputs (i.e., the imported preset may have a 
Path 1 Output block set to Path 2A, which will result in no audible output). Please see your 
Helix Owner’s Manual for details.

Marketplace Assets
Premium presets and IRs purchased from the online Marketplace are compatible with 
Helix devices and Helix Native plugin. Marketplace also includes presets and bundles 
specifically for HX devices as well. The import of premium Marketplace assets requires 
online license Authorization. Please see “Marketplace & Account Options” on page 
54. 

NOTE: Version 1.70 of Helix Native and 2.70 of HX Edit and device firmware (or later 
versions) are required for full support and use of premium Marketplace presets and IRs.

https://www.line6.com/manuals
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GUI Overview
HX Edit has a very intuitive, easy-to-use interface. The main application window 
automatically detects your specific Helix or HX device type and displays all its options 
within the main application window. 

TIP: As covered in “Multi-Device, Multi-Window Support” on page 3, if you have more 
than one device connected, a separate application window is available for each device.

Within the application window, the navigation is divided into three main sections: 

The Librarian Window - For managing presets, Impulse Responses (IRs), and 
Favorites.

The Signal Flow Window - Where you can add and move amp, effects & mix 
blocks, and customize your complete signal path routing.

The Inspector Window - Where you can choose from the huge selection of 
models, edit their parameters, create bypass & controller assignments, and more. 

Show/Hide
Librarian

Undo/Redo 
Buttons

IRs
Tab

Tempo 
Controls

Presets
Tab

Signal Flow
Window

E
D

ITO
R

LIB
R

A
R

IA
N

Edit TabMy Account/Preferences
Menu

Bypass/Controller 
Assign Tab

Inspector
Window

Favorites
Tab

The HX Edit main GUI (Helix Floor device)

HX Device Owners: With an HX device connected, its application window 
displays the single signal flow, just as on your HX hardware screen. As covered in 
this chapter for Helix devices, you can utilize the application’s signal flow to 
bypass, move, clear, copy & paste blocks, create split paths, and more.

The HX Edit signal flow—with an HX Stomp XL or HX Stomp connected

The HX Edit signal flow—with an HX Effects connected

TIP: The Command Center, for creating MIDI control assignments and Global EQ (Helix, 
HX Stomp XL, and HX Stomp only) are available as separate windows from the application’s 
Window menu.

Resizing the Application Window
The HX Edit main application window is resizable, allowing you to adjust it to best fit 
your screen size and workflow. Simply click and drag any corner or edge of the window 
to adjust to the preferred size, or click the “Maximize” button at the top of the window 
to use it in full-screen mode. If you have multiple devices connected, each device’s 
application window is independently resizable.

It is also possible to show or hide the Presets/IRs/Favorites Librarian panel, by clicking 
on the toggle button at the top left of the Signal Flow window (or via the Window menu’s 
Show/Hide Librarian command). 

The Librarian window Show/Hide toggle button
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Application Menus
At the top of your computer screen (Mac) or top of the application window (Windows), 
you’ll find the familiar application menu bar for the current device. Note that the available 
commands differ within the File and Edit menus depending on the application window, 
tabbed panel, and/or specific control that currently has “focus.” The window focus is 
indicated by a blue outline appearing around the Librarian, Signal Flow, or Inspector 
windows.* To change focus, simply click within the desired window, or use the TAB key. 
To follow are descriptions of the included application menu commands for Mac and 
Windows. See “Keyboard Shortcuts” on page 72 for additional information. 

*NOTE: It is possible that the Librarian’s Presets or IRs tab currently has focus, but if 
you’ve “hidden” the Librarian panel, you will not see its blue outline focus indicator. Using 
the TAB key will advance the focus to the other windows, even when the Librarian is 
hidden.

NOTE: On Mac computers, HX Edit has one common, main application menu at the top of your 
screen. If you have multiple Helix devices connected and multiple app windows open, available 
menu commands & keyboard shortcuts act only upon the current “foreground” application 
window. (Choose the desired device within the Devices menu to bring its application window to 
bring it to the foreground.)

HX Edit (Mac only)

•	 About HX Edit - Launches the About box screen, which displays the versions 
of the HX Edit software and connected Helix device firmware, as well as legal 
information.

•	 Check for Updates - Launches the built-in updater to check for an install any 
available software and device firmware updates—see “Updater & Additional 
Resources” on page 84.

•	 Preferences - Launches the Preferences window, where you can select 
application and hardware settings—see “Preferences and About Box” on page 
51. You can also launch the Preferences window by clicking on the “gear icon” 
button or device indicator at the bottom of the application window.

•	 Quit HX Edit - Exits the application for all connected devices.

File
When a preset within the Presets tab currently has focus (or, when the Presets tab is 
displayed and focus is within any other window), the following commands are selectable:

•	 Save Preset - Saves changes for the currently loaded preset to the device’s 
Preset Library. 

•	 Save Preset As - Displays the Save As window, allowing you to choose the 
desired Setlist and Preset Library location where to save the current tone. Note 
that choosing an occupied preset location will overwrite the existing preset 
within the location on your device.

•	 Import Preset - Imports any .hlx preset file (or files) from your computer, 
replacing the currently selected library preset(s).

•	 Export Preset - Exports the currently selected preset (or presets) and saves 
each to your computer as a .hlx file. 

•	 Import Setlist - (Helix devices only) Imports any .hls setlist file from your 
computer, replacing the current setlist on your Helix.

•	 Export Setlist - (Helix devices only) Exports the current setlist and saves it to 
your computer as a .hls setlist file.

•	 Import Bundle - (Helix devices only) Imports any .hlb bundle file from your 
computer, replacing all setlists and presets within the Helix.

•	 Export Bundle - (Helix devices only) Exports all the current setlists and their 
presets from your Helix and saves them to your computer as a .hlb bundle file.

When an IR slot within the IRs tab currently has focus, the additional following 
commands are available:

•	 Import Impulse - Imports an Impulse Response file (or files) from your computer, 
replacing the currently selected library Impulse(s).

•	 Export Impulse - Exports the currently selected Impulse (or IRs) and saves 
each to your computer.

When a Favorites slot within the Favorites tab currently has focus, the following 
commands are available:

•	 Import Favorite - Imports a Favorite file (or files) from your computer.

•	 Export Favorite - Exports the currently selected Favorite (or Favorites) and 
saves each to your computer.

TIP: Please see “Presets Panel”, “IRs Panel”, and “Favorites Panel” for details on these 
menu command behaviors.

The following, additional File menu commands are available regardless of window 
focus:

•	 Create Backup - Launches the Create a Helix Backup window, where you can 
export a full backup of your device’s Presets, IRs, Global Settings, Favorites, 
and User Defaults—see page 27.

•	 Restore From Backup - Launches the Restore From Backup window, where 
you can restore your device’s Presets, IRs, Global Settings, Favorites, and User 
Defaults from a previously created backup—see page 27.

•	 Extract Files From Backup - Launches the Extract Files From Backup window, 
where you can select one of your saved Helix Backup files and individually 
choose to extract the Favorites, IRs, and/or Presets from the backup—see 
page 28.

•	 Preferences - (Windows only) Launches the Preferences window, where you 
can access application and hardware settings—see page 51. You can also 
launch the Preferences window from the “gear icon” button or the connected 
device indicator at the bottom of the application window.

•	 Quit - (Windows only) Exits the application.
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Edit
Regardless of tab focus:

•	 Undo - Reverses the last supported edit action.

•	 Redo - Reverses the last performed Undo action.

TIP: Please see “Undo / Redo” on page 25 for details.

When the Presets tab has focus:

•	 Copy Preset - Copies the selected Preset(s) to the clipboard.

•	 Paste Preset - Pastes the last-copied preset(s), replacing the preset(s) within 
the selected preset library location(s).

•	 Select All Presets - Selects all Presets within the current Setlist.
•	 Rename Preset - Renames the currently loaded preset.

When the IRs tab has focus:

•	 Copy IR - Copies the selected IR(s) to the clipboard.

•	 Paste IR - Pastes the last-copied IR(s), replacing the IR(s) within the selected 
IR library location(s).

•	 Clear IR - Deletes the selected IR(s) from the IRs library.

•	 Select All IRs - Selects all IRs within the IRs library.
•	 Rename IR - Renames the currently selected IR.

When the Favorites tab has focus:

•	 Copy Favorite - Copies the selected Favorite(s) to the clipboard.

•	 Paste Favorite - Pastes the last-copied Favorite(s) and displays a prompt to 
copy as new or replace the selected Favorite.

•	 Clear Favorite - Deletes the selected Favorite(s) from the library.
•	 Rename Favorite - Renames the currently selected Favorite.

When the Signal Flow window has focus:

•	 Cut Block - Copies the currently selected block and its settings to the clipboard 
and removes the block from the Signal Flow.

•	 Copy Block - Copies the currently selected block and its settings to the 
clipboard.

•	 Paste Block - Pastes the last-copied block’s model and its settings to the 
selected block location. When an existing block is selected as the paste 
location, this replaces the existing block.

•	 Paste Block Before - When an existing block is currently selected, pastes the 
last-copied block’s model and its settings to the location before the selected block.

•	 Paste Block After - When an existing block is currently selected, pastes the 
last-copied block’s model and its settings to the location after the selected block.

•	 Clear Block - Deletes the selected block.
•	 Rename Preset - Renames the currently loaded preset.

When the Command Center window has focus:*

•	 Cut Command - Copies the currently selected (instant, footswitch, EXP pedal, 
or Variax knob) controller’s command settings to the clipboard and clears the 
command settings from the controller.

•	 Copy Command - Copies the currently selected controller’s command settings 
to the clipboard.

•	 Paste Command - Pastes the last-copied controller’s command settings to the 
selected controller. 

•	 Clear Command - Deletes the selected controller’s command settings.

*NOTE: When working in “The Command Center Window” you can access these Edit 
commands as follows:

Mac - These commands are available within the main application’s Edit menu at the top of 
your screen when the Command Center window has focus. 

Windows - The Command Center window itself includes an Edit menu with these 
commands.

TIP: Copy Block and Paste Block, as well as drag and drop of processing blocks, can be 
also used between multiple HX Edit windows, and back and forth with Helix Native plugin! 
See “Cutting, Copying, Pasting, and Clearing Blocks” on page 32 for details.

Snapshots
•	 Copy Snapshot - Copies the currently loaded preset’s snapshot to the 

clipboard.

•	 Paste Snapshot - Pastes the last-copied snapshot contents, replacing the 
currently loaded snapshot’s contents. 

•	 Rename Snapshot - Allows you to edit the title of the currently loaded snapshot 
(Helix and HX Effects devices only).

•	 Snapshots - Any of the current preset’s snapshots can be selected directly 
here. (Note that Helix devices offer 8 snapshots, HX Stomp XL and HX Effects 
offer 4, and HX Stomp offers 3.) 

*NOTE: When working in “The Command Center Window” you can access the Snapshots 
commands as follows:

Mac - These commands are available within the main application’s Snapshots menu at the top 
of your screen when the Command Center window has focus. 

Windows - The Command Center window itself includes a Snapshots menu with these 
commands.

TIP: Please see “Configuring & Managing Snapshots” on page 24 for details.
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Window
•	 Show / Hide Librarian - Toggles the Presets/IRs/Favorites librarian panel 

between shown and hidden for the current device window.

•	 Command Center - Displays the Command Center window (Helix and HX 
Effects devices only)—see page 46.

•	 Global EQ - (Helix devices only) Displays the Global EQ window—see page 
50.

•	 Close - Closes the Command Center, Global EQ, or main application window 
(whichever has focus). Note that the main HX Edit window can be re-opened 
using the Devices menu commands.

Help
•	 HX Edit Online Help - Takes you to the Line6.com Support site where you can 

find the helpful info on HX Edit and Helix & HX devices.

•	 HX Edit Application Pilot’s Guide - Launches the PDF you are reading now.

•	 Check for Updates - (Windows - this command is found within the Apple 
menu on Mac) Launches the built-in updater to check for an install any available 
software and device firmware updates—see “Updater & Additional Resources” 
on page 84.

•	 About HX Edit - (Windows only) Launches the About box, which includes the 
software version and legal credits.

Devices
Displays a selectable option for each connected Helix or HX device’s individual HX Edit 
application window. Choosing a device within the menu will bring its HX Edit forward, 
if it is currently not in the foreground, and re-displays the window if it is currently 
minimized or closed. A checkmark appears to the left of the device window that is in 
the foreground. See “Multi-Device, Multi-Window Support” on page 3.

Preferences, Help & Account Options
At the bottom left of the application window, click on the menu buttons to access the 
app’s Preferences, Help & About Box, (see page 51) and My Account options (see 
page 54)

Preferences Help/About Account Options
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Presets Panel
The Librarian’s Presets tabbed panel provides functionality for importing, exporting, 
and managing presets & setlists.

Setlist Commands

Presets Tab

Setlist Menu

Loaded Preset

Selected Preset

Preset Commands

The Presets panel

You’ll find the same commands for copying, pasting, renaming, importing, and exporting 
within the application’s File & Edit menus. These commands are also accessible via 
“Keyboard Shortcuts”. 

TIP: Helix device presets, setlists, and bundles can also be imported and utilized within 
other Helix devices and the Helix Native plugin! Please see “Preset Compatibility” on page 
4 for more info.

HX Device Owners: All functionality described in this chapter is the same for use 
with all Helix and HX devices unless otherwise noted.

Premium Marketplace Presets
If you’ve purchased and downloaded premium Helix or HX presets from the Marketplace, 
you must be Signed In to your Line 6 account within HX Edit and have your computer 
Authorized to allow HX Edit to initially Import or Export these presets (as well as for any 
setlists or bundles that include premium presets).*

*NOTE: Once you’ve initially imported your Marketplace assets to sync their licenses with 
your account, you don’t need to have HX Edit actively Signed In to use them—and it is not 
necessary to even be connected to the Internet once your computer has been Authorized, 
except to Deauthorize the computer. Please see “Authorize / Deauthorize Your Computer” 
on page 56.

Premium Marketplace presets are otherwise able to be utilized just like any other Helix 
presets. When imported, these premium Marketplace presets are indicated by guitar 
pick “badges” to their right within the Presets panel.

Premium Marketplace presets are indicated with golden guitar pick badges

Selecting, Loading & Saving Presets
It is important to note there is a difference between the selected and loaded preset 
within the Presets panel.

To Select a Preset - Click once on a preset location in the Presets panel and 
you’ll see it become highlighted in gray. This indicates the preset is selected, 
meaning that a preset command (Copy, Paste, Import, etc.) will act upon this 
preset (even if a different preset is the one currently loaded within the Signal Flow).

To Load a Preset - Double-click on any preset (or click once to select it and then 
hit your Enter/Return key) and you’ll see the preset highlighted and with amber-
colored text, indicating it as the preset currently in use. If no other preset is 
currently selected (highlighted in gray), menu commands will act upon this loaded 
preset, since it is effectively also the selected preset. 
To Save a Preset - Once a preset is loaded from the Presets Library and edited, 
you’ll most likely want to save the preset to retain your changes.* To save the 
Preset to your device’s library, choose the Save or Save As option from the 
app’s File menu, or click the Preset Save button  that appears at the top of the 
Signal Flow panel (see “Naming & Saving the Preset” on page 24). See the next 
section for the option to Export a preset to save it to your computer.

*TIP: Before editing a preset you may wish to first copy it to another location in the Presets 
panel, or export it, to be sure you have an original version of the preset before making 
changes.
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Importing and Exporting Preset Files
Presets are able to be exported to your computer as individual (.hlx) files, 
allowing you to create a limitless collection of tones that can be imported back 
onto your device’s internal preset library at any time. 

To Import a Preset File - It is recommended to select an empty “New Preset” 
location within the Presets panel and select the Import Preset command. A 
brief dialog will inform you that importing will overwrite any preset information in 
the selected location. Click Yes to continue. A system window will display a file 
browser for selecting the preset you wish to import. Once imported, the preset 
will reside on your Helix or HX device’s internal memory, within the selected 
preset location.

To Export a Preset File - Select the preset by single-clicking on it in the Librarian 
- Presets panel and select the Export Preset command. This creates a copy 
of the preset in its last-saved state from your Helix or HX device’s memory and 
saves it to your computer. The familiar “save” window is presented, in which you 
can edit the filename and choose a destination folder. 

TIP: If you happen to own both a Helix (or Helix Native plugin) and HX device, it is 
recommended to export your HX devices’ presets into their own, individual directories to 
avoid mixing them up with Helix and Helix Native plugin preset files. 

Note that presets are exported in the format of the specific device you are using, which 
determines its behaviors for use with HX Edit preset translation and Helix Native’s Hardware 
Compatibility modes—see “Preset Compatibility” on page 4.

Renaming, Reordering, Copying, and Pasting Presets
These functions allow you to customize your presets within the Presets panel. Choose 
Rename, Copy, or Paste from the row of preset command buttons or application’s 
Edit menu and it will act upon the selected (highlighted) preset. You can also right-click 
on a preset in the list to open a context menu with these same commands. For most 
commands, it is also possible to multi-select a number of presets by using Shift+Click 
to select a contiguous set of presets, or Cmd+Click (Mac) or Ctrl+Click (Windows) to 
select a non-contiguous set.

TIPS: There is no command to “delete” a preset, but you can right-click on a block within 
the signal flow and use the Clear All Blocks command.

NOTE: Copy/Paste of presets and IRs between HX Edit and Helix Native, or between 
multiple HX Edit device app windows is not currently supported. However, you can use 
drag and drop for these actions! See the next section.

Drag and Drop Presets
It is possible to drag and drop any preset (or multi-selected presets) directly from the 
Presets panel to perform the following actions.

•	 Import - Drag a .hlx preset file from any computer folder and drop directly onto 
a Presets panel slot to import it into the device’s Presets Library.* This import 
action replaces and overwrites the slot’s existing preset. 

•	 Import and Load - Dragging a preset from a computer folder and dropping 
it directly into the currently loaded preset’s slot within the Presets Library, or 
dropping it directly into the Signal Flow window, will both Import the preset and 
load it as the new current tone, replacing the previous tone. (Note that if you 
drag and drop a preset into a slot that is not that of the currently loaded preset, 
this will import the preset into the library, but not also load it.)*

*NOTE: If you import a preset that was created with a different source Helix/HX device (or 
created with a different Helix Native HC mode) than currently in use, HX Edit will attempt to 
translate the preset for the current device. (See “Preset Translation” on page 4.)

•	 Export - Drag one or multiple presets from the Presets panel and drop into any 
folder on your computer to export a copy of the .hlx preset file(s) there. 

•	 Reorder - Drag vertically to another location within the Presets panel to reorder 
the presets within the setlist as desired. When the preset is dropped into the 
new location slot, the surrounding presets are shifted upward or downward 
accordingly.

•	 Copy Between Two Devices - If you have multiple devices connected, it is 
possible to drag and drop presets between the multiple HX Edit device app 
windows’ Presets panels, or directly into the Signal Flow, assuming the presets 
can be translated between the device types. (See “Preset Compatibility” on 
page 4.)

•	 Copy To/From Helix Native Plugin - (Helix devices only) Drag a preset from 
the plugin’s Presets panel and drop directly into the Presets panel of the HX 
Edit app to import and load the preset on your Helix device, replacing and 
overwriting the previously loaded preset. Likewise, you can also drag and drop 
presets from HX Edit into Helix Native plugin (see “Preset Compatibility” on 
page 4).

Importing and Exporting Setlists
The Presets panel allows you to instantly save the currently loaded setlist, 
including all its saved presets, to a Helix setlist file (.hls). This is very handy for 
making a backup of all presets within a setlist, so that a group of presets can 
easily be loaded back into your Helix in a single action. 

HX Device Owners: A Setlist for your HX device consists of all presets within the 
device’s preset library. Similar to the steps described here for Helix devices, you can 
use the HX Edit Import Setlist and Export Setlist commands, found within the app’s 
File menu.
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To Import a Setlist - Select the Import Setlist command. This will prompt you 
to ensure that you wish to replace the currently selected setlist and the presets 
therein. Continue through the Open window to select the setlist you wish to load 
onto your connected device.*

*NOTE: If you import a setlist that was created with a different source Helix/HX device (or 
created with a different Helix Native HC mode) than currently in use, HX Edit will attempt to 
translate its presets for the current device. (See “Preset Translation” on page 4.)

To Export a Setlist - Select the Export Setlist command to display the Save As 
dialog. 

Changing Setlists
(Helix devices only*) To change the active setlist shown in the Presets panel, click on 
the Setlist menu and choose from among your device’s setlists. The currently-selected 
setlist will be indicated with an “open folder” icon in this menu.

*HX Device Owners: With an HX device in use, there is no Setlist menu, since 
these devices’ Presets Libraries include only one setlist. However, you can use the 
Import Setlist option to replace the current setlist with one saved on your 
computer.

Renaming Setlists
To rename the current setlist, right-click on the setlist name within the Setlist 
menu and type in your desired title.

HX Device Owners: The single Setlist on your HX device displays no name on the 
hardware or within HX Edit. However, you can edit the Setlist’s filename when 
Exporting the file to your computer.

Importing and Exporting Bundles
A Bundle file (.hlb) includes all 8 setlists’ contents of your Helix device, including 
all their presets and saved settings, wrapped up in a tidy package.* This makes it 
easy to export to create and store a backup of your Helix device’s complete 

Preset library, and easily restore your device’s Presets library to your device (or to the 
Helix Native plugin) by importing the bundle. 

NOTE: Bundle files do not contain any of the Helix device’s Global Settings or Impulse 
Response (IR) files. To include all these Helix items, use the Create & Restore Backups 
feature—see page 27.

*HX Device Owners: HX devices do not support Bundle files, therefore, you will see 
no available Bundle options.

The Import Bundle and Export Bundle options are found in the application’s 
Preferences > Presets/IRs tab (see “Preferences and About Box” on page 51). 

Bundle options within the Preferences window (for Helix devices)

To Import a Bundle - Click the Import Bundle button and a prompt is displayed 
to replace all setlists and presets within your Preset library. Continue through 
the File – Open window to select the bundle you wish to import. Note that it is 
possible to optionally import any bundle that was exported from the Helix Native 
plugin or any Helix device.

To Export a Bundle - Click the Export Bundle button to create a copy of all 
presets and their last-saved settings that exist in all setlists as a Helix bundle 
(.hlb) file. 

NOTE: (Helix devices) On the next power-up after importing multiple presets, or importing 
any setlist or bundle, you may see your device perform an additional “Rebuilding Presets” 
process during boot up. This process is normal and optimizes preset loading times on the 
hardware.

TIP: Wanting to restore the Factory Presets & settings for your device? You can do so by 
performing a Factory Restore—please see your Helix or HX device’s Owner’s Manual for 
details (and remember to use HX Edit to first do a backup of your current presets!).

TIP: Visit the line6.com/customtone site to share your tones and download from the huge 
online library of artist and user presets!

https://www.line6.com/manuals
http://line6.com/customtone
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IRs Panel
The Librarian’s IRs panel provides a list of all Impulse Response files (along with 
respective ID numbers in the left column) that currently reside on your Helix or HX 
device. Initially, this IRs panel is empty, awaiting your import of Impulse Response files. 
Once imported into the IRs panel, your IRs can be utilized in any Single IR or Dual IR 
blocks within your tones.

IR Commands

IR Index Numbers
Selected IR

IRs Tab

The IRs panel

HX Device Owners: IR files can be used by all Helix and HX devices. All functionality 
described in this chapter is the same for use with all devices unless otherwise noted.

What are Impulse Responses?
Impulse Responses (or “IRs”) that can be used in Helix & HX devices are audio files that 
are the result of capturing the sound of a test tone (frequency sweep) through a guitar or 
bass amp speaker cabinet, which has been de-convolved with the original tone signal. 
This represents the frequency response of the miked cabinet itself and can be used 
to simulate the way it alters the sound. This is similar to a convolution reverb, but with 
much shorter decay. 

Add an IR block to your preset as an alternative to using one of the Cab or Legacy 
Cab blocks to provide speaker cabinet simulation. Several companies now offer large 
selections of professionally recorded IR files that can be used in Helix devices, or you 
can even do some research on how to record and create your own. Feel free to jump on 
your favorite guitar gear forums and join the ongoing, sometimes heated, discussions 
about the best and most realistic IRs, and methods to create them.
You can also find some IRs that were created using this convolution process to capture 
the properties of acoustic guitar bodies, guitar pickups, and other sources. These IRs 
can certainly be used in the Helix IR blocks as well, to allow even deeper tone sculpting!

As of Helix/HX firmware v3.50, you can use not only the Single IR block type, but also 
the Dual IR block type, which offers the use of two independent IR files and stereo 
output!

TIP: You can find a great selection of IRs specifically created for Helix family products on 
the Marketplace—see page 54.

IR Formats and Restrictions
For all Helix and HX devices, as well as Helix Native plugin, the following IR file types 
are supported.

•	 Helix Impulse Response (.hir) - This is the proprietary Line 6 IR file format. All 
IRs purchased through the Marketplace are of this file type. (Please also see 
“Marketplace & Account Options” on page 54.)

•	 WAV (.wav) - Most IR producers and vendors typically offer IRs within the .wav 
format. It is possible to import a mono or stereo .wav file IR, regardless of its bit 
depth, length, or sample rate frequency. While this is very convenient, please 
be careful to import only .wav files that were created specifically for use as IRs, 
not just any audio .wav file, or you may experience unexpected sonic results.

Importing and Exporting IRs
To access the IRs stored on your Helix or HX device, click on the IRs tab. From here you 
will be presented with a list of up to 128 IRs and their index numbers. 

NOTE: Premium Helix IRs purchased from Marketplace are also imported & exported 
using the following steps. It is required that you have Authorized your computer and that 
you are Signed In to your Line 6 account in HX Edit to initially Import or Export them. Once 
imported into HX Edit, no active Internet connection is necessary to utilize your Marketplace 
IRs. Please see “Marketplace & Account Options” on page 54 for details.

To Import an IR into your Helix/HX device, select the desired index location in the 
application’s IRs panel and select Import. Select the desired IR .hir or .wav file you 
wish to load onto your device. It is also possible to select multiple IR files and all will be 
imported in one action. 

When premium Marketplace IRs (.hir files) are imported, they are indicated by a golden 
guitar pick “badge” to their right within the IRs panel.

Premium Marketplace IRs are indicated with a golden guitar pick badge
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To Export an IR from your device onto your computer, click Export to display the 
Save As dialog. You can also drag and drop to and from the IRs panel to export and 
import IRs—see the following section.

TIP: Use the File menu’s Create Backup & Restore From Backup options to create a 
backup of your IRs panel’s contents, and restore from the backup, at any time—see 
“Creating & Restoring Complete Device Backups”.

Renaming, Loading, Copying, and Clearing IRs
Several actions can be performed by clicking the commands above the IRs list view, 
which will act upon the selected (highlighted) IR. You can also right-click to choose 
these options from the context menu (or use the app’s “Keyboard Shortcuts”).

NOTE: Copy and Paste of presets and IRs between HX Edit and Helix Native, or between 
multiple HX Edit device app windows, is not currently supported. However, you can use 
drag and drop for these actions! See the next section.

Drag and Drop IRs
There are several drag and drop options that allow you to import and export single or 
multiple IR files between your computer’s directories and HX Edit, as well as load IRs 
into your current tone. 

•	 Import - Drag one or more IR files from your computer folder directly into the 
IRs panel. When multiple files are being dragged in, they are imported starting 
with the selected IR index slot. 

•	 Export - Select one or more IR index locations and drag from the IRs list view 
directly to your computer to export the IR files to the selected hard drive folder.

NOTE: When exporting IRs from the HX Edit IR panel, any Marketplace purchased IR is 
saved to your computer as a Helix IR (.hir) type file. The .hir files are proprietary to Line 6 
products and licensed to you via the Line 6 account on which you purchased them. Any IR 
that was originally imported as a .wav file is exported as a .wav file. 

•	 Copy - It is also possible to drag and drop IRs within the IRs list view to create 
a copy of the IR in a new index location.*

*NOTE: There are no options offered to move or reorder IRs in a single operation. Use the 
Copy, Paste, and Clear functions to rearrange IR within the IRs list as needed.

•	 Copy Between Helix / HX Devices - If you have multiple devices connected, 
it is possible to drag and drop IRs between the multiple HX Edit device app 
windows’ IRs panels to copy them between devices.

•	 Copy To/From Helix Native Plugin - With an instance of the Helix Native 
plugin open, drop IRs from the HX Edit application’s IRs panel directly into the 
IRs panel of the Helix Native. It is also possible to drag IRs from Helix Native 
directly into the IRs panel of HX Edit to import copies of the same IRs.

•	 Load into Current Tone - Once you’ve imported one or more IRs into the IRs 
Library, you can drag any IR from the Library window and drop it directly into 
the desired position within the Signal Path in the Edit window to create a Single 
1024 type IR block loaded with the IR file. See the next section.

Single and Dual IR Blocks
As of Helix Native version 3.50, in addition to the mono Single IR block type, there is a 
stereo Dual IR block type.

•	 A Single IR block allows you to choose either the 1024-Sample or 2048-Sample 
higher resolution IR type. Optionally, you can add up to two Single 1024 IR 
blocks on a signal path (such as one each within the A & B parallel paths).*

•	 A Dual IR block provides the ability to load two of your IRs into one block, 
which can be independently set with different parameter settings, delayed, and 
panned as desired. You can add one Dual IR block max. per signal path.*

*NOTE: The maximum IR blocks per signal path is also combined with the v3.50 Cab, Dual 
Cab, and Amp+Cab block types—also, see “DSP Limit and Model Availability” on page 35.

IR Block Parameters
Individual IR Parameters - The following are available for any Single IR block. You’ll see 
two sets of these parameters in a Dual IR block—one set for each of the block’s “A” 
and “B” IRs.

Parameter Description

IR Select Loads the IR index 1-128 from the IR Library—see the following section.

Low Cut Filters a portion of the IR block’s bass/treble frequencies, which can 
help remove rumble and/or high-end harshness.High Cut

Mix Adjusts the balance of dry and wet (IR processed) signals. 0% = 
completely dry, and 100% = completely wet.

Level Adjusts the overall output level of the IR.

Dual IR Block Parameters - The following are additionally available for any Dual IR block.

Pan Pan the output of each IR independently up to 100% Left or 100% Right. 

Polarity Sets the polarity (Normal or Inverted) for either IR. If you encounter 
audible phasing, try setting one IR's Polarity to Inverted.

Dual IR Block "Both" Parameters - The following are applied to both IRs in a Dual IR block.

Delay

Delays either the "A" or "B" IR up to 50 ms. You can use this to correct 
minor phasing issues between the blocks' IRs (as an alternative to using 
Polarity), or to delay the output of one IR to simulate a "double tracking" 
effect—most effective when the two IRs are also panned opposite. 

Mix Adjusts the balance of dry and wet (IR processed) signals for the entire 
Dual IR block. 0% = completely dry, and 100% = completely wet.



 18 

Loading an IR in an IR Block
When you insert an IR block into your preset’s Signal Flow, the block initially 
defaults to referencing the #1 IR index location within your IR Library (and both of 

a Dual IR block’s IRs initially default to the #1 IR index location). If you have not yet 
imported any IR file into the referenced index location(s), the “empty” IR block has no 
effect on the signal. 

To follow are steps for loading IRs into an IR block, which determines the IR file(s) 
associated with the IR block (also see “IR File Reference” on page 19 for additional 
behaviors).

1.	 In the Model Browser, choose the IR category and select either the Single or 
Dual subcategory, as desired, from the menu at the top of the 2nd column in 
the panel.

•	 If choosing the Single subcategory, you can choose the 1024-Sample or 
2048-Sample type. 

•	 If choosing the Dual subcategory, choose the 1024-Sample type.

2.	 Select the IR block within the Signal Flow. In the Edit tab, use the IR Select 
parameter slider (or its menu at the right) to choose the IR index number (1-
128) that includes the desired IR.

Choosing an IR for a Single IR block within the Model Browser

TIP: For Single IR blocks, you can also use these methods for loading an IR file:

Double-click in Library - Select the Single IR block within the Signal Path and then 
double-click on the preferred IR within the IRs Library list to load into the IR block—
replacing any currently referenced IR. Note that no action is performed if you do not have 
an IR block selected within the Signal Path.

Drag and drop - As mentioned in the preceding section, you can also add a Single IR 
block by dragging the desired IR from the IRs Library panel and dropping it directly into an 
empty location within your Signal Path. (Drag and drop from the IR Library always adds a 
1024 Sample, Single IR block, with your dragged IR file pre-loaded.)

For a Dual IR block, you’ll see a tabbed panel where you can choose the 
primary or secondary IR, select an IR to load, and adjust settings for each 
independently. The “Both” tab offers common parameters (Delay and Mix), 
which apply to both loaded IRs.

A Dual IR block offers multiple tabs of edit options—IR B tab selected

TIP: You can also use a double left-click on the desired IR within the IR Library to load it 
into a Dual IR block’s currently-selected IR A or IR B edit tab.

TIP: Optionally, you can create a Snapshot assignment (see page 44) on the IR Select 
parameter, which then allows you to change the IR within the block as desired, per 
snapshot!

Whenever you load a preset that includes one or more IR blocks that reference an 
empty IR index location, a pop-up is displayed to alert you. For example, the alert 
shown below is telling you that the preset includes two IR blocks, on Paths 1A and 
1B, which cannot locate its originally associated IR files. The “Position” denotes the 
block position of each IR block from left to right on the path, starting with “0” for the left 
position. Please see the next section for more related IR behaviors.

Missing associated IR(s) alert pop-up
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IR File Reference
Once an IR block is configured to utilize an IR index slot that includes an imported IR 
(.wav or .hir) file, and the preset then saved (using HX Edit and device firmware version 
2.90 or later), the preset creates a “reference signature” to the imported IR from its file 
name. Likewise, if you save your IR block as a Favorite (see page 20), or set the IR 
block’s current settings as the User Model Defaults (see page 34), the IR block also 
creates a reference to the specific IR file within your IR library. Therefore, if you happen 
to change the order of your IRs within the IR library list, your preset (or IR Favorite or IR 
User Model Default) will still intelligently reference the originally associated IR file, even 
if it now resides in a different IR Library index location. The following behaviors apply:

•	 If you Clear or Replace an IR file within the IR index slot for which the preset’s 
IR block is configured to use, upon the load of the preset/IR Favorite/User 
Model Default IR, the IR block will first attempt to locate another instance of the 
missing, associated IR file within the IRs Library and automatically utilize it and 
its residing index slot. 
•	 If the configured IR index slot is currently empty, you’ll be alerted that the IR 

block’s associated IR file cannot be found (see the previous section). The IR 
block continues to utilize the same (now empty) IR index slot. You’ll want to 
configure the IR block to utilize an occupied IR index slot (or import an IR 
into the currently referenced slot) and re-save the preset (or recreate a new 
Favorite or User Model Default for the IR block). 

•	 If the original IR file is cleared from the Library and the IR index slot now 
includes a different IR file, you’ll be alerted that the associated IR cannot be 
found, and the IR block utilizes this new IR file within the configured index 
slot. You’ll need to save the preset (or recreate a new Favorite or User Model 
Default for the IR block) with this reference to the new IR file, or configure the 
IR block to use a different, occupied IR slot, to avoid seeing the alert pop-up 
on future loads of the preset/Favorite.

•	 Once an IR block is configured with an IR Library index selection, and the preset 
then saved (or the IR Favorite or IR User Model Default then created), the IR file 
retains this reference signature when exported from the library—thus, even if 
you import the exported IR file again into any index slot within your IRs Library, 
the IR block will still be able to locate and utilize it.*

Yes, the above rules all sound a bit complicated. But in typical use, all this really means 
is that if you happen to import your IRs into different IR library slots than where they 
used to be, your saved preset, IR Favorite, or IR Model User Default will not lose its IR 
file reference!

*NOTE: The IR file reference functionality is also incorporated in the Helix Native plugin. 
Therefore, presets and IR Favorites exported from Helix Native (v3.00 or later) will exhibit 
the same behaviors and attempt to locate their referenced IR .wav files from within the HX 
Edit IR library upon loading. Likewise, presets and IR Favorites exported from HX Edit will 
attempt to locate their IR blocks’ referenced IR .wav files when loaded within Helix Native. 
The moral of the story here is simply to import the same IR .wav files into both HX Edit and 
Helix Native if you plan on sharing your crafted presets and/or Favorites between them, 
and the proper IRs will automatically be utilized from your IR library, regardless the IR slots 
where they reside.

NOTE: We highly recommend using the Create Backup feature in HX Edit to make it easy 
to restore your complete preset and IR libraries (see page 27). Immediately after 
performing a Restore From Backup, it is also best to power your device off and on again 
and allow all presets to “rebuild,” for best preset performance and IR file reference 
functionality.
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Favorites Panel
The Librarian’s Favorites panel provides a list of all blocks you’ve added to your Helix/
HX device’s library as Favorites. This functionality allows you to customize any Helix/HX 
amp, cab, IR, effects, send/return/fx loop, or looper block’s settings, and then optionally 
name and store it within the Favorites library of your device, where it is easily accessed 
for adding to presets. Additionally, you can export your Favorites to your computer 
as (.fav) files, allowing you to create a massive collection, import into other Helix/HX 
devices, and share with others!

TIP: The Helix Native plugin also offers the same Favorites functionality—which means 
you can freely import, export, and even drag and drop your Favorites between HX Edit and 
Helix Native!

Initially, this Favorites panel is empty, awaiting your creation or import of up to 128 
Favorites. Once added, Favorites appear within the panel as shown below and can 
be renamed, copied, exported, reordered, and cleared as desired—see “Managing 
Favorites” on page 21.

Favorites commands

Selected Favorite

View By menu

Favorites tab

The Favorites panel

Adding Blocks as Favorites
Once you’ve dialed in a processing block exactly the way you like it, you can save it as 
a Favorite so the block can be accessed very quickly when building presets, complete 
with your stored parameter settings, bypass state, and existing bypass assignment.* 
Input, Output, Split, and Merge block types are not available to be saved as Favorites.

*NOTE: For HX Effects devices, existing bypass assignments are not saved with Favorites.

There are several ways to add a block to your Favorites library:

1.	 Add or select any amp, cab, IR, effects, send/return/fx loop, or looper block in 
the Signal Flow and tweak its parameters and block bypass state as desired.

NOTE: If you don’t want a Favorite to be recalled with a stored bypass assignment, add 
the block to Favorites before you create an assignment (or remove any existing bypass 
assignment before proceeding). Controller and snapshot type assignments are not stored 
as part of Favorites.

2.	 With your block still selected within the Signal Flow, click on the “star” button 
at the top right of the Inspector’s Edit Tab. 

3.	 Alternatively, right-click on the block within the signal flow and choose Save 
As Favorite.

4.	 The Save As Favorite window appears. 
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At the top of the Save As Favorites window, you can choose to either Add as a 
New Favorite or Replace an Existing Favorite.

To Add as a new Favorite, choose this option.

•	 Type in a custom name for your Favorite, if desired.

•	 If your Favorites panel’s View By sorting option is set for Device List (which 
displays Favorites in the same order as you see on your Helix/HX device), you 
will see the “Choose where to add in favorites list” text in the Save As Favorites 
window, as shown in the preceding image. Optionally, click in a different, 
desired position where you would like your new Favorite saved. 

•	 Click Save to add the new Favorite, or Cancel to exit without adding the Favorite.

To Replace an existing Favorite, choose this option at the top of the window. 
Note that if the block you selected is already an existing Favorite, this option 
will be selected as the default, with the existing Favorite highlighted in the list 
below. 

•	 You can optionally edit the name of the Favorite you are replacing.

•	 Click Save to add the new Favorite, or Cancel to exit without adding the 
Favorite.

NOTE: If you replace and overwrite an existing Favorite that is already in use within your 
presets, the presets remain unchanged.

5.	 You’ll see the Favorite now added to the Favorites lists within both the Library 
panel’s Favorites tab and the Edit tab - Model menu’s Favorites category. 

Within the Model menu’s Favorites list, you can also right-click any Favorite and 
choose to Rename or Clear—see “Adding a Block to Favorites” on page 34. 

TIPS: You can also import Favorites (.fav) files into your Favorites library, as covered in the 
following sections.

When you add an IR block as a Favorite, the IR file you have it set to use is automatically 
recalled, even if moved to a different IR slot in the IR Library (see “IR File Reference” on 
page 19).

The contents of your Favorites library are included when you a create a backup (see 
“Creating & Restoring Complete Device Backups” on page 27).

To Insert a Favorite into your Current Preset
Double-click on the desired Favorite within the Favorites panel to insert it into the 
currently-selected block location within the Signal Flow. Note that if an existing 
processing block is currently selected, this replaces that block with the Favorite. Or, 
you can alternatively drag from the Favorites panel directly into an empty block location 
within the signal flow (also see “Drag and Drop Favorites” on page 22).

You can also choose a Favorite from the Edit tab - Model menu - Favorites category, 
much like choosing any other category’s model, to add it to your tone.

Once a Favorite is inserted into your preset, you can optionally edit its settings further, 
add bypass, controller, and snapshot assignments, and move, copy, paste, or clear it 
just as you can with any other block. Note that the same preset rules apply to Favorites 
as they do for blocks of the same model type (e.g., a maximum block number and type 
limits, DSP limit, etc.).

The Model Menu - Favorites Category

TIP: You can also right-click on any Favorite within the Model menu - Favorites category 
list to Rename, Clear, or change the View By sort order.

Managing Favorites
The row of commands at the top of the Favorites panel allows you to Import, and 
Export (see the next section), Copy, Paste, or Clear the selected Favorite(s) within 
the panel. You can also access these commands via the application’s Edit menu or 
via right-click on any Favorite. Note that the following commands are not available for 
Undo/Redo. 

•	 To Copy and Paste - Select one or multiple Favorites within the panel and 
choose the Copy command. Select the Favorite within the panel above which 
you want to position the copied Favorite(s), and choose the Paste command.

•	 To Clear - Select one or multiple Favorites within the panel and choose the 
Clear command to delete them from the Favorites library.

NOTE: Clearing any Favorite from the Favorites panel does not remove instances of the 
Favorite block that is in use within any preset—your presets simply retain the block and its 
existing settings.

•	 To Rename - Select the Favorite within the panel and choose the Rename 
command to type in your own custom name. It can be extremely helpful to 
name your Favorites descriptively! 

NOTE: The name of the Favorite within the Favorites panel/model menu is also the name 
that is displayed on your device’s footswitch scribble strip if you have a bypass assignment 
created for the block.
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•	 To Reorder - When the View By option is set to Device List, it is possible to 
drag Favorites within the panel to reorder them (also see the next bullet point). 
Click on one or multiple Favorites and drag up/down within the panel. A blue 
line appears while dragging to indicate the target “drop” location.

•	 To Change the List Sorting - Choose the preferred View By option from the 
menu to change the sorting order. This View By option can also be changed 
by right-clicking within the Model menu - Favorites category list, or within the 
“Preferences - View Tab”. The View By options are:
•	 Device List - The same order as displayed on your device’s Favorites list. 

Note that when this option is in use, you can reorder Favorites in the panel or 
on your device, and the lists remain in sync. 

•	 Category - By the model’s original Model menu Category (Distortion, 
Modulation, Amp+Cab, etc.)

•	 Name (A-Z) - Ordered alphabetically by the Favorites’ names.

Importing and Exporting Favorites
Any of the Favorites within the panel can be exported as Favorite (.fav) files to your 
computer. These files can then be imported into HX Edit for any Helix or HX device. 

To Import a Favorite
1.	 There are a few ways to access the Import Favorites command:

- Click the Import command at the top of the Favorites panel 

- Choose Import from the application’s File menu

- Right-click on any Favorite within the Favorites panel and choose Import

Then browse to the folder on your computer containing your .fav files, and 
choose the file(s) to import.

TIP: You can also import via drag and drop—see the following section.

2.	 If the panel’s View By menu is set to the Device List option, the Import Favorites 
window appears, where you can choose to insert the imported file(s) as new 
Favorites (the default option), or you can choose to Replace the currently 
selected Favorite(s) within the list. Click OK to import.

NOTE: It is possible to Import the same .fav file more than once within the Favorites panel. 
The best practice is to avoid creating duplicate Favorites, and use unique and descriptive 
names for your Favorites within your library!

To Export a Favorite
1.	 Click to select the desired Favorite(s) within the Favorites panel. 

2.	 There are a few ways to access the Export Favorites command:

- Click the Export command at the top of the Favorites panel 

- Choose Export from the application’s File menu

- Right-click on any Favorite within the Favorites panel and choose Export

3.	 Browse to or create a folder on your computer where you wish to save your 
.fav files.

TIPS: You can also import via drag and drop—see the following section. 

Once a Favorite is inserted into the signal flow, you can copy the block and paste it into the 
current, or another preset. You can also paste it into another HX Edit device’s window, or 
into Helix Native (in which case it is pasted as a regular, non-Favorite block type, but with 
all settings intact). 

It’s a good idea to create a single “Favorites” folder on your computer, especially if you 
own more than one Helix/HX device and/or Helix Native, and export all your Favorites there 
to make them easy to find!

Drag and Drop Favorites
You can also drag Favorites to perform the following tasks:

•	 Drag from the Favorites panel directly into the Signal Flow to insert the Favorite 
block into your current preset. 

•	 Drag one or multiple Favorites (.fav) files from your computer directly into HX 
Edit to import them. Drop directly into the Favorites panel, on top of an existing 
Favorite within the list to import the Favorite(s). The Import Favorite window 
appears where you can choose to import before the Favorite you dropped onto, 
or to replace it.

•	 Drag from the HX Edit - Favorites panel to your computer to export as Favorites 
file(s).

•	 If you have multiple Helix or HX devices connected, drag from one HX Edit 
window’s Favorites panel into the other HX Edit Favorites panel to import it there.

•	 Drag either direction between the HX Edit and Helix Native plugin Favorites 
panels to import Favorites.

•	 Drag from another device’s HX Edit (or the Helix Native) - Favorites panel 
directly into the HX Edit Signal Flow to add the block to your current tone. Note 
that this adds the block along with its settings as a standard block type (not as 
a Favorite) into the preset—no new Favorite is imported into the library of the 
receiving device. 
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Working in the Editor
The Editor portion of the HX Edit user interface consists of the Signal Flow and Inspector windows. The Signal Flow window is where you’ll see the signal paths for your currently-
loaded preset, appearing much like the Home screen of your Helix, or Signal Flow screen of your HX device. The lower Inspector window contains 2 tabbed panels, Edit & Bypass/
Controller Assign, where you can select models, tweak parameters, configure controllers, and more. Regardless of which of these tabs you have selected, the current preset’s Name 
Field, Save, Snapshots, Undo, & Tempo options are always available at the top of the window. Additionally, there are dedicated windows for the Command Center for MIDI assignments 
(see page 46), and the Global EQ (Helix, HX Stomp XL, and HX Stomp only—see page 50), accessible from the application’s Window menu. If you have not already done so, be 
sure to read through the in-depth information in your device’s Owner’s Manual to get an understanding of the features we’ll be covering in the following sections.

 HX Device Owners: HX Edit application functionality described within this chapter is the same with Helix or HX devices, except where noted.

Preset Name Field Preset Save Button Snapshots Menu Undo / Redo Buttons Tempo Controls

Edit & Bypass/Controller 
Assign Tabs

Signal Flow Window

Librarian Show/Hide
Button

Inspector Window

http://line6.com/support/manuals/
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Naming & Saving the Preset
The Preset Name field at the top of the Editor displays the title of the currently loaded 
preset. Double-click on the text here to optionally rename the preset. Whenever you see 
your preset’s title appearing in the italicized text at the top of the Signal Flow window, 
it indicates that the preset has been edited from its last-saved state. 

The Preset Save button at the top of the Editor launches the Save To Library window, 
where you can optionally re-title the preset in the Name field, and then choose the 
desired Setlist and Preset location to save the currently-loaded tone, overwriting the 
preset that resides within the selected location. (The currently loaded preset is selected 
by default, so you can overwrite it simply by clicking the OK button.) 

The Preset Save To Library window

Alternatively, you can choose the Preset Save or Preset Save As command from the 
HX Edit – File menu. As covered in “Presets Panel” on page 13, there are also the 
Librarian window options, Copy and Export, to create & store copies of your presets. 

Configuring & Managing Snapshots
Your device offers the ability to configure the 8 snapshots within a Helix preset (or 
3 snapshots of HX Stomp preset, or 4 snapshots of an HX Stomp XL or HX Effects 
preset), allowing you to recall a customized set of options for your current blocks 
instantly, without the brief lag time associated with changing presets! A snapshot is 
capable of storing the bypass state of any amp or effects block, up to 64 assigned 
parameter values, tempo settings, and more (please see your device’s Owner’s Manual 
for specifics). 

There are two ways to select a snapshot within HX Edit: by clicking on the Snapshots 
menu at the top of the Edit window, or by using the commands within the application’s 
Snapshots menu. To edit its settings, select the numbered snapshot you want as your 
destination, then configure the desired tone options for this snapshot.*

The Edit window’s Snapshots menu The menu bar’s Snapshots menu

*NOTE: You can use your device’s Global Settings > Preferences > Snapshot Edits to 
choose between Recall (automatically stores your changes to the current snapshot) versus 
Discard (does not store changes to the current snapshot). 

The camera icon within the Edit window’s Snapshots menu is displayed in red  when 
the hardware’s option is set to Discard.

Once your desired destination snapshot has been selected, use the following steps to 
configure your settings. 

To Store a Block’s Bypass State Per Snapshot - Click on the Bypass button 
above any block within the Signal Flow and set your desired bypass state for the 
block (or you can toggle the block’s Bypass button within the Edit tab). Any amp 
or effects block’s Bypass state will, by default, be remembered and recalled per 
Snapshot. 
If you prefer to exclude a block from being controlled by Snapshots, select the 
block and set the Snapshot Bypass option from the block’s right-click menu to 
“off” (so that no checkmark appears at the left of the menu option). Or, you can 
right-click on the block’s Bypass button within the top right of the Edit tab and 
access the Snapshot Bypass command from its menu. Choosing the Snapshot 
Bypass option from the menu again (so that the checkmark appears at the left of 
the menu command), returns the block to the default Snapshot behavior.

Block right-click menu

Edit tab - Block Bypass button right-click menu

The Snapshot Bypass option

http://line6.com/support/manuals/
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To Store a Parameter’s Values Per Snapshot - Select the desired block within 
the Signal Flow, then right-click directly on the desired parameter’s slider within 
the Edit tab and choose the Snapshots controller option. This creates the 
snapshot assignment for the parameter. 
You can then simply load a snapshot and adjust the snapshot-assigned 
parameter to the desired value. Repeat this step for each snapshot as desired, 
and the parameter values are stored and recalled with each snapshot. We cover 
more about configuring controller options in “The Bypass/Controller Assign Tab” 
on page 39.

To Store a Command Center Messages and Command Values Per Snapshot 
The Value parameters of any instant MIDI CC, Bank/Prog, and MMC message, 
plus the state (Dim or Lit) of any CC Toggle and Ext Amp messages are always 
stored and recalled when selecting a snapshot. Therefore, there is no need 
to manually set any of these parameters to a snapshot assignment within the 
Command Center—see page 46. 

Attention Helix Native Plugin Users: Snapshot settings are compatible within presets 
between Helix, Helix Rack & Helix LT devices, and the Helix Native plugin!

Copying, Pasting, Renaming & Customizing Snapshots
The Copy and Paste Snapshot commands are available within the app’s main menu. 
Or, right-click on the Edit window’s Snapshots menu to access these commands as 
well as the snapshot Rename and LED color customization options. These snapshot 
name and LED color options affect the scribble strip names (or names in Performance 
View on Helix LT) and footswitch LED colors when the footswitches are in Snapshot 
Select mode.

The context menu for the Snapshots menu name field

To Copy & Paste a Snapshot - It is possible to copy all the settings of one 
snapshot and paste them to another snapshot within the same preset. Select 
and load the snapshot you wish to copy and select Copy. Then select and load 
the snapshot you wish to overwrite and choose Paste to paste the clipboard 
contents, replacing the currently loaded snapshot. 

NOTE: The action of pasting a copied snapshot is not tracked by the HX Edit Undo / Redo 
feature (also see next section).

To Rename a Snapshot - Right-click the desired snapshot from the Snapshots 
menu and select Rename Snapshot. Type in your new name, then press Enter/
Return on your keyboard.
To Customize a Snapshot’s LED Color - When your device is set to Snapshot 
footswitch mode, each footswitch LED defaults to a red color. If you prefer to 
customize the LED color for the current Snapshot, choose the desired color from 
the right-click menu. Or choose Auto to restore the default behavior, or Off for no 
LED.

NOTE: Remember that you’ll need to Save before switching to another preset to retain 
your edited snapshot settings & customizations within the current preset! The snapshot 
that is in use when you save your preset is the one that is recalled when the preset is 
loaded again.

Snapshot Control On/Off Option for Hardware 
Controller Assignments
This global option enables (Variax Knob, Footswitch, and MIDI type) controller 
assignments that may exist on your presets’ parameters to also be assigned for 
Snapshot control or not. By default, the Snapshot Control On/Off feature is On for these 
controller assignment types, and you can toggle it On/Off per assignment via the option 
within the Bypass/Controller Assign panel—see page 40. (Parameters manually 
configured for the Snapshot controller assignment type are not affected by this option.)

Undo / Redo
The HX Edit application supports Undo and Redo for most editing actions within the 
Signal Flow and Edit tab of the current preset, whether the edits are made within HX 
Edit or directly on the connected Helix/HX hardware, accessible via the Undo and 
Redo buttons at the top of the main window (or from the Edit menu).* The Undo / Redo 
history is tracked individually per device window (if you happen to have more than 
one Helix/HX device connected). Your Undo / Redo history is retained until you load a 
different preset, exit the application, or disconnect or power off your connected Helix 
or HX device. 

*NOTE: See “Software Edits vs. Hardware Edits” on page 26 for additional behavior 
details.

The Undo and Redo buttons
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Undo is available for most actions performed within the Signal Flow and Edit tab 
in HX Edit, including:

•	 Parameter changes

•	 Snapshot selection

•	 Block model changes

•	 Signal path changes (block bypass states, adding/cutting, clearing blocks, 
changing path structure, etc.) 

•	 Hardware edits and edit actions performed via external controller and MIDI 
CC & PC messages (see “Software Edits vs. Hardware Edits” on page 26)

Actions that are not available for Undo/Redo include the following:

•	 Tempo changes

•	 Actions performed within the Presets, IRs, and Favorites Library panels—e.g., 
changing setlists, loading a different preset, importing, exporting, reordering, 
or pasting presets, IRs, or Favorites, etc.

NOTE: The application’s Undo history is cleared whenever a different preset is loaded. 
The action of Saving a Favorite to the Favorites Library is Undo-able.

•	 Adding, editing, and removing Snapshot, Bypass, and Controller assignments.

NOTE: Note that when Undo restores the removal of a block that includes assignments, in 
most cases, these assignments are restored with the block, but in some cases may not be 
able to be retained.

•	 Pasting a copied Snapshot and/or the Snapshot title

•	 Changes to any settings within the HX Edit Preferences, Command Center, 
and Global EQ windows

NOTE: The Undo button and Edit menu command remain unavailable (dimmed) until an 
undo-able action is performed in HX Edit. Likewise, Redo remains unavailable until an 
Undo action has been applied.

Software Edits vs. Hardware Edits
Edit actions performed within the HX Edit application (or “software edits”) are tracked 
individually for Undo / Redo. For example, if you adjust an HX Edit parameter slider, move 
a block, and then change a block’s model, these actions are reverted individually—one 
action per each click of Undo. 

Edit actions performed directly on your connected Helix/HX device and via external 
MIDI control (or “hardware edits”), are aggregated into a separate, single undo-able 
action within the Undo history. Therefore, if you perform a number of hardware edits and 
then choose Undo, all such edits are reverted in one click of Undo. Likewise, selecting 
Redo after performing an Undo of several hardware edits restores all the hardware edit 
changes in one click of Redo.

Editing the Tap Tempo
There are a few options available for configuring the tempo, accessible from the Tempo 
Controls at the top of the Signal Flow window. Any of the current preset’s effect models 
set to note division values will follow this Tap Tempo value. (Note Sync mode is available 
for most delay and modulation effects—see page 36.)

Tempo Select 
Menu

Tap Tempo 
Button

      The Tempo Controls

How the Tempo Value is Recalled
Use the Tempo Select menu to choose how the tempo value is saved and recalled 
(this is the same option found in your Helix or HX hardware’s Global Settings > MIDI/
Tempo screen):

•	 Per Snapshot - The tempo value is stored and recalled individually per snapshot 
for the current preset.

•	 Per Preset - The tempo value is stored and recalled individually with this preset.
•	 Global - The tempo value is used for all presets whenever set to Global.

NOTE: Your Helix/HX device’s tempo can also be configured to follow MIDI Clock from an 
external source, accessed from within your device’s Global Settings > MIDI/Tempo 
screen. When your device is actively following MIDI Clock, all options for the Tempo 
Controls are disabled and the Tempo value displays as “[External].”

Entering a Tempo Value
To enter a value, click on the Tap Tempo button rhythmically, or right-click directly on 
the Tap Tempo button and type in your desired numerical value.
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Creating & Restoring Complete Device Backups
Use the File menu’s Create Backup and Restore From Backup commands to create 
complete backups of your Helix/HX device’s current Global Settings, IRs, Favorites, 
User Model Defaults, and Presets and easily restore them back to your device at any 
time. Optionally, you can also Extract Files From Backup to individually access assets 
from a saved Backup. All presets are backed up from their last-saved state, therefore, 
be sure to save your currently-loaded preset before creating your backup to include its 
current settings.

NOTE: If you have purchased and imported Marketplace premium presets or IRs, your 
computer must be in the Authorized state to be able to use the Create Backup and Restore 
From Backup features, if the backup includes Marketplace premium assets. See “Authorize 

/ Deauthorize Your Computer” on page 56.

TIP: Backup files (.hxb) created using the Create Backup feature for any Helix (Helix Floor, 
LT, or Rack) device can then be “Restored” onto any other Helix device. This allows you to 
easily duplicate all your applicable Global Settings, Presets, and IRs to another Helix in one 
action.

 Backup files created for HX devices are only compatible with each specific 
device type (HX Stomp XL, HX Stomp, or HX Effects).

To Create a Backup
Select the Create Backup command from the File menu to launch the window.

The Create Backup window (Helix device)

4.	 Name - Your backup file is automatically named with the type of device (Helix 
Floor, Helix Rack, Helix LT, HX Stomp XL, HX Stomp, or HX Effects) and the 
current date. Optionally, you can click directly on the file name here and edit 
it as desired.

5.	 Description - Optionally, type in some descriptive notes. All text added here 
is saved with your backup, and viewable during the Restore From Backup 
process.

6.	 Where - By default, your Backup file (.hxb) is saved to the following directory 
on your computer:

•	 Mac - /Documents/Line 6/Tones/Helix/Backups folder

•	 PC - \My Documents\Line 6\Tones\Helix\Backups folder

To save to a different folder, click the folder button and browse to select your 
preferred disk location.

7.	 Click Create Backup and the progress of your backup is shown, with a 
message once it is completed successfully (or click Cancel to exit without 
creating a Backup).

Repeat the above steps at any time to create as many individual backups as 
you like. All compatible backup files for your connected Helix or HX are then 
available within the Restore From Backup window.

TIP: It is highly recommended to create a full Backup before installing device firmware, and 
to perform backups regularly to make sure you always have copies of your tones, IRs, and 
settings!

To Restore From a Backup
Select the Restore From Backup command from the File menu to launch the window.

The Restore From Backup window (Helix device)
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1.	 Backup Folder - The most-recently-used Backup folder is selected here. To 
find a backup file in a different folder, click the folder button and browse to the 
desired location.

2.	 Backup File - All compatible Backup files (.hxb) that you saved within the 
currently selected directory are selectable here. When selecting a backup 
file, the following information is displayed so you know the details about the 
backup before choosing to restore from it.

•	 Date: The creation date of the backup file.

•	 Device: The specific type of Helix device this backup was created from (Helix 
Floor, Helix Rack, Helix LT, HX Stomp XL, HX Stomp, or HX Effects).

•	 Version: The firmware version installed on the device when the backup was 
created. 

•	 Description: Any notes that you entered within the Description field when the 
backup was created appear here.

3.	 Items to Restore - In the lower pane, select the individual items you wish to be 
restored from the selected backup file: Global Settings, IRs, Favorites, User 
Model Defaults, and Presets. Whichever items that are selected here will be 
restored, overwriting those currently on your Helix device.

TIP: For Helix Floor, Rack & LT devices, click on the arrow to the left of the Presets 
checkbox and expand the option (as pictured above) to individually choose whichever 
setlist(s) you want to restore from the selected Backup!

4.	 Click Restore Backup and the progress of the restore process is shown, and 
then a pop-up message is displayed once it is completed successfully (or 
click Close to exit without restoring). Do not disturb the HX Edit application or 
device until the Restore process is complete.

TIP: For Helix devices, if the restored Backup includes presets or setlists, it is highly 
recommended to power your device off and on again to allow it to “rebuild” the presets. 
This process optimizes preset loading times and “IR File Reference” functionality. 

You can repeat the above steps at any time and select any available Helix or 
HX Backup file stored on your computer. 

Extracting Files from a Backup
Instead of restoring a complete backup, as covered in the preceding section, you might 
prefer to “extract” the IRs, Favorites, or setlists & presets from one of your saved Backup 
files to your computer. Extracting allows you to browse and choose only the individual 
assets you wish to import into your Helix or HX device (or Helix Native plugin).* For this 
task, you can utilize the Extract Files from Backup feature. 

*TIP: You can use this feature to extract the IRs, Favorites, or presets from any Helix or HX 
device’s saved Backup (.hxb) file on your computer! Note that the preset compatibility 
rules apply when importing the extracted presets into a different type of Helix/HX device—
see “Preset Compatibility” on page 4.

To Extract Files From a Backup
Select the Extract Files From Backup command from the File menu to launch the window.

The Extract Files From Backup window (Helix device)

1.	 All fields and options displayed in the upper portion of the window are the same 
as described for the Restore From Backup window—please refer to the indi-
vidual item descriptions in the preceding section. 

2.	 Select which items from the backup you wish to extract - In this lower portion 
of the window, check the desired assets. Note that when extracting from 
a Backup created from a Helix Floor/Rack/LT type device, you can check 
individual setlists (as pictured above) to choose only the setlists you want.
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3.	 Click the Extract Files button to start the process, and a folder including all 
the extracted assets is saved to the designated Backups folder (by default, 
this folder path is Documents > Line 6 > Tones > Helix > Backups). 

4.	 Once the extraction completes, a pop-up window asks if you’d like to open 
the folder of the extracted assets. 

5.	 Click Yes to open the folder now. All extracted IR, Favorite, and preset files are 
found within their own sub-folders, with all files conveniently named utilizing 
their original library index slot number. For Helix device backups, each of your 
selected setlists are extracted as separate sub-folders.

These extracted IR, Favorite, and preset files can now be imported into your 
Helix and HX device(s), and Helix Native plugin.
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The Signal Flow Window
The Signal Flow window allows you to directly access the Amp, Effects, Mix & Looper 
blocks within your preset and configure your signal path routing simply by clicking and 
dragging. Once you select any block within the Signal Flow, the Inspector’s Edit tabbed 
panel below provides access to all its editable parameters. The options offered here are 
essentially the same as found on your connected Helix or HX device, making editing 
very straight-forward.

HX Device Owners: HX Edit application functionality described within this chapter is 
the same with Helix or HX devices, except where noted.

Split BlockPath 1A

Path 2A

Path 1B Merge - Mixer Block

The Signal Flow Window (Helix device)

Split BlockPath A Path B Merge-Mixer Block

The Signal Flow Window (HX Stomp XL or HX Stomp device)

Split BlockPath A Path B Merge-Mixer Block

The Signal Flow Window (HX Effects device)

Preset Spillover
Helix Floor, LT, and Rack devices include the Preset Spillover option (see page 8). 
When Preset Spillover is “On,” you’ll see one signal path rather than two in the Signal 
Flow display, reflecting the Spillover state of the device. Preset Spillover is switched 
On/Off via your device’s Global Settings > Preferences options.

Show/Hide Block Labels Option
If you prefer a cleaner look within the HX Edit app’s Signal Flow window, you can “hide” 
the descriptive text labels that appear below each block using the Show/Hide option 
within the Preferences > View tab (see page 51). When set to hide the labels, you’ll 
only see a block’s label appear when hovering your mouse over the block.

Block Label Option Set to Show Block Label Option Set to Hide

Block Bypass Assignment Indicator
If you create a Bypass assignment for any Amp or Effects block within your tone (via 
any footswitch, EXP, or MIDI type hardware controller), you’ll see the block name label 
displayed in brackets, as shown below. Please see “The Bypass/Controller Assign Tab” 
on page 39 for the full info on creating Bypass assignments. (Note that if you happen 
to have the above-mentioned Show/Hide Block Label option set to “Hide” you won’t 
see these labels or indicators except for when hovering over the block.)

Bracketed block labels indicate block bypass assignments

Hardware Block Signal Indicators & Level Meters
Helix and HX devices include real-time level indicators and metering for specific 
block types, which are very handy for visually checking and adjusting the gain staging 
throughout the signal flow of your tone. 

NOTE: These indicators and meters are visible only on the screen of your device, and 
not within the HX Edit application.

To follow are highlights of some of these features—please refer to your device’s Owner’s 
Manual for more info. 

Signal Indicators
(Helix and HX devices) For all Input, Output, Send, and FX Loop block types within 
the Signal Flow, when an input or output signal is present, these blocks display with a 
green fill to indicate a signal is present. Whenever the signal level at any of these block 
types is too hot, a red fill color is displayed as a clip indicator (which means you should 
reduce the signal level of block(s) preceding the red indicated block, and/or the red 
indicated block’s own levels, to eliminate the clipping). 

https://www.line6.com/manuals
https://www.line6.com/manuals
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Level Meters
(Helix devices) Whenever an Output, Send, FX Loop, Compressor, or Gate type 
block is selected within the Signal Flow, you’ll see its meter(s) appear within the lower 
Inspector panel of the Helix device’s Home screen. 

•	 For Output, Send, and FX Loop blocks, the meter measures output level and 
is displayed green for normal signal levels. Whenever the signal is too hot, the 
meter is displayed red to alert you of clipping. 

•	 For a Dynamics - Compressor or Gate type block, the yellow meter measures 
the amount of gain reduction being applied by the effect.

Moving Blocks & Arranging the Signal Flow
To move blocks within a signal path, click and drag any block to its desired location. To 
follow are a number of pointers for arranging the signal flow.

HX Device Owners: You’ll see only the HX device’s single Path 1 displayed within the 
HX Edit signal flow panel. The HX Path 1 can be similarly split to offer parallel Paths 
1A and 1B, as shown in the preceding screenshots.

Path 1 / Path 2 (Helix devices only) - Unlike on the Helix hardware, within HX 
Edit it is possible to copy or move a block, including its current settings, between 
main Paths 1 and 2 via drag and drop. You can also Cut or Copy a block and then 
Paste into any desired location on the opposite path to re-locate it there, along 
with its settings intact—see the next section. 

Split Paths - To create a split (or “parallel”) path, simply drag a block down 
from the main signal path (Path 1A or Path 2A) and you’ll see a split path (Path 
B) appear, with both a Split and Merge block created at each end (as shown in 
images at the start of this chapter). Each path is stereo, with the audio content 
fed to each determined by the Split block type selected (see next section). To 
remove the split path, clear or move all blocks out of the parallel “B” path. 

Mix (Split and Merge-Mixer) Blocks - When a Split block is selected in the 
signal flow, you can choose from among 3 types of Split blocks, and adjust the 
balance options using the parameter sliders that appear in the Edit tab below. 
Note that you can click and drag the Split and Merge-Mixer blocks to position 
them however you like within the path. 

Split Path Options
There are four Split types you can choose from for any Split block. 

Split Y: By default, a Split > Y appears any time parallel Path B is created. Use 
the Balance A and Balance B (pan) parameters to adjust the left/right stereo 
balance fed to each stereo path, respectively.

Split A/B: Use the Route To parameter to determine the total amount of signal 
fed to Path A versus Path B.

Split Crossover: Splits the audio content so that treble frequencies are sent to 
Path A and bass frequencies are sent to Path B. Use the Frequency parameter to 
set the center frequency; Any signal above this frequency is sent to Path A, and 
any signal below this frequency is sent to Path B.

Split Dynamic: Similar to a crossover, except the audio content above the 
audio Threshold is sent to Path A, and the content below the audio Threshold 
is sent to Path B (or the path routing is reversed when Reverse is On). Attack 
determines how fast the signal routes to Path B once reaching the Threshold, and 
Release determines how fast the signal returns to Path A once falling below the 
Threshold—typically, higher values result in a smoother transition. Reverse, when 
On, flips the Path. 

Much like any effects type block, a Split block can be bypassed, as well as have a 
bypass assignment created for it. Bypassing the Split block results in feeding equal left 
and right signals to each stereo parallel path. Functionality for Split blocks and Paths 
differ slightly for Helix vs. HX devices, as detailed here.

Helix, Helix Rack & Helix LT Devices
If you drag a Split block down from Path A (or right-click on the Split block and choose 
Create Input), it will change into a separate Input block for Path B, which then offers a 
set of Input block options in the Edit panel. Likewise, if you drag a Merge block down 
(or right-click on the block and choose Create Output), it becomes a separate Output 
block for Path B. When dragged to Path B, the Split or Merge-Mixer block becomes 
inactive and no longer affects either of the signal paths.

This functionality is how you can potentially create up to 4 individual signal paths 
within one preset, each with its own input and output settings, as shown below. Once 
converted to Input & Output blocks, you can drag the inactive Split or Merge-Mixer 
block back up to the main Path A to restore each back to an active Split or Merge-Mixer 
block (or use the right-click options to Restore them).

Inactive Merge-Mixer blocksInactive Split blocks

Split paths converted to individual paths (Helix device)
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HX Devices
On HX devices, once a parallel path is created, the Split block can be dragged left or 
right on Path A to re-position it as desired. (But unlike with Helix devices, a Split block 
cannot be moved down to convert it into a separate Path B Input.) 

It is possible to drag the Path A Merge-Mixer block down (or right-click on the block 
and choose Create Output), as shown in the following screenshot. This routes the Path 
B output separately to the hardware Send L/R output jacks, and the Merge-Mixer block 
becomes inactive in this Path B position. 

NOTE: If your preset already includes an FX Loop block, the option to set the Merge-Mixer 
block to Path B as an Output block is not available, since the Send L/R outputs are already 
in use by the FX Loop. Likewise, once you’ve set the Merge-Mixer block to Path B (Send 
L/R out) as an Output block, it is not possible to also add an FX Loop block to the preset. 

Once converted to an output, drag the inactive Merge-Mixer block back up to the main 
Path A to restore the split path and active Merge block (or use the right-click option to 
Restore it).

Inactive Merge-Mixer blockParallel Paths A & B

Split path with Path B routed to the Send L/R Output (HX Stomp XL or HX Stomp device)

Inactive Merge-Mixer blockParallel Paths A & B

Split path with Path B routed to Send 1/2 Output (HX Effects device)

Cutting, Copying, Pasting, and Clearing Blocks
You can use the Cut Block or Copy Block commands for an existing processing (Amp, 
Cab, IR, FX, Looper, Mix, or Favorite) block, and then use one of the Paste Block 
commands to paste it, with all its current settings, into a new location within any path 
and within any preset. Use Clear Block to remove the selected block from the path. 
Once you’ve selected the desired block, these commands are accessed either from 
the menu bar’s Edit menu or from a block’s (right-click) context menu (or via keyboard 
shortcuts—see page 72). 

Block Cut, Copy, Paste & Clear commands are available in the Edit menu or block’s context menu

TIP: You can also use copy/paste, or drag and drop, to copy a block between  
separate HX Edit device windows, and/or Helix Native, as covered below.

Note that if you copy/paste a Favorite block between HX Edit and Helix Native, the block 
is pasted as a standard (non-Favorite) type block, but with all its settings intact.

Use Cut Block or Copy Block and then any of the Paste Block commands in either 
HX Edit or Helix Native plugin, as follows:

•	 Into any path within the Helix Native plugin’s Signal Flow

•	 Into any path within the HX Edit app, and within any preset

•	 Into any preset within HX Edit when then connected to a different Helix or 
HX device (as long as the copied Block data is the last item copied to your 
computer’s clipboard)

•	 Into an additional HX Edit application window—also see “Multi-Device, Multi-
Window Support” on page 3

Block Cut / Copy / Paste is allowed for all block types, with some restrictions.* This 
provides great flexibility in re-creating tones between Helix Native, HX Edit, and even 
different Helix & HX devices.

*NOTE: Some restrictions apply for Copy / Paste of blocks, depending on the DSP capacity 
and features of the particular device in use. For example, just as any Helix device preset 
will prevent the addition of some block or model types as the DSP limit is reached, the 
same DSP limit rules apply for Copy / Paste. Presets can also include only one Looper 
block, one use of each Return, up to two IR blocks, etc. Therefore, Copy and Paste 
observes these Block rules as well. Physical inputs & outputs differ between Helix and HX 
devices (and between the different HC modes within Helix Native), therefore, the copying 
of Looper, Mix, Input and Output blocks and their settings may not be allowed, as covered 
throughout this chapter.

Cut Block - Clears the block from the Signal Flow and copies the block and its 
current parameter settings to the clipboard.

Copy Block - Copies the block and its current parameter settings to the 
clipboard. 
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Paste Block - Pastes the most recently cut or copied block to the selected 
destination. If you select an existing block, this will replace the existing block and its 
settings. To follow are a few handy copy & paste tips.

•	 Paste Block After / Paste Block Before - If you select an existing block, you 
can alternatively choose either of these commands to paste the block in your 
preferred location. All these Paste Block commands are selectable within the 
main Edit menu, as well as from a block’s right-click context menu.

•	 Mix Type Blocks (Helix devices only) - Copy & Paste are available for any 
Input, Output, Split and Merge type block as well, where its settings can be 
copied & pasted into a location with the same block type. (When copying these 
blocks between different device types, which may include unique parameters 
per device, only common parameters are pasted.)

•	 Favorite Blocks - Copy & Paste are also available for any Favorite type block 
as well, where the block and its current settings can be copied just like any 
processing block. 

NOTE: If you paste a copied Favorite block (or drag/drop it) into the signal flow of another 
HX Edit or Helix Native Signal Flow, it pastes the block as a standard (non-favorite) type 
block, thus, no respective “Favorite” is imported into the new device or Native. 

If you paste a copied Favorite block (or drag/drop it) into the Favorites panel of another HX 
Edit/Helix Native window, the Favorite is imported into the new device or Native Favorites 
library.

•	 When copying a block within the same window, or between separate HX Edit 
(and/or Helix Native) windows. All existing assignment types are copied with 
the block, except for any footswitch-based Bypass assignment.*

•	 When copying a block from HX Edit to Helix Native, it may not appear that 
its hardware-based controller assignments are retained, since the Helix Native 
does not support them. But if you copy the same block back into an HX Edit 
window again, you’ll see its original assignments are indeed still intact.*

*NOTE: When copying a block with existing hardware-based assignments, the assignments 
will not be retained if the destination device does not include or support the specific 
controller type (e.g., if copying a block with an EXP 3 controller assignment from a Helix 
Floor to an HX Stomp device, the assignment is not shown or supported, since HX Stomp 
includes no EXP 3).

Clear Block - Choose Clear Block from the application’s Edit menu, from the 
block’s (Right-click) context menu, or by clicking the “X” button that appears 
when you hover your mouse cursor over a block. Alternatively, you can select 
an existing block in the Signal Flow and choose None from the Edit tab’s Model 
Browser. 

When hovering over a block, you’ll see its Bypass and Clear buttons appear

Clear All Blocks - Available in the block’s context menu, this removes all 
processing blocks from the signal flow. (Input & Output block settings remain 
unchanged.)

NOTE: Only one Looper block can exist within any preset at a time. Therefore, you cannot 
Copy and then Paste a Looper block within the same preset. But you can use the Cut 
Block command and then Paste Block to effectively “move” a Looper block, including its 
settings, to a new location, such as to a different path. 

Drag and Drop Blocks
You can also use “drag and drop” to copy/paste a block within the current preset, as 
well as between separate HX Edit and/or Helix Native windows. Copy or Move can be 
performed with any processing type blocks - Amps, Cabs, IRs, FX (as long as the block 
type is supported by the target destination’s Signal Flow). The following drag and drop 
actions are available.

•	 Drag and drop of a block anywhere within the current HX Edit Signal Flow 
moves the block (including when dragging between Paths).

•	 Holding the Alt/Option (Mac) or Ctrl (PC) key and performing drag and drop of a 
block anywhere within the current HX Edit Signal Flow copies the block. 

•	 Drag and drop of a block into the Signal Flow of any other HX Edit or Helix 
Native plugin window copies the block.

•	 Holding the Alt (Mac) or Ctrl (PC) key and performing drag and drop of a block 
into any other HX Edit or Helix Native plugin window moves the block. 

•	 Since performing a drag and drop of a block between separate windows is 
essentially the same as a Copy/Paste Block operation, the same rules and 
behaviors apply—please see the preceding section.

NOTE: When dragging a block, if you try to drop it on top of an existing block, you’ll see 
the existing block shift left or right to place your dragged block before or after it. Unlike 
when using the Copy and Paste commands, it is not supported to replace an existing block 
via drag and drop.

See “Drag and Drop Favorites” on page 22.
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Adding & Bypassing Blocks
To Add Any Type of Block to Your Tone - Simply hover your mouse cursor over 
the desired location on any path and you’ll see an empty “None” block location 
appear. Once you select the location, choose any type of block from the Model 
List Menu in the Inspector’s Edit tab below (see the following chapter for more 
info). If you select a location already occupied, choosing a different model from 
the menu will replace the selected block’s model.

To Toggle the Bypass of a Block - Do any of the following:

•	 Hover your mouse cursor over a block within the Signal Flow and use the 
Bypass button that appears above the block. 

•	 Right-click on the block and choose Bypass from the context menu.

•	 Click on the desired block to select it, then use the Bypass button within the 
Edit tab.

•	 Click on the desired block to select it and hit the Spacebar.
•	 A block’s bypass state, by default, is also stored and recalled with each 

Snapshot (see “Configuring & Managing Snapshots” on page 24). 

Adding a Block to Favorites
Once you’ve dialed in an amp or effects block exactly the way you like it, you can 
save its settings as a “Favorite” so the block can be added very quickly to other tones, 
complete with your stored parameter settings, bypass state, and existing bypass 
assignment. Please refer to “Favorites Panel” on page 20 for details on how to add, 
utilize, and manage Favorites. 

Configuring a Model’s User Defaults
If you find yourself constantly re-tweaking your commonly-used models, you can save 
any model’s settings as its new defaults (excluding Input, Output, Split, or Merge Mixer 
blocks), so the model shows up that way every time you add it to a preset.

1.	 Choose any model and tweak it exactly how you like it—including any of its 
parameters and bypass state (existing bypass, MIDI, snapshot, and controller 
assignments are not stored with the User Defaults).

2.	 With the model’s block selected within the Signal Flow, right-click on the 
block and choose User Default.

All your current parameter settings are now saved as the default for future uses of 
the model. (Existing presets that already include the model are not affected.)

NOTE: To return a model to factory defaults, select the model’s block, right-click on it, and 
select Factory Default.

TIP: Your User Defaults are included when creating backups in HX Edit—see “Creating & 
Restoring Complete Device Backups” on page 27.
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The Edit Tab
The Inspector window’s Edit panel provides access to all models via its multi-level 
Model Browser, where you can choose from numerous categories of models to make 
up your tone. This panel also displays all available parameters for the block that is 
currently selected within the Signal Flow window, providing easy access for editing.

HX Device Owners: HX Edit functionality described in this chapter is the same for 
all Helix and HX devices, except where noted.

Selecting Models
As mentioned in the previous chapter (page 34), add models to your current preset 
by selecting the desired empty location on any path within the Signal Flow window and 
then choose the specific model you want from the Model Browser. You can also select 
any existing block within the Signal Flow and change its model this way.

 

List/Grid View Toggle

Category List Model List/Grid

Sub-category Menu

Parameter Sliders

The Edit Panel’s Model Browser

Choose the type of block first in the Category List at the left to see all of its available 
models appear in the Model List. Note that, once you’ve selected a category, you can 
toggle the List/Grid View toggle button to change between a menu list or grid type 
display of the category’s models.

HX Effects Owners: HX Effects devices do not include Helix Amp, Preamp, or Cab type 
models, therefore, these categories will not be available. 

Model List view

Model Grid view

For block categories that offer it, you’ll see a sub-category menu at the top of the 
Model List, where you can choose to see Mono, Stereo , or Legacy  type models. 
Amp categories offer Guitar & Bass sub-categories, and for Cabs you’ll see Single & Dual 
category options (also, see “Model Lists” on page 57). 

Once you click on any model in the Model List, it is instantly active and loaded into 
the selected Signal Flow location. You’ll see the selected model’s editable parameters 
appear at the right of the Edit panel. If you want to remove an existing block, select it 
within the Signal Flow and choose the None category’s Empty Block option (or use the 
Clear Block menu command).

DSP Limit and Model Availability
As in your Helix or HX device’s Model Select menu, when the current preset reaches 
a high DSP and/or memory usage, some models become non-selectable within the 
menu. Additionally, some block types are limited in the maximum number of instances 
that can be added to a single path and/or to a preset (as shown in the following table). 
In the HX Edit app’s menu, you’ll see models dimmed to indicate this, as shown below. 
To free up more DSP resources for the current preset, try removing some models, or 
selecting “Simple” or “Legacy” type models. For Helix devices, utilize both Path 1 and 
Path 2 to take advantage of all available DSP power. (See the DSP Management information 
within your device’s Owner’s Manual for details.)

Dimmed models 

Unavailable models appear dimmed when the preset’s DSP or block limits are reached

NOTE: See “Preset Compatibility” on page 4 for relevant information about DSP limits 
and the use of Helix presets with the Helix Native plugin.
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The following table shows block types which include a maximum instance per path or 
per preset limitation. 

Block Type
Device Type

Helix Rack/Floor/LT HX Stomp/Stomp XL HX Effects

Amp+Cab, 
Amp, Preamp, 

Single Cab,  
1024 IR

Up to four, any 
combination, within a 
preset (up to two per 
path).

Up to two, any 
combination.

Amp, Preamp, and 
Cab blocks not 
supported.

Dual Cab,  
Dual IR,  

Single 2048 IR

These count as two of 
any of the above block 
types. 
Any two within a preset, 
one per path.

One per preset. One 2048 IR per 
preset.
Amp, Preamp, and 
Cab blocks not 
supported.

Legacy Amp+Cab,  
Single Legacy Cab,  

Dual Legacy Cab 

Up to four Single Legacy 
Cabs (up to two per path.
Any two Legacy 
Amp+Cab or Dual Legacy 
Cabs per preset (one per 
path). 

Up to two Single 
Legacy Cabs per 
preset.
One Legacy Amp+Cab 
or Dual Legacy Cab per 
preset.

Legacy Amp, 
Preamp, and 
Cab blocks not 
supported.

Poly Pitch Effects 
Models

One per path and 
two per preset. 

One per preset. One per preset.

Return One instance for each 
Return input per preset.

One instance for each 
Return input per preset.

One instance for 
each Return input per 
preset.

6 Switch Looper, 
1 Switch Looper, or 

Shuffling Looper 

One Looper per preset. One Looper per preset. One Looper per 
preset.

Editing Model Parameters
Once added to your tone, simply click on any block to select it, then choose the desired 
model type and tweak its parameters in the Edit panel. To follow are a few editing tips 
(also see “Keyboard Shortcuts”).

Toggling Model Bypass - A Bypass button is available at the top right of the Edit 
panel for any model that offers a bypass option. When a model is bypassed, its 
parameters appear dimmed to indicate this state. 

Edit tab - model active Edit tab - model bypassed

Save to Favorites - The “star” button at the top right of the panel allows you to 
add the model, along with its current settings, to your device’s Favorites library—
see page 20.

Adjusting Parameter Sliders - There are several ways to adjust slider values:

•	 Click on any slider’s “handle” and drag it to the desired value.

•	 Click on the desired range location within a slider’s path and it will jump to the 
clicked value.

•	 While hovering your mouse cursor directly over any slider’s path, use your 
mouse wheel to adjust it.

•	 Click the up/down arrow buttons at the right for small, incremental adjustments. 
If a down arrow is displayed at the right, click on it to expand its menu.

Type in a Precise Value - Double-click anywhere on a slider’s path or on its value 
to manually type in a precise numerical value.

Resetting Sliders - If you’re not happy with your slider adjustment, Cmd+Click 
(Mac) or Ctrl+Click (Windows) on the slider to reset it to its initial default value.

Accessing All Parameters - Note that some model types, such as amps and 
complex effects, may have more sliders and controls than you can see all at once 
in the Edit tab. You can re-size the application window to show more sliders, or 
click and drag the vertical scroll bar at the right to access all parameters (or use 
your mouse wheel when hovering your mouse cursor over the scroll bar).

Note Sync - Most modulation and delay effects models offer a Note Sync option, 
allowing the modulation rate or delay repeat time to follow the device’s main Tap 
Tempo value (see “Editing the Tap Tempo” on page 26). For models that offer it, 
you can click the Note Sync button within the Edit tab to toggle the feature on/off. 
When active (the Note Sync button is lit), the parameter will change to offer note 
division values, as shown in the following screenshot. 

Note value options Note Sync (active)

A Delay block configured for Note Sync

Impulse Response Block Options - When an IR block is selected in the Signal 
Flow, you’ll see IR block parameter sliders here in the Edit panel, just like for any 
other block. Use the IR Select parameter to choose the index number for the 
desired IR from your IR Library. Remember that you’ll need to import IR files into 
your Helix or HX device using the application’s IRs tab for an IR block to utilize 
them—see “Importing and Exporting IRs” on page 16.

Looper Block Options - It is possible to add a Looper type block to a preset, 
and view and edit several Looper block parameters within the Edit tab. However, 
it is not possible to toggle the Looper mode of your connected device on and off 
within the HX Edit application.
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TIPS: 
Right-click on a slider for a handy menu to assign external control of the parameter to one 
of your Helix or HX device’s controllers, or to an external MIDI controller—also see page 
42. 
Alt+Click directly on slider in the Edit tab to instantly create a Snapshot Controller 
Assignment for the parameter—see page 24.
By default, all Amp & Effects blocks’ bypass state is automatically stored and recalled per 
Snapshot. If you prefer, you can exclude a block’s bypass state from being recalled via 
Snapshot changes—see page 24.

Link Dual Cabs Option
For Dual Cab and Dual Legacy Cab blocks, you can enable the global Link Dual Cabs 
option within the Edit tab (see “Link Dual Cabs Option” on page 66) if you prefer 
the secondary Cab model to automatically change to match your primary Cab model 
selection. This option is Off as the initial default, and can also be accessed within your 
device’s Global Settings>Preferences.

The Link Dual Cabs button - Off The Link Dual Cabs button - On

Editing Input, Output, Split & Mixer Blocks
Much like Amp & Effects blocks, you can click on the Input, Output, Split or Mixer 
blocks of any path and access their options in the Edit panel. 

Input Block Options: 

•	 Helix, HX Stomp XL, and HX Stomp Devices - Different parameters, such as 
Gate, Level, Pan, etc., are displayed depending on the specific input type you 
select from the Input block’s menu. If the Multi or Variax input type is selected 
(available on Helix devices only), you’ll see options here for selecting a Variax 
model, individual string tunings & levels, and more. 

NOTE: As of v3.15, Helix devices include an Input block - Guitar In Pad level option for 
the Guitar Input, which you can set On or Off per preset, or set to Global, which then allows 
the Pad to be set On or Off via the device’s Global Settings > Ins Outs > Guitar In Pad 
option.

Similarly, HX Stomp XL and Stomp devices include an Input block - Input Level option. 
You can set this to Pad/Instrument or Line level option per preset, or set to Global, which 
then allows the level to be set to Pad/Instrument or Line level via the device’s Global 
Settings - Ins Outs - Input Level option.

•	 HX Effects Devices - The path’s input is “fixed” and, therefore, is not selectable 
and does not offer block options.

Output Block Options:

•	 Helix Devices - When the Output block of any path is selected, you’ll see output 
routing options available, as well as other options the selected Output block for 
your device offers (Pan, Level, L6 LINK - Powercab® & DT amp options, etc.). In 
addition to your Helix device’s analog and digital outputs, you can also choose 
to route the output of one path to the input of another later path. Note that you 
can route the output of Path 1 into Path 2 in a “serial” fashion to take advantage 
of both paths’ DSP capacity! 

NOTE: When an FX Loop block exists within your Helix preset, the Output block will not 
offer options to choose the same Send output(s) as utilized by the existing FX Loop block. 
Likewise, once an Output block is set to utilize an Send output(s), no FX loop block which 
utilizes the same Send output(s) can be added to the preset.

NOTE: When an FX Loop block exists within your Helix preset, the Output block will not 
offer options to choose the same Send output(s) as utilized by the existing FX Loop block. 
Likewise, once an Output block is set to utilize an Send output(s), no FX loop block which 
utilizes the same Send output(s) can be added to the preset.

•	 HX Devices - When a split path is created, the Mixer block can be dragged 
down to Path B to create a separate “Send” output (see “Split Path Options” 
on page 31). When this dual-output, split path configuration exists, you can 
click on the Path A (Main) output or the Path B (Send) output to access Pan and 
Level parameters for each. The HX Stomp XL and HX Stomp devices’ Path B 
output additionally offers a Mono/Stereo option.

NOTE: When an FX Loop block exists within your HX preset, it is not possible to move a 
Merge-Mixer block to create a Path B output, since the Send L/R outputs are already in 
use—see “Split Path Options” on page 31.

Split Block Options - If your preset includes a split path, click directly on the 
point on the main path where the signal divides to select the Split block and you’ll 
see options for choosing different Split block types and their parameters. Note 
that there is also a Bypass switch for Split blocks which, when bypassed, feeds 
an equal signal balance to each parallel path.

Mixer Block Options - If your preset includes a split path, click directly on the 
point on the main path where the signal returns to select the Merge-Mixer block 
and you’ll see several mixer options for blending the two paths’ signals.
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L6 LINK - Powercab Plus and DT 25/50 Amp Options
Helix Floor, Rack, and LT devices include the Line 6 proprietary L6 LINK technology, 
providing a simple, single-cable connection for mono/stereo audio and remote control 
capability between Helix and up to two Line 6 Powercab Plus 112 or 212 powered 
speaker systems or DT 25/50 amps. This allows you to store and recall Powercab Plus/
DT parameters via your Helix device—globally or even per Helix preset! 

For L6 LINK functionality, the following versions (or later) are required:

•	 Helix device firmware v2.80 
•	 Powercab Plus system firmware v2.00 
•	 HX Edit v2.80 (if you wish to use HX Edit to access these Helix-L6 LINK 

parameters). 
For best results, it is highly recommended to use the latest available software and 
firmware versions for all your Line 6 products.

These options are accessible in HX Edit by selecting the Output block within the Signal 
Flow window, and choosing either the Multi or Digital output block type within the Edit 
tab. Click on the Powercab or DT 25/50 tab to configure the desired options for your 
respective device(s).

The L6 LINK Powercab and DT 25/50 amp options

Within the Powercab and DT 25/50 tabs, you’ll see the following sets of controls at the 
top of the screen.

Remote - Selects the Speaker Remote behavior from Helix to your connected 
Powercab Plus or DT unit(s).

•	 Off - No remote control settings are sent from Helix to the unit(s).

•	 Preset - All settings within the tab are saved with this Helix preset only, and are 
sent from Helix to the L6 LINK-connected unit(s) upon load of the Helix preset.

•	 Global - All settings with this tab are sent from Helix to the L6 LINK-connected 
unit(s). These sent settings remain the same regardless of the Helix preset that 
is loaded.

Note that the following three options will change to indicate whether they are 
applied per preset or globally, depending on the respective Remote option 
selected.

Mode - (Powercab tab screen only) Select the desired Powercab Mode (Flat, 
Speaker, or User IR). 

Flat Voicing - When Flat is selected for the above Powercab Mode option, 
you’ll see this row of controls to select either FRFR, LF Flat, or LF Raw for 
the Voicing function of the Powercab Flat mode.

Select - Allows you to configure the remote settings for each unit “1” and “2” of 
the L6 LINK-connected unit(s), or “1+2” for adjusting both simultaneously. You’ll 
see the sliders within the tab change accordingly when you select 1, 2, or  
1+2 Link, allowing you to control the respective unit(s), as described below.

•	 When using one Powercab 112 Plus or a single DT amp - it can be controlled 
from Helix by selecting 1.

•	 When using two Powercab 112 Plus systems or DT amps - the first can be 
controlled from Helix by selecting 1, the second can be controlled by selecting 
2, or both can be controlled as one by selecting 1+2 Link.

•	 When using one or two Powercab 112 Plus amps - selecting 1 controls the 
left speaker(s) of the unit(s) and 2 controls the right speaker(s), or both speakers 
can be controlled as one by selecting 1+2 Link.

NOTE: Any of the individual sliders within the tab can optionally be assigned to the Snapshot 
controller and then the slider value changed per Snapshot. Or, any slider can be assigned to a 
Helix hardware or external MIDI controller, and the slider value changed remotely. These controller 
assignments will function whether the L6 LINK settings are configured for the above Preset or 
Global operation.

Please refer to your Powercab Family Pilot’s Guide or DT amplifier documentation for 
details on the individual Mode, Speaker, and other options available for these devices. 

NOTE: L6 LINK can also be used to connect up to two Line 6 StageSource powered speakers. 
When two StageSource speakers are connected, the Helix left channel audio is automatically 
routed to the first StageSource and the right channel audio to the 2nd StageSource. Helix does 
not send any control or parameter messages to StageSource speakers via L6 LINK, therefore, 
there are no Helix Output block options to configure.

https://www.line6.com/manuals
https://line6.com/legacy/
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The Bypass/Controller 
Assign Tab
This tabbed panel combines the options found within the Controller Assign screens 
of your Helix or HX device (as well as the options within the Helix, HX Stomp XL, and 
HX Stomp devices’ Bypass Assign screens), allowing you to assign model parameter 
functions to your device’s footswitches & expression pedals, or external MIDI controllers 
for real-time, remote control. It is also possible here to assign model parameters to be 
stored and recalled with snapshots, as well as to customize footswitch labels and LED 
colors.

HX Device Owners: HX Edit functionality described in this chapter is the same for 
all Helix and HX devices, except where noted.

TIP: For creating & managing assignments for the transmission of MIDI commands from your 
(Helix or HX Effects) device’s footswitches and pedals, see “The Command Center Window” 
on page 46. 

In addition to the options for creating assignments, a list of existing bypass & controller 
assignments for the current preset appears within the left portion of this panel, allowing 
you to select and edit assignment options. (This handy display of existing assignments 
in one list is something not found on your Helix or HX devices’ screens.)

Column HeadersAssignment List Selected Block

Selected Assignment Bypass/Control 
Parameters

Footswitch/Controller 
Menu

Assignment Menu

The Bypass/Controller tab

Attention Helix Native Plugin Users: The Helix Native plugin’s Automation/Controller 
Assign panel supports a different set of controller assignments (for use with host DAW 
software’s parameter automation). Therefore, Helix Native will essentially ignore any HX Edit-
created hardware controller assignments saved in a preset—see “Preset Compatibility” on 
page 4.

Editing an Existing Assignment
When working with Factory Presets, you’ll see that most already have some existing 
assignments, and they appear within the Assignments List at the left of the Bypass/
Controller Assign tab (see the previous image). Once you create your own Bypass & 
Controller assignments, you’ll see them appear within this list as well. At any time you 
can select an assignment within the list to see and edit its options, as described below. 
Please also refer to the following examples for creating specific assignments types for 
more info.

Clearing Existing Assignments
If you right-click directly on any existing Bypass or Controller assignment within the 
Assignment List, you’ll find handy options for deleting the selected or all assignments.

The Clear Assignment options within an assignment’s context menu

Clear Assignment - Deletes the assignment that you clicked on. 

Clear All Assignments - Deletes all Bypass, Controller, Snapshot, and MIDI 
assignments that exist within the current preset.

Minimum & Maximum Sliders
Use the Min & Max sliders to set the range of control. For example, if creating a 
controller assignment utilizing an EXP Pedal, the Min setting equates to the pedal’s 
“heel down” value, and the Max to its “toe down” value. If assigning to a footswitch, 
clicking the switch toggles between your configured Min & Max values. (Note that if 
assigning to a snapshot, all you need to do is set the single parameter value you wish 
to be recalled with the currently-loaded snapshot.)

TIP: You can “reverse” the behavior of a controller by setting the Min to 100% and the Max to 
0%, such as to make an assigned Wah pedal work backward! 

Latching/Momentary Footswitch Option
For amp & effects models, you’ll also find the Type option here to have the assigned 
footswitch behave as Latching (alternating On/Off on each click) versus Momentary 
(active only while the footswitch is held down).
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MIDI CC In Selector
For assignments that offer remote control via external MIDI, this parameter is where 
you can define the specific MIDI CC value (CC 0-127) to match the MIDI CC value 
being transmitted from your external MIDI controller device or MIDI software. Your MIDI 
hardware or software must be capable of sending MIDI CC messages via 5-pin MIDI 
cable or USB to your Helix or HX device.* 

*NOTE: Your Helix or HX device can receive MIDI from either its 5-pin MIDI IN jack or over 
USB. (MIDI over USB can be received when connected to a computer, via a DAW host or 
MIDI software.) Use the device’s Global Settings - MIDI Tempo options to configure its 
receiving MIDI channel and other MIDI options.

Snapshot Control On/Off
Whenever a parameter (other than Bypass) is configured with a Variax knob, footswitch, 
or MIDI type controller assignment, by default, the parameter is also automatically 
assigned to Snapshots. As of v3.50, you can configure whether the parameter’s values 
are recalled per Snapshot (Snapshot Control On) or not (Snapshot Control Off). This 
setting is saved with your preset. 

The Snapshot Control On/Off option

Switch LED Option
By default, the color of the LED light surrounding your assigned footswitch is set to 
Auto Color, where it intelligently takes on the color according to the assigned model 
type. You can optionally use this slider to manually configure this LED color as desired.

Customizing a Footswitch Label
For any selected Bypass or Controller assignment that is created using your device’s 
Footswitch, you’ll see a Customize control displaying the block model’s default name. 
This is the label displayed on the hardware’s scribble strip for this footswitch (or on 
the LCD screen for a Helix LT, HX Stomp, or HX Stomp XL device) when your device is 
in Stomp Footswitch Mode. If you want to customize this label, double-click on the 
existing name, type your new text in the field, and hit your Enter/Return key. To clear 
your text and return to the default model label, click the Clear (eraser) button to the 
right of the field.

The Customize label control

NOTE: If a footswitch includes one or more additional block Bypass, Controller, or 
Command Center assignments, the default label appears as Multiple (X) with “X” being 
the number of assignments. You can customize the label in this scenario, but note that it 
can also be customized within the Custom field of the other assignment panels as well, 
with the latest customization edit affecting the label in all places.

Creating a Bypass Assignment
Create a Bypass assignment for any Amp, Cab, IR, Effect, Looper, or Split type block to 
allow it to be toggled on/off via one of your Helix or HX device’s footswitches, controllers 
or via external MIDI.

NOTE: On Helix devices, adding a Volume Pedal, Pan, Wah, or Pitch Wham block 
automatically creates a Bypass assignment to the Helix onboard pedal’s EXP Toe 
footswitch. On HX devices, a Bypass assignment is automatically created for these block 
types on EXP 1 / EXP 2. You can change or clear this assignment if desired—see “Editing 
an Existing Assignment” on page 39.

Creating a Bypass Assignment Using a Footswitch 
1.	 Click on the block within the Signal Flow for which you want to create the 

Bypass assignment. 

2.	 At the right of the Bypass/Controller Assign panel, if not already selected by 
default, click the Assignment Menu and choose Bypass as the parameter to 
control. 

3.	 Click on the Footswitch/Controller Menu to select the desired footswitch or 
controller and your assignment is created. 

Selecting a footswitch controller for block Bypass assignment

TIP: Alternatively, right-click on a block within the Signal Flow and choose the desired 
Footswitch or Controller to quickly create a Bypass assignment.

Creating a Bypass Assignment Using an External MIDI Controller Source
It is also possible to configure a block to be controlled remotely via an external MIDI 
controller switch, or via MIDI software on your DAW computer. All that is required is that 
the MIDI controller is capable of sending MIDI CC messages via 5-pin MIDI cable or 
USB to your Helix or HX device.* 
A MIDI Bypass assignment can be created independently of a Helix or HX hardware 
controller source assignment for the same block. You will only see one Bypass assignment 
entry displayed within the HX Edit app’s Assignments List, regardless if it includes an 
active MIDI assignment source, hardware controller assignment source, or both.

*NOTE: Your Helix or HX device can receive MIDI from either its 5-pin MIDI IN or over USB. 
(MIDI over USB can be received when connected to a computer, via a DAW host or MIDI 
software.) Use the device’s Global Settings - MIDI Tempo options to configure its 
receiving MIDI channel and other MIDI options.
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1.	 Click on the block within the Signal Flow for which you want to create the 
MIDI-In Bypass assignment. 

2.	 At the right of the Bypass/Controller Assign panel, if not already selected by 
default, click the Assignment Menu and choose Bypass as the parameter to 
control. 

3.	 Set the MIDI In parameter to match the MIDI CC number (0–127) that your 
external MIDI controller is sending. To “disable” the MIDI assignment, simply 
set this parameter to Off.

Setting the MIDI In’s CC number in the Bypass/Controller Assign panel

Or, instead of steps 2 & 3 above, you can right-click directly on the desired 
block within the Signal Flow and choose MIDI In and your MIDI CC from the 
menu. 

Setting the MIDI In’s CC number from the block’s right-click menu

Your configuration is now complete and your external MIDI source should 
successfully toggle the selected block’s Bypass. You’ll also see the CC number 
you selected shown in the Assignment list’s Source column (“MIDI In 11”).

TIP: Alternatively, you can utilize the Learn (MIDI Learn) feature within the Bypass Assign 
screen of your Helix or HX device to create a MIDI Bypass Assignment. 

NOTE: With Helix and HX Effects devices, you can use CC67 to toggle the Bypass of a 
Looper block. This is a pre-defined, global MIDI CC hardware assignment that does not 
appear within the HX Edit Bypass/Controller Assign panel.

Creating a Bypass Assignment Using an Expression Pedal
It is also possible to assign a block’s Bypass to an Expression pedal (or to a Variax 
knob on Helix devices). An example of this is to configure a Wah block so that resting 
the pedal at the “heel” position toggles the effect off, and then moving the pedal away 
from this position to use the Wah automatically activates the effect again. Set this type 
of configuration using the following steps.*

*HX Effects Owners: On HX Effects, this type of EXP 1 - Bypass configuration is 
configured automatically for any Wah or Pitch Wham type block you add to your tone, 
and to EXP 2 for any added Volume/Pan block. You can follow these steps to manually 
create an EXP Pedal - Bypass assignment for any type of block.

1.	 If using a Helix device with an onboard EXP 1 pedal, move the pedal forward 
and click the Toe Switch so that it is set to EXP Pedal 1.

2.	 On a Helix, HX Stomp XL, or HX Stomp device, since the Wah block is already 
automatically assigned to a footswitch for bypass, you’ll need to change its 
Bypass assignment to EXP Pedal 1 instead. 

3.	 Add a Wah block to your tone. Select the Wah block in the Signal Flow view 
and go to the Bypass/Controller Assign tab. Select the existing Bypass 
assignment in the list at the left, then select the EXP Pedal 1 controller from 
the Controller/Switch menu at the right.

Selecting an expression pedal controller for block bypass assignment

4.	 Once the assignment is created, you can configure its option sliders at the 
right of the panel.

Configuring an expression pedal - Bypass assignment options

•	 Position - For a Bypass assignment, this determines the position of the 
controller where the block’s bypass is triggered. Set this slider to 5% or lower 
to establish a “heel down” resting position to trigger your bypass toggle.
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•	 Wait - Determines the duration of time for which the assigned controller must 
rest at the configured Position value before the bypass is triggered. For this 
type of Wah Bypass assignment, 300 ms is generally a good setting, since it 
prevents unwanted bypass triggering during the typical use of the pedal for 
your Wah effect.

•	 Behavior - Determines what position of the expression pedal triggers the 
block’s Bypass state: Toggle (when moving the pedal, the default option), on 
Heel Down, or on Toe Down.

Once configured using the default settings, you’ll see that when you move your 
EXP 1 pedal, it toggles the Wah block on, and when you move the pedal to the 
heel position and rest it there for 300 ms or more (as determined by the Wait 
slider), the Wah block is bypassed. You can choose to configure other blocks’ 
parameters with a “pedal bypass” using these same steps as well.

TIP: By default, all blocks are automatically assigned for Snapshot Bypass—that is, each 
block’s bypass state is automatically remembered and recalled per Snapshot by default. You 
can also choose to exclude any block from Snapshot Bypass—see “Configuring & Managing 
Snapshots” on page 24.

Bypass Assignments for Multiple Blocks
For Helix & HX hardware, you can only assign the Bypass toggle of any particular 
block to one footswitch at a time. If a block already has an existing Bypass assignment 
and you change the assignment, this will move the assignment to the newly selected 
footswitch or controller. But it is possible to assign the Bypass function for multiple 
blocks to one common footswitch or controller for simultaneous switching. 

Each Helix or HX device’s footswitch or controller can have up to 8 assignments. 
You can additionally create Controller and (on Helix or HX Effects) Command Center 
assignments utilizing footswitches that simultaneously include Bypass assignments. 
It’s also possible to create snapshots that include multiple Bypass & other parameter 
changes all in one click—see the respective sections for more on these assignment 
types!

Block Bypass Assignment Indicator
Once you’ve created a Bypass assignment for a block, you’ll see the block’s name label 
displayed in brackets to indicate this. (See page 30.)

Bracketed block labels indicate block bypass assignments

TIP: A handy trick is to create a multi-bypass assignment to toggle one block off and the other 
on simultaneously, such as to change between two different distortions, between two different 
amps, etc. To reverse the switching, select one block within the Signal Flow and manually click 
its Bypass button so that one block is in the opposite bypass state as the other. Now whenever 
you toggle the assigned Bypass footswitch, both blocks’ bypass states are toggled oppositely.

Creating a Controller Assignment
Just as on your Helix or HX device’s Controller Assign screen, you can create a 
Controller assignment for practically any block’s parameter (yes, even any Input, 
Output, Split and Merge block parameter!) to allow it to be controlled by a remote 
device’s footswitches or controllers, or by external MIDI gear.* Here in the Bypass/
Controller Assign tab you can also configure a Snapshot assignment, to allow your 
desired parameter settings to be stored & recalled with a preset’s snapshots.

*NOTE: Your Helix or HX device can receive MIDI from either its 5-pin MIDI IN or USB. 
(MIDI over USB can be received when connected to a computer, via a DAW host or MIDI 
software.) Use the device’s Global Settings - MIDI Tempo options to configure its 
receiving MIDI channel and other MIDI options.

TIP: Whenever a parameter is configured with a Variax knob, footswitch, or MIDI type 
controller assignment, by default, the parameter is also assigned to Snapshots. You can 
choose to toggle this behavior On/Off for each assignment—see “Snapshot Control On/
Off” on page 40.

Creating a Controller Assignment Using an EXP Pedal or Footswitch
1.	 Click on the block within the Signal Flow that includes the parameter for which 

you want to create the Controller assignment. 

2.	 At the right of the Bypass/Controller Assign panel, click the Assignment menu 
and choose the parameter to control—for this example we’ll choose the Mix 
of a 70s Chorus block.

Selecting a Chorus block’s Mix parameter for controller assignment 

3.	 Click on the Switch/Controller menu to select the desired controller and your 
assignment is created. We’ll choose the EXP Pedal 1, but you can alternatively 
choose any EXP Pedal (or if using a Helix device, one of the Variax Knob 
controllers). It is also possible to choose one of your device’s Footswitches as 
the controller, which allows you to then configure a specific parameter value 
for each of the two states of the footswitch. More on this in the final step.

Selecting an EXP Pedal controller for controller assignment
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TIP: Alternatively, right-click on the Mix slider for the 70s Chorus within the Edit tab to access 
the context menu and quickly create a Controller assignment.

4.	 Once you’ve created the Controller assignment, you’ll see it appear in the list 
at the left of the Bypass/Controller Assign tab. Select the assignment in the 
list to access options specific to the type of controller you’ve chosen. For 
EXP Pedal and Variax Knob controller types, there are options for the Min 
and Max, which allow you to limit the range of the assigned parameter as you 
move the pedal or knob controller from minimum to maximum position. For 
our example, we’ll set the Max slider to 50% so that it achieves a 50% wet/dry 
Mix balance when our controller is moved to full open.

Configuring options for an EXP Pedal controller assignment

If you have chosen a Footswitch as your controller rather than an EXP Pedal or 
Variax Knob, you’ll have a few more options, as described below.

Configuring options for a footswitch controller assignment

•	 Type - Choose the footswitch behavior:
•	 Latching - Press and release the footswitch to toggle between the “On/Off” 

states.
•	 Momentary - Press and hold and the footswitch. While held down, the “On” 

state of the switch is active. While released, the “Off” state is active.

•	 Min and Max - Configure these two sliders to the specific values you’d like the 
“Off” and “On” footswitch states of the assigned footswitch to toggle between. 

•	 Switch LED - Customize the color of the LED that surrounds the assigned 
footswitch on your device. 

•	 Customize - You can edit the name that appears for the assigned footswitch 
label on your device by clicking in this field. To return to the default label, click 
the eraser button.

Creating a Controller Assignment Using an External MIDI Controller 
Source
It is also possible to configure a block’s parameter to be controlled remotely via an 
external MIDI controller device, or via MIDI software. 

1.	 To configure a parameter for external MIDI control, you can essentially use the 
same steps as in the above controller assignment example. However, in step 3 
you will want to select MIDI CC from the Footswitch/Controller Menu.

Selecting MIDI CC as the controller type 

2.	 Once the assignment is created, configure the Min & Max sliders to limit the 
range of the assigned parameter control, if desired. You then need to set the 
MIDI CC In slider value to match the MIDI CC number being sent from your 
external MIDI source. If this value does not match the MIDI CC being sent, the 
parameter will not respond.

Configuring a MIDI CC assignment’s options

Your configuration is now complete and your external MIDI controller source 
should successfully control the selected 70s Chorus - Mix parameter. The 
assigned CC number is shown in the Assignment list’s Source column (“MIDI 
CC 16”) for reference.

TIP: Alternatively, utilize the Learn Controller (MIDI Learn) feature within the Controller Assign 
screen of your Helix or HX device to create a MIDI Controller assignment. 
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Creating a Snapshots Controller Assignment
Configure a block’s parameter with a Snapshots assignment to allow the parameter’s 
settings to be stored & recalled with a preset’s snapshots. 

1.	 Since a Snapshots assignment is simply one type of controller assignment, 
you can follow the same steps 1 and 2 from “Creating a Controller Assignment 
Using an EXP Pedal or Footswitch” on page 42 to select the block within the 
Signal Flow, and then choose the desired parameter in the Bypass/Controller 
Assign tab’s Parameter Menu. 

2.	 In the Controller Menu, choose Snapshots.

Selecting the Snapshots controller type

TIP: Click on the desired slider within the HX Edit Edit tab and use the “Alt+click” or “S” 
keyboard shortcuts to instantly create a Snapshots controller assignment. 

3.	 Unlike with other controller types, you won’t see any options in the right of the 
Bypass/Controller tab for a Snapshots controller assignment. 

A snapshots assignment is created—there are no configurable options for this assignment type

With this assignment created for the parameter, simply choose the desired 
snapshot from the Snapshots Menu at the top of the HX Edit application 
window, and then whatever value you set for this parameter is automatically 
stored and recalled with the snapshot. This allows you to configure up to 8 
different values on Helix devices (or 4 values on HX Effects and HX Stomp XL, 
or 3 values on HX Stomp) for each preset—one for each available snapshot. 
Please see your device’s Owner’s Manual for details on using snapshots.

Controller Assignments for Variax & L6 LINK Parameters
(Helix devices only) It is also possible to create hardware, MIDI, and snapshot controller 
assignments for the individual Input block–Variax parameters, and Output block–L6 LINK 
(Powercab and DT 25/50) parameters. 

Controller assignments can be created the same as any other block parameters, by 
selecting the Input or Output block, and ether right-clicking directly on the desired Edit 
tab–parameter slider, or by using the menus within the Bypass/Controller Assignment 
tab. Note that these parameter types are grouped within their own sub-tab panels within 
the Edit tab. Please also see “L6 LINK - Powercab Plus and DT 25/50 Amp Options” on 
page 38.

As an example, the following shows a Footswitch Controller assignment created for 
the L6 LINK–Powercab–Speaker Type select parameter within the Bypass/Controller 
Assignments tab. In the Assignments list at the left, you can see the created assignment 
selected, so that the assignment’s options appear in the inspector at the right. Note 
that, since the options for this assignment are deep within the Bypass/Controller tab’s  
Powercab sub-tab, a “back” arrow button is available at the top left of the inspector 
pane. Clicking this allows you to easily navigate back to the main Output block options.

Back button

Options for an existing L6 LINK–Powercab parameter’s Footswitch Controller Assignment

http://line6.com/support/manuals/
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Multiple Controller Assignments
Just as on the hardware, you can only assign a parameter to one Controller at a time. 
However, it is possible to assign multiple parameters to one common Controller, for 
example, you could create the following Controller assignments:

•	 Configure an EXP Pedal for the Mix parameters of two different effects to blend 
between them.

•	 Configure an EXP Pedal to simultaneously adjust a few of the Input block > 
Variax String Level parameters if you happen to want that level of control over 
individual string volumes!

It is also possible to create additional Bypass assignments and/or Command Center 
assignments on footswitches that also include Controller assignments—see the 
respective sections for more on these assignment types.

NOTE: If a footswitch includes one or more additional block Bypass, Controller or 
Command Center assignments, the default label appears as Multiple (X) with “X” being 
the number of assignments. You can optionally customize the footswitch label—see 
“Customizing a Footswitch Label” on page 40. 

The footswitch label can also be customized within the Customize label field within the 
Command Center window, with the latest customization edit affecting the label in all 
places. See the next chapter.

Automatic Preservation of Controller Assignments
Your Helix or HX device incorporates an automatic “preservation” for all controller 
assignments, with the exception of Snapshot assignments, when changing a block’s 
model. For assignments to be preserved, the newly selected model’s assigned 
parameters need to be similar in type and scale. 

For example, if you’ve configured the Drive slider of the Amp+Cab model to be assigned 
to an Expression Pedal controller, you can then select most any other Amp+Cab, Amp, 
or Preamp model for this block, and the Expression Pedal controller will automatically 
re-assign itself to the Drive slider of the new model. Likewise, if you have a Delay’s Mix 
parameter automated, the Mix parameter assignment will typically be preserved for the 
Mix parameter of most any other type of FX model that includes a Mix slider.

For the cases where controller assignments cannot be preserved automatically (e.g., 
when a block’s model is changed to one with a very different set of parameters), the 
controller assignment is deleted.
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The Command Center Window
To display the Command Center window, select it from the application’s Window 
menu. This window offers the options found within the Helix or HX devices’ Menu - 
Command Center screen, allowing you to create MIDI, Bank/Program, MMC, External 
Amp Channel Switching, and even Hotkey (QWERTY key) output assignments (as 
well as CV assignments on Helix devices) to remotely control other gear from your 
device. You can also configure footswitches to expand your device’s Stomp mode with 
additional control functions (see “HX Preset, Snapshot, and Looper Commands” on 
page 48). Please refer to your Helix or HX device Owner’s Manual for details on 
the types of commands supported and their options. Many of the Command Center 
window functions are also accessible using keyboard shortcuts—see page 72.

The Command Center window is a “floating” window, therefore, you can keep it open or 
closed as desired while using HX Edit. If it gets hidden behind the main HX Edit window, 
simply click on it, or use the Cmd+Shift+M (Mac) or Ctrl+Shift+M (Windows) shortcut 
to bring it to the foreground.

TIP: Your Helix or HX device makes an excellent external USB remote control device for host 
DAW and other popular software applications! Note that you can easily copy and paste all 
commands into other presets too—see “Cut, Copy, Paste, and Clear Commands” on page 47.

For Helix devices, check out the presets that include “Remote” in their titles, found within 
the TEMPLATES Preset Library, which are pre-configured for sending commonly used 
control commands for specific, popular DAW applications. Several of the Template presets 
are configured with Hotkey assignments to control other software apps (see the following 
“Hotkey Assignment “section).

Command Menu

EXP Pedals

Instant Controllers 
Variax Knobs 

Footswitches

EXP Pedal Toe Switch
Snapshots Menu

Selected Controller

Inspector Done Button

The Command Center window (Helix Floor device)

NOTE: The application’s Command Center window will show Control selector items 
specific to your device. For example, as shown above, the Helix Floor device offers more 
hardware options for controller assignment (Variax Knobs, 3 EXP Pedals, and a Pedal Toe 
switch), than are available with an HX device.

Command Center assignments remain intact on exported presets, and are translated 
where possible when loaded on a different Helix or HX device type—not all Command 
Center assignments may be available if the new device does not include the equivalent 
footswitch and controller types.

Attention Helix Native Plugin Users: Helix Native does not include the Command Center 
or support for creating or customizing these types of commands. However, existing 
Command Center assignments are retained even after loading, editing, or exporting presets 
with Helix Native. See “Preset Compatibility with Helix Native Plugin” on page 4.

Creating a Command Center Assignment
Click directly on any source Control Selector item (Instant , Footswitch, EXP Pedal, 
or Variax Knob) for which you want to map an assignment. Then, in the inspector pane 
at the right portion of the window, click on the Command menu to choose the type 
of message you wish to transmit from this source control. Once a command type is 
selected, configure its options using the parameter sliders that appear. Once you save, 
these Command Center settings are stored individually with the current preset.

You’ll see a turquoise triangle indicator above the source control items which include 
an assignment. To remove an existing assignment, select the source control item again 
within the Command Center window and choose None from the Controller menu, or 
right-click and choose one of the Clear Command options from the context menu.

Assignment Indicators

http://line6.com/support/manuals/
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Creating a Hotkey Assignment
Any Instant or Footswitch type controller on your Helix or HX Effects device can also be 
configured to send “QWERTY” keyboard commands to your computer via USB. This 
allows you to remotely control DAWs, DJ software, lighting software, media players, 
video software, browsers, photo editing software, video games, etc… If you can control 
it with your computer keyboard, you can now control it with your feet! To create a 
Hotkey assignment:

1.	 Select the desired Instant or Footswitch controller (we’ll choose Footswitch 4), 
then choose Hotkey from the Command menu to see the options.

The Hotkey options

2.	 Manually choose your specific command by clicking the Keystroke dropdown 
menu, selecting the desired keyboard character, and optionally adding up 
to three modifier keys (Shift, Control, Command, etc.) via the three Modifier 
options.*

Or, even easier, use the “Learn” function by clicking on the little keypad icon 
button in the Keystroke section, and then you’ll see it turn green, awaiting your 
keyboard command to be typed.

Awaiting a keystroke to “learn” your Hotkey command

Now simply type any key, or any combination key and modifier key(s) in one 
keystroke, and HX Edit will automatically learn and apply it as your command. 

3.	 Use the Type option to choose the behavior you prefer for your Footswitch 
(Latching or Momentary). Optionally use the Switch LED selector and 
Customize field to add a custom LED color and scribble strip label to your 
device’s Footswitch (see the following sections for details).

*NOTE: On your Helix/HX Effects device screen, you’ll see a single Mac/PC option within 
these three Modifier menus—this selection corresponds to the Windows key on Windows 
OS systems, and to the Command key on macOS systems.

Cut, Copy, Paste, and Clear Commands
Just as on your Helix or HX Effects device, there are options available to easily Cut, 
Copy, Paste, and Clear Command Center assignments. Using these commands from 
the application’s Edit menu*, from the individual controls’ right-click context menu, 
or using “Keyboard Shortcuts”, you can copy and paste an assignment from one 
controller to another, copy & paste all command assignments within the current preset 
to another preset, clear the current command assignment, or clear all of the preset’s 
current command assignments. 

*NOTE: On Mac computers, these commands are available from the main application’s 
Edit menu when the Command Center window has focus. 

On Windows computers, the Command Center window includes its own Edit (and 
Snapshots) menu:

The Command Center context menu’s Cut, Copy Paste & Clear commands

NOTE: Customized label and LED color options for Footswitch controls are not copied 
with a footswitch’s commands (to allow the target footswitch’s existing label and colors to 
remain unchanged).

It is also possible to paste within the Command Center window for any other preset, even 
if a different Helix device is connected to the HX Edit application while your last-copied 
command data still exists on the clipboard. At this time, it is not possible to utilize the 
Copy All Commands and Paste All Commands options between different devices.

NOTE: The different Helix device types offer varying sets of Command Center assignment 
options, therefore, unsupported commands cannot be copied between different Helix 
devices.
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To Cut, Copy, or Clear - Simply right-click on the desired instant , Footswitch, EXP 
Pedal, or Variax Knob source controller item that includes the assignment and choose 
the command from the context menu. 

•	 Use Cut if you want to clear the assignments of the selected Control Select 
item, and also copy the assignments to the clipboard.

•	 Use Copy All if you want to copy the complete set of existing Command Center 
assignments within the current preset and you can then load a different preset 
and use Paste All Commands within its Command Center window to copy all 
in one action.

•	 Use Clear All if you want to wipe out all the Command Center assignments 
from the current preset and start clean.

To Paste - Once you’ve copied Command Center assignment data to the 
clipboard, right-click on your desired destination controller item (within the same 
preset, or in another) and choose the Paste or Paste All option.*

*NOTE: It is not supported to copy and paste the commands between Instant and 
Footswitch type source controllers.

Configuring Unique Command Values Per Snapshot
Once you’ve created an assignment to any Instant, Footswitch, Pedal, or other controller 
within the Command Center, it is possible to configure the command’s values differently 
per snapshot if desired, allowing a great deal of message variety possibilities within a 
single preset. (Most Commands’ parameter values are automatically stored & recalled 
per snapshot—there is no need to manually create a Snapshot controller assignment.)

For example, if you have configured one of the  Instant controllers with a MIDI CC type 
command, you can configure the MIDI Channel, CC #, and/or Value to be different per 
Snapshot, thus triggering a different function on your MIDI-connected hardware each 
time you change to a different snapshot within the current Helix preset! 

Configuring the MIDI CC options on an Instant controller

TIP: For Instant commands, the Wait Time parameter (firmware v3.10 and later) allows you to 
delay certain events by up to 1000 ms. This may help your Helix/HX device control older MIDI 
gear that may behave incorrectly when receiving multiple commands at once.

Note that it is not possible to store or recall a different Command type per snapshot, 
only the values of the sliders for the current command (with the exception of the Switch 
LED color and Customize label values for Footswitch controllers). 

Please refer to your Helix or HX device’s Owner’s Manual for details about Command 
Center command types and their specific behaviors.

You’ll see a Snapshots menu at the top of the Command Center window. This menu 
is offered here as a convenience so that you don’t need to close out of the Command 
Center window just to select a different snapshot index number from the main window 
menu (although changing snapshots from the main window performs the same function). 

The Command Center’s Snapshots menu

To store your Command Center assignment settings per snapshot - First, select 
the desired snapshot index number from the Command Center’s Snapshots menu, then 
edit the values of your existing Control Center assignments that you wish to be stored. 
The settings are automatically retained per snapshot during editing—save your preset 
once your edits are complete. (See “Configuring & Managing Snapshots”.)

TIP: You can also Copy and Paste a Snapshot to any other Snapshot number, to save time 
recreating your Command Center and other Snapshot settings. Access these Copy and Paste 
Snapshot commands via the main application Snapshots menu (on Mac, when Command 
Center window has focus), of from the Snapshots menu at the top of the Command Center 
window (Windows).

HX Preset, Snapshot, and Looper Commands
These “HX” commands allow you to configure Stomp mode switches for even greater 
control of the internal functions of your device. These commands are saved per preset.

HX Command options within the Command Center Footswitch - Commands menu

NOTE: Although Stomp mode switches can be assigned to multiple functions, to 
avoid unintended behavior, we strongly recommend the HX Preset, HX Snapshot, and 
HX Looper commands are assigned only to empty footswitches.

http://line6.com/support/manuals/
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HX Preset - Allows you to configure a Stomp mode footswitch to immediately 
“jump to” any other preset within the current setlist. With any footswitch controller 
selected in the Command Center window, set the Command parameter to HX 
Preset, and then set the Preset parameter Next or Previous, or choose the 
specific preset (01A~32D) within the current setlist that you wish to load. 

HX Snapshot - Allows you to configure a Stomp mode footswitch to immediately 
recall any snapshot within the current preset. With a footswitch controller 
selected in the Command Center window, set the Command parameter to HX 
Snapshot. The additional options then allow you to recall the desired snapshot 
index number, or Next or Previous snapshot, independently per each Press 
and Release or each Press and Hold of the footswitch. (Note that the assigned, 
Stomp mode footswitch’s label and LED will only indicate the command assigned 
to the Press function.)

HX Looper - For a preset that includes a Looper block, this command allows you 
to configure an instant  or Stomp mode footswitch to trigger any function of the 
Looper (Play, Stop, Record, etc.).

NOTE: A Looper block must be present in your preset for HX Looper commands to 
function.

•	 With any instant  command controller selected in the Command Center 
window, set the Command parameter to HX Looper and then use the Function 
parameter to choose the specific Looper function you wish to trigger. (Note 
that it is possible to create HX Looper commands on more than one Instant 
command, so you’ll want to be careful not to set them to trigger multiple, 
conflicting Looper functions!)

•	 The HX Looper, instant  command assignment’s Function parameter value 
is automatically stored and recalled per snapshot. This allows you to record 
a loop and, for example, configure an instant command to automatically Play 
the Loop when loading one Snapshot, and Stop when loading a different 
Snapshot. 

•	 With any Stomp mode footswitch controller selected in the Command Center 
window, set the Command parameter to HX Looper. The additional options 
then allow you to toggle the desired Looper functions independently per each 
Press and Release or each Press and Hold of the footswitch. 
•	 Note that the assigned, Stomp mode footswitch’s label and LED will only 

indicate the command assigned to the Press function.

•	 The HX Looper command, Stomp mode footswitch assignment parameter 
values (Behavior, Press, and Release) are automatically stored and recalled 
per snapshot.

Customizing a Footswitch Label
When you create a Command Center assignment to the selected footswitch control 
within the Command Center window, you’ll see the Customize field available within the 
parameter display at the right. 

You can customize the text in this field to determine what is displayed on the hardware’s 
footswitch scribble strip (or on the screen for a Helix LT, HX Stomp, or HX Stomp XL 
device) when in Stomp Mode. To clear your text and return to the default label, click the 
Clear (eraser) button to the right of the field.

Clear buttonCustomize label field

NOTE: If the footswitch includes one or more additional block Bypass, Controller, or 
Command Center assignments, the default label appears as Multiple (X) with “X” being the 
number of current assignments. You can customize the label in this scenario, but note that 
it can also be customized within the Customize field of the Bypass/Controller Assignment 
tab as well, with the latest customization edit affecting the label in all places. 

This Command Center Footswitch Label - Customize option is not available for the 
footswitch if you have selected the HX Preset, HX Snapshot, or HX Looper type command.

Customizing a Footswitch LED Color
When the selected footswitch within the Command Center window includes a 
Command Center assignment, the color of the LED on/off indicator light surrounding 
your footswitch can be customized to your color choice for Stomp footswitch mode by 
using the Switch LED slider/menu at the right.* 

The Command Center - Switch LED parameter

The options are as follows:

•	 Choose one of the 10 colors

•	 Auto Color - The LED intelligently takes on the color according to the assigned 
model type. 

•	 Off - The LED remains unlit, regardless of the switch state.

*NOTE: This option is also found within the Bypass/Controller Assign panel. Customizing 
an LED in either will overwrite the LED’s current Stomp footswitch mode settings.

This Command Center - Switch LED option is not available for the footswitch if you have 
selected the HX Preset, HX Snapshot, or HX Looper type command.
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Global EQ Window
The Global EQ, accessed from the application’s Window menu, offers a large graphical 
interface for the Helix, HX Stomp XL, or HX Stomp device’s Global EQ feature.* As its 
name suggests, the Global EQ settings and bypass state are indeed global and not 
saved or recalled with any preset or snapshot. HX Edit functionality described in this 
chapter is the same for all Helix, HX Stomp XL, or HX Stomp devices, except where 
noted.

The Global EQ window is a “floating” window, therefore, you can keep it open or closed 
as desired while using HX Edit. If it gets hidden behind the main HX Edit window, simply 
click on it, or use the Cmd+Shift+G (Mac) or Ctrl+Shift+G (Windows) shortcut to bring 
it to the foreground.

*HX Effects Owners: HX Effects devices do not include the Global EQ feature.

Bypass Button

Done ButtonLevel Slider

Reset Button

Inspector Pane Band Parameters

Apply EQ Output Menu

Band Edit Nodes

The Global EQ is a 5-band, parametric style equalizer, situated after all other processing 
blocks of your signal path, allowing for sculpting your overall tone just before it is sent 
out your Helix (1/4" and/or XLR) or HX Stomp XL/Stomp (Main 1/4") outputs. This is 
especially handy for fine-tuning your tone to compensate for a venue’s stage or room 
sound, without having to go in and tweak all your presets.

Adjusting Global EQ Parameters
The Global EQ window offers two methods in which you can view & adjust its settings: 
by dragging any band’s edit “node” within the graph or by adjusting the selected band’s 
parameter sliders within the lower inspector portion of the window. The EQ processing 
is functional whenever its Bypass button is set to “active” in this window (or via your 
device’s Bypass button when viewing its Global EQ screen). 

Reset - Click the Reset button to instantly return all parameters to their default, 
“flat” values.

Apply EQ Output Menu - (Helix devices only) Select your Helix device’s output(s) 
on which you want the Global EQ to be active.

Bypass Button - Toggle the Bypass to globally enable or disable the EQ.

Band Edit Nodes - Click and drag the desired band’s Edit Node in the upper 
graph to adjust its Frequency and Gain. Note that the respective parameter 
sliders move within the inspector pane while adjusting any edit node.

Inspector Pane - This lower portion of the window offers a set of adjustable 
parameters for each of the EQ’s five bands.

Band Parameters - Each band has its own set of sliders. Note that the Low 
Cut and High Cut are “shelving” type filters, allowing you to set the roll-off point 
for the low and high frequencies, respectively. The middle 3 bands are fully 
parametric, with controls for choosing the center Frequency, Gain (with a boost 
or cut of up to 12 dB), and Q (the width of the frequency range affected). Adjust 
the sliders as follows:

•	 Click and drag any slider’s handle or use the Up/Down buttons at the right of 
each slider

•	 Right-click on a slider to enter a precise value numerically 

•	 Turn your mouse wheel while hovering your cursor over any slider

•	 Click on a slider and use the comma/period or -/+ shortcut keys to incrementally 
adjust its value 

•	 Double click on a slider to individually reset it to its default value

Level Slider - (Helix devices only) Adjusts the post-EQ output level, offering a 
“make-up gain” to compensate for the overall output level change incurred by EQ 
parameter settings.

Done Button - Click to close the Global EQ window.

TIP: Try the handy keyboard shortcuts for adjusting Global EQ options—see page 72. 
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Preferences and About Box
The Preferences Window
The HX Edit Preferences window includes three tabbed screens to edit application 
options: View, Presets/IRs, and Device Settings. This window is accessed by either 
selecting Preferences from the HX Edit menu (Mac), Help menu (Windows), or by 
clicking the Preferences button (or on the Helix/HX device indicator icon) at the bottom 
of the main HX Edit window.

Click the Preferences (gear icon button) or device indicator to open the Preferences window

NOTE: If you happen to have multiple Helix/HX devices connected, each HX Edit 
application window includes its own Preferences window, and all settings within it pertain 
to HX Edit’s use per individual device.

Restore Factory Settings

This button at the bottom left of the Preferences window resets all items in all three tabs 
of the Preferences window back to the initial factory default settings.

NOTE: Your Helix or HX device also includes several additional settings within its Global 
Settings screens (as well as its own Restore options) This Restore Factory Settings button 
restores only the settings shown within the HX Edit application’s Preferences window.

Check for Updates

Use this button to manually check for, and optionally install, any available HX Edit 
application or firmware updates for your connected Helix or HX device (an active 
Internet connection is required) See “Updater & Additional Resources” on page 84. 

Preferences - View Tab

The View tab

This tab includes two options.
Show/hide name labels - The Show Names setting is the factory default. If you 
prefer to have the Signal Flow window not show labels beneath each block, you 
can choose Hide Names here (see page 30).

Manage Favorites By - The Favorites tabbed panel and Model menu’s 
Favorites category by default match the same order as seen on your device. This 
Preference change the default Device List order to alternatively be sorted by 
model Category or alphabetically by Name (A-Z)—see page 20.

Preferences - Presets/IRs Tab

The Presets/IRs tab

This tab includes the following options for the Presets and IRs Librarian tabs.
Preset Numbering Format - The presets within the Librarian’s Presets Panel can 
be numbered as Bank numbers & letters (as 01A-32D, the factory default setting) 
or sequentially (as 000-127) within each setlist, depending on which is more 
convenient for you.

Stereo IR Import - When a stereo IR .wav file is imported by a Helix or HX 
device, it must be converted to mono. This preference lets you choose whether to 
take the left channel (the factory default) or right channel of the source IR file or to 
sum both channels to mono.
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Import Bundle & Export Bundle - (Helix devices only) A Bundle is a single file 
containing the complete contents of the Helix device’s Preset Library (or, the 
full Preset Library from Helix Native plugin, if exported from Helix Native). These 
buttons allow you to Import a Helix Bundle file from your hard drive or create 
and save all your device’s setlists and presets in their currently-saved state as a 
Bundle file to your hard drive. Please see page 15 for details.

Preferences - Device Settings Tab
The Device Settings screen offers options for your connected device’s configurable 
EXP and Footswitch options. Note that these options only exist for Helix LT, HX Effects, 
HX Stomp XL, and HX Stomp devices (you’ll see no options in this tab with a Helix Floor 
or Rack device in use since these devices do not utilize shared EXP jacks).

Helix LT

Helix LT Device Settings

EXP 2/Ext Amp Option - Helix LT devices incorporate a “shared” EXP PEDAL 2/
EXT AMP jack. This option allows you to choose the jack’s functionality (same as 
the Helix LT hardware’s Global Settings > Preferences option).

HX Effects

HX Effects Device Settings

Pedal 1 and Pedal 2 Jack Options - For the HX Effects device’s two rear panel 
Pedal jacks, these options allow you to choose their functionality (same as the 
HX Effects hardware’s Global Settings > Preferences options).

HX Stomp XL and HX Stomp

HX Stomp XL Device Settings

HX Stomp Device Settings

The HX Stomp XL and HX Stomp device’s rear panel includes a multi-functional TRS 
expression pedal and footswitch jack (EXP 1/2 FS 7/8 on HX Stomp XL and EXP 1/2 
FS 4/5 on HX Stomp). These EXP/FS options allow you to choose the individual 
functions for the jack’s “Tip” and “Ring” connections. These are the same as the 
hardware’s Global Settings > Preferences and Footswitches options—please refer to 
your device’s Owner’s Manual for details.

EXP/FS Tip - Determines whether the jack’s Tip signal is an Expression Pedal 
1 input jack or a Footswitch 7 (HX Stomp XL) or Footswitch 4 (HX Stomp) input 
jack.

EXP/FS Ring - Determines whether the jack’s Ring signal is an Expression 
Pedal 2 input jack or a Footswitch 8 (HX Stomp) or Footswitch 5 (HX Stomp) 
input jack.

•	 Tap, FS7, FS8 Functions (HX Stomp XL)
•	 FS3, FS4, FS5 Functions (HX Stomp) 

Determine the behavior for each footswitch, such as for Tap/Tuner, All Bypass 
Stomp Footswitch, Bank Up/Down, Preset Up/Down, Snapshot Up/Down, or 
Toggle EXP. 

NOTE: Link Dual Cabs is a “global” option (found within your device’s Global 
Settings>Preferences), but we’ve added a handy button for within the app’s Edit 
tab rather than here in the Preferences window to make it easy to access and 
reference its current On/Off state—see “Link Dual Cabs Option” on page 66.

https://www.line6.com/manuals
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The About/Legal Box and Help Options
These options are available by:

•	 Selecting About HX Edit from the HX Edit menu (Mac), Help menu (Windows)

•	 Selecting the Help or Pilot’s Guide options from the application’s Help menu 

•	 Or, selecting any of these options from the  button menu at the bottom left of 
the HX Edit main window

Click the  button to access the menu

About Box
Choose About at the left of the window to display the About Box screen, which provides 
version information for the HX Edit application.

Connected 
device’s firmware 
version

HX Edit app 
version

The HX Edit About box screen - About tab selected

Note that your connected Helix/HX device’s current firmware version is displayed at 
the top of this window. It is always recommended that you use the latest available 
versions of both your device firmware and HX Edit application. If you are also to be 
using and sharing presets with the Line 6 Helix Native plugin, it is also recommended 
to use the latest version of it (also see “Preset Compatibility with Helix Native Plugin” 
on page 4).

IMPORTANT! Please be sure to read the Release Notes available with all firmware, 
device driver, and application versions before installing, since there may be specific 
instructions for the order and procedure for your installations, depending on the existing 
versions you already have installed. 

For Helix and HX device firmware updates, click the Check for Updates button to 
use the Updater feature built right into the HX Edit app (see “Updater & Additional 
Resources” on page 84). The latest Line 6 Central and HX Edit application installers 
can be downloaded free from line6.com/software.

Legal Information
Choose the Legal tab at the left of the window to display the Legal screen, which lists 
all the necessary trademark, copyright, and other legally required statements for the HX 
Edit software. 

Online Help
Choose the Online Help option from the menu to go directly to the Line 6 Support 
website page within your browser app. Here you can find the Knowledge Base, FAQs, 
videos, User Forums, and more for HX Edit and Helix/HX devices.

Pilot’s Guide
Choose the Pilot’s Guide option from the menu to open the PDF document you are 
now reading.

https://line6.com/software/
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Marketplace & 
Account Options
Marketplace

Now open for business is the Line 6 Marketplace online shop, where you’ll find 3rd-
party, premium add-on assets that even further enhance the functionality of your Helix 
and HX devices, as well as for Helix Native plugin! As of this writing, professionally 
crafted presets and IRs are available. Check back often on the Marketplace site for 
product news and announcements. As covered within this chapter, you’re only a few 
clicks away from using new Marketplace assets on your system, right from the My 
Account menu in HX Edit.

NOTE: Version 2.70 of HX Edit and device firmware, and 1.70 of Helix Native (or later 
versions) are required for full support and use of premium Marketplace presets and IRs.

Get Your Marketplace Assets
Access the Marketplace website by choosing the Get More Presets and Get More 
IRs, commands within the My Account menu at the bottom left of the HX Edit window 
(or go directly to https://line6.com/marketplace/). When visiting the Marketplace site, 
simply sign in to your Line 6 account, choose the desired pack(s) of presets or IRs, add 
them to your cart, and check out.*

*NOTE: Be sure to log in to the same Line 6 account on which you’ve authorized your 
computer for HX Edit and Helix Native to ensure your Marketplace purchased assets are 
added to the correct account! 

Once your purchase is complete, your downloadable Marketplace assets are deposited 
into your Line 6 account, including your personal license that allows you to import them 
on your authorized computer system. Each Marketplace purchase is downloadable as 
a “zip” file that you’ll need to “unzip” on your local hard drive once downloaded.

To download your purchased assets, click on the Manage Account command 
within the HX Edit app’s My Account menu (or go directly to https://line6.com/
account/), sign in to your account, and select Helix Marketplace from the 
Hardware & Software section at the left.

Licenses for your purchased assets are automatically added to your Line 6 
account and “synced” the next time you use the HX Edit application, as long as 
you are actively signed in to your Line 6 account from the My Account menu (see 
“Sign In / Sign Out” on page 55).

Import and Utilize Your Marketplace Assets
An Internet connection is required for the computer where you’ll be using the HX Edit 
app to authorize it for the use of Marketplace premium assets, and for the sync with 
your Line 6 account to initially authenticate your newly purchased Marketplace licensed 
assets. Otherwise, an active Internet connection is not required for the use of HX Edit. 
Please see the following sections for details about signing in and authorization.

Once you’ve signed in and authorized your computer via HX Edit, your premium 
Marketplace presets and IRs can then be imported and used just like any other 
presets and IRs within HX Edit (and/or within Helix Native).

Once imported, premium Marketplace presets and/or premium IRs (.hir files), 
appear with a golden guitar pick “badge” at their right in the HX Edit librarian lists. 
(See page 14. and page 16 for more about importing presets and IRs.)

The golden guitar pick badges indicate premium Marketplace presets and IRs

https://line6.com/marketplace/
https://line6.com/marketplace/
https://line6.com/marketplace/
https://line6.com/account/
https://line6.com/account/
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The My Account Menu Options
At the bottom left of the HX Edit application window, you’ll see the My Account menu 
and account status indicator. Initially, before you’ve signed in to your Line 6 online 
account and/or authorized your computer for Marketplace premium assets, you’ll see 
this menu displayed with the My Account label.

The My Account menu (not signed in or authorized)

Clicking on the My Account menu displays options for signing in & managing your Line 
6 account, as well as for access to the Marketplace online shop.*

*NOTE: It is not required that your computer have an active Internet connection, nor do you 
need to be signed in or authorized at all for the HX Edit app itself to be functional. But signing 
in is necessary to authorize (or deauthorize) your computer to allow the import and export of 
premium assets purchased from the online Marketplace. 

If you don’t plan to use Marketplace premium assets, you don’t have to worry about signing 
in and out with HX Edit, and you can simply ignore the following Sign In / Sign Out and 
Authorize / Deauthorize sections.

Sign In / Sign Out
If you are not currently signed in, choose Sign In from the menu and enter your 
Line 6 account user name and password in the Sign In window. If you have forgotten your 
sign in credentials, or have not already created a Line 6 account, choose the Forgot my 
password/username or Create a Line 6 account option within the window. If you are 
already signed in and wish to sign out, choose the Sign Out option from the menu.

TIP: If you plan on purchasing premium Marketplace assets, it is easiest to simply remain 
actively signed in, with your computer in the authorized state. This allows the licenses for your 
purchased assets to automatically be “synced” from your Line 6 account, and for the assets 
able to be utilized for all actions within the HX Edit app.

The Line 6 account Sign In window

Computer Authorization Status Indicator
Once you’ve signed in, your computer is automatically authorized, as confirmed by a 
pop-up window letting you know the sign in and authorization were successful. You’ll see 
the My Account menu label display your first name (derived from your Line 6 account) 
and indicate the status of your account sign in and computer authorization (more details 
about authorization in the following section). 
Whenever signed out, the menu button displays the “My Account” label, with no colored 
authorization indicator. 

Signed in with computer Deauthorized

Signed out with computer Deauthorized

Signed in with computer authorized

Once you’ve authorized your computer, you can optionally sign out, and your computer 
remains in the authorized state, allowing you to continue to perform import, export, copy, 
and backup actions with your Marketplace assets, even if your Internet connection is not 
currently active.
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Note that you will need an Internet connection to be able to sign in again to access the 
Deauthorize and Authorize options from the menu, as well as to initially synchronize with 
your online Line 6 account after making any new Marketplace purchase (see “License 
Synchronization”).

Authorize / Deauthorize Your Computer
It is necessary for your computer to be in the authorized state for performing any HX Edit 
Import, Export, Copy/Paste, or Backup/Restore action that includes your purchased 
Marketplace premium IRs or presets (as well as setlists or bundles that include them). 
Simply signing in to your Line 6 account will authorize your computer automatically.*

*NOTE: It is permitted to authorize a maximum of 4 of your computers concurrently. If 
you’ve already authorized 4 computers, you can deauthorize one computer to free up one 
of your authorizations.

Deauthorizing You Computer
While signed in to your Line 6 account, choose the Deauthorize Computer command 
from the My Account menu and the brief online deauthorization process completes 
automatically. You’ll see a confirmation dialog appear and the Authorization Status 
Indicator for the My Account menu will change to red to indicate your deauthorized 
state (see preceding section). Additionally, deauthorizing your computer will also 
automatically sign you out of your Line 6 account.

When deauthorized, the HX Edit application still functions to provide all preset & IR 
librarian and signal flow editing tasks, however, Marketplace-purchased assets are not 
able to be imported or exported with the HX Edit app. You can choose Authorize 
Computer from the menu to authorize the computer again at any time, providing you 
have not exceeded the 4 computer authorization limit.

Helix Native Plugin Owners: This authorization/deauthorization within HX Edit globally 
authorizes/deauthorizes your computer for the use of the Helix Native plugin (and the use 
of Marketplace assets within it) as well, assuming your Helix Native license and Marketplace 
purchases were performed using your same Line 6 user account. Please also see the Helix 
Native Pilot’s Guide.

License Synchronization
Whenever you make a purchase from Marketplace, a license for each product you 
purchase is deposited into your online Line 6 account. For the HX Edit application to 
access your new licenses and effectively “unlock” your purchased assets, it needs to 
perform a “sync” process with your Line 6 account. You must have an active Internet 
connection and be signed in within HX Edit on your next use of the app after your 
purchase for this license synchronization to occur. 

When signed in, this brief sync takes place automatically in HX Edit on the next launch 
the application, or if already running, when clicking on the HX Edit app window. (Note 
that it may take up to 5 minutes before sync occurs if HX Edit was already running.) 
Once the license sync has completed, an active Internet connection is not required 
for the use of these Marketplace purchased assets within HX Edit or within your Helix 
hardware.

Manage Account
Choose this menu option to be taken to the Line6.com My Account page to view 
and update your Line 6 user account—view and manage add-ons and Marketplace 
purchases, register Line 6 gear, update your personal information, and more.

http://line6.com/support/manuals/
http://line6.com/support/manuals/
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Model Lists
To follow are the lists of all Effect, Amp, Speaker Cabinet & Microphone models included 
in Helix and HX devices, as well as the original gear they are based on.* Models, in 
many cases, include some unique parameters, typically based on the controls found 
on the original gear we modeled. However, you will also find a set of options that are 
common to model category types, as described in the sections that follow.

HX Effects Owners: Note that HX Effects devices include all Effects models, but not the 
Amp, Cab, and Mic models within the following

Effects Models
The following Effects models are found within each of the Helix and HX device’s 
respective block category menus (Distortion, Dynamics, EQ, etc.). Once you’ve selected 
an effects category in the application’s Model Browser menu, you’ll see up to three 
effects sub-categories: Mono (no icon), Stereo , and Legacy , vary in behavior, 
just as on the classic Line 6 effects from where these models originated. Mono models 
process in mono, as you’d expect, collapsing the stereo output of any block preceding 
it to mono. Stereo models process the signal as discrete stereo-in, stereo-out. Legacy 
type models, just as on earlier Line 6 devices, are a mixed bag and can be either mono, 
stereo, or mono-in/stereo-out. 

NOTE: “Legacy” models are effects from the classic Line 6 DL4™, DM4™, MM4™, and 
FM4™ stompboxes as well as M13®, M9®, and M5® processors.

TIP: The Favorites category that appears at the start of the Model menu is initially empty, 
awaiting your addition of preferred models—see page 20.

Distortion Models
Model Subcategories Based On*

Kinky Boost Mono, Stereo Xotic® EP Booster

Deranged Master Mono, Stereo Dallas Rangemaster Treble Booster

Minotaur Mono, Stereo Klon® Centaur

Teemah! Mono, Stereo Paul Cochrane Timmy® Overdrive

Heir Apparent Mono, Stereo Analogman Prince of Tone

Tone Sovereign Mono, Stereo Analogman King of Tone

Alpaca Rogue Mono, Stereo Way Huge® Red Llama (modded)

Compulsive Drive Mono, Stereo Fulltone® OCD

Model Subcategories Based On*

Dhyana Drive Mono, Stereo Hermida Zendrive

Horizon Drive Mono, Stereo Horizon Precision Drive

Valve Driver Mono, Stereo Chandler Tube Driver

Top Secret OD Mono, Stereo DOD® OD-250

Prize Drive Mono, Stereo Nobels® ODR-1(bc)

Scream 808 Mono, Stereo Ibanez® TS808 Tube Screamer®

Pillars Mono, Stereo Earthquaker Devices® Plumes

Hedgehog D9 Mono, Stereo MAXON® SD9 Sonic Distortion

Stupor OD Mono, Stereo BOSS® SD-1 Overdrive

Deez One Vintage Mono, Stereo BOSS DS-1 Distortion (Made-in-Japan)

Deez One Mod Mono, Stereo BOSS DS-1 Distortion (Keeley modded)

Ratatoullie Dist Mono, Stereo Pro Co RAT (with LM308 opamp)

Vermin Dist Mono, Stereo Pro Co RAT

Vital Dist Mono, Stereo Earthquaker Devices Life - Octave/Distortion 
circuit

Vital Boost Mono, Stereo Earthquaker Devices Life - Boost circuit

KWB Mono, Stereo Benadrian Kowloon Walled Bunny Distortion

Legendary Drive Mono, Stereo Carvin® VLD1 Legacy Drive (hi gain channel)

Swedish Chainsaw Mono, Stereo BOSS HM-2 Heavy Metal Distortion (MIJ)

Arbitrator Fuzz Mono, Stereo Arbiter® Fuzz Face®

Pocket Fuzz Mono, Stereo Jordan Boss Tone Fuzz

Bighorn Fuzz Mono, Stereo ‘73 Electro-Harmonix® Ram’s Head Big Muff Pi

Triangle Fuzz Mono, Stereo Electro-Harmonix Big Muff Pi

Dark Dove Fuzz Mono, Stereo Electro-Harmonix Russian Big Muff Pi

Ballistic Fuzz Mono, Stereo Euthymia ICBM Fuzz

Industrial Fuzz Mono, Stereo Z.Vex Fuzz Factory

Tycoctavia Fuzz Mono, Stereo Tycobrahe® Octavia

Wringer Fuzz Mono, Stereo Garbage’s modded BOSS FZ-2

Thrifter Fuzz Mono, Stereo Line 6 Original

Xenomorph Fuzz Mono, Stereo Subdecay Harmonic Antagonizer

Megaphone Mono, Stereo Megaphone

Bitcrusher Mono, Stereo Line 6 Original

*See “U.S. Registered Trademarks” on page 71 All product names used in this document are trademarks of their respective owners and neither Yamaha Guitar Group nor Line 6 are associated or affiliated with them. 
These trademarks appear solely to identify products whose tones and sounds were studied by Line 6 during sound model development.
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Model Subcategories Based On*

Ampeg Scrambler Mono, Stereo Ampeg® Scrambler Bass Overdrive

ZeroAmp Bass DI Mono, Stereo Tech 21® SansAmp Bass Driver DI V1

Regal Bass DI Mono, Stereo Noble Preamp Bass DI

Obsidian 7000 Mono, Stereo Darkglass® Electronics Microtubes® B7K Ultra

Clawthorn Drive Mono, Stereo Wounded Paw Battering Ram

Tube Drive Legacy Chandler Tube Driver

Screamer Legacy Ibanez Tube Screamer

Overdrive Legacy DOD Overdrive/Preamp 250

Classic Dist Legacy Pro Co RAT

Heavy Dist Legacy BOSS Metal Zone

Colordrive Legacy Colorsound® Overdriver

Buzz Saw Legacy Maestro® Fuzz Tone

Facial Fuzz Legacy Arbiter Fuzz Face

Jumbo Fuzz Legacy Vox® Tone Bender

Fuzz Pi Legacy Electro-Harmonix Big Muff Pi

Jet Fuzz Legacy Roland® Jet Phaser

L6 Drive Legacy Colorsound Overdriver (modded)

L6 Distortion Legacy Line 6 Original

Sub Oct Fuzz Legacy PAiA Roctave Divider

Octave Fuzz Legacy Tycobrahe Octavia

Bronze Master Legacy Maestro Bass Brassmaster

Killer Z Legacy BOSS Metal Zone MT-2

Dynamics Models
Model Subcategories Based On*

Deluxe Comp Mono, Stereo Line 6 Original

Red Squeeze Mono, Stereo MXR Dyna Comp

Kinky Comp Mono, Stereo Xotic SP Compressor

Ampeg Opto Comp Mono, Stereo Ampeg Opto Comp Compressor

Rochester Comp Mono, Stereo Ashly® CLX-52 (in conjunction w/ B. Sheehan)

LA Studio Comp Mono, Stereo Teletronix® LA-2A®

3-Band Comp Mono, Stereo Line 6 Original

Noise Gate Mono, Stereo Line 6 Original

Hard Gate Mono, Stereo Line 6 Original

Horizon Gate Mono, Stereo Horizon Precision Drive - Gate Circuit

Autoswell Mono, Stereo Line 6 Original

Feedbacker † Mono Line 6 Original, Feedback Generator

Tube Comp Legacy Teletronix LA-2A

Red Comp Legacy MXR Dyna Comp

Blue Comp Legacy BOSS CS-1

Blue Comp Treb Legacy BOSS CS-1 (Treble switch on)

Vetta Comp Legacy Line 6 Original

Vetta Juice Legacy Line 6 Original

Boost Comp Legacy MXR Micro Amp

EQ Models
Model Subcategories Based On*

Simple EQ Mono, Stereo Line 6 Original

Low and High Cut Mono, Stereo Line 6 Original

Low/High Shelf Mono, Stereo Line 6 Original

Parametric Mono, Stereo Line 6 Original

Tilt Mono, Stereo Line 6 Original

10 Band Graphic Mono, Stereo MXR 10-Band Graphic EQ

Cali Q Graphic Mono, Stereo MESA/Boogie Mark IV Graphic EQ

Acoustic Sim Mono, Stereo Line 6 Original

*See “U.S. Registered Trademarks” on page 71 All product names used in this document are trademarks of their respective owners and neither Yamaha Guitar Group nor Line 6 are associated or affiliated with them. 
These trademarks appear solely to identify products whose tones and sounds were studied by Line 6 during sound model development.
† The Feedbacker model utilizes polyphonic pitch shifting and, therefore, is extremely DSP-intensive—possibly utilizing up to half of all DSP available for Path 1 or Path 2!
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Modulation Models
Model Subcategories Based On*

Optical Trem Mono, Stereo Fender® optical tremolo circuit

60s Bias Trem Mono, Stereo Vox AC-15 Tremolo

Tremolo/Autopan Mono, Stereo BOSS PN-2

Harmonic Tremolo Mono, Stereo Line 6 Original

Bleat Chop Trem Mono, Stereo Lightfoot Labs Goatkeeper

Script Mod Phase Mono, Stereo MXR Phase 90

Pebble Phaser Mono, Stereo Electro-Harmonix Small Stone

Ubiquitous Vibe Mono, Stereo Shin-ei Uni-Vibe®

FlexoVibe Mono, Stereo Line 6 Original

Deluxe Phaser Mono, Stereo Line 6 Original

Gray Flanger Mono, Stereo MXR 117 Flanger

Harmonic Flanger Mono, Stereo A/DA Flanger

Courtesan Flange Mono, Stereo Electro-Harmonix Deluxe EM

Dynamix Flanger Mono, Stereo Line 6 Original

Chorus Mono, Stereo Line 6 Original

70s Chorus Mono, Stereo BOSS CE-1

PlastiChorus Mono, Stereo Modded Arion SCH-Z chorus

Ampeg Liquifier 
Chorus Mono, Stereo Ampeg Liquifier Chorus

Trinity Chorus Stereo Dytronics® Tri-Stereo Chorus

4-Voice Chorus Mono, Stereo Line 6 Original

Bubble Vibrato Mono, Stereo BOSS VB-2 Vibrato

Vibe Rotary Stereo Fender Vibratone

122 Rotary Stereo Leslie® 122

145 Rotary Stereo Leslie 145

Triple Rotary Mono, Stereo Yamaha® RA-200

Retro Reel Mono, Stereo Line 6 Original

Double Take Mono, Stereo Line 6 Original

Poly Detune † Mono Line 6 Original

AM Ring Mod Mono, Stereo Line 6 Original

Pitch Ring Mod Stereo Line 6 Original

Model Subcategories Based On*

Pattern Tremolo Legacy Line 6 Original

Panner Legacy Line 6 Original

Bias Tremolo Legacy 1960 Vox AC-15 Tremolo

Opto Tremolo Legacy 1964 Fender Deluxe Reverb®

Script Phase Legacy MXR Phase 90 (script logo version)

Panned Phaser Legacy Ibanez Flying Pan

Barberpole Legacy Line 6 Original

Dual Phaser Legacy Mu-Tron® Bi-Phase

U-Vibe Legacy Shin-ei Uni-Vibe

Phaser Legacy MXR Phase 90

Pitch Vibrato Legacy BOSS VB-2

Dimension Legacy Roland Dimension D

Analog Chorus Legacy BOSS CE-1

Tri Chorus Legacy Dytronics Tri-Stereo Chorus

Analog Flanger Legacy MXR Flanger

Jet Flanger Legacy A/DA Flanger

AC Flanger Legacy MXR Flanger

80A Flanger Legacy A/DA Flanger

Frequency Shift Legacy Line 6 Original

Ring Modulator Legacy Line 6 Original

Rotary Drum Legacy Fender Vibratone

Rotary Drum/Horn Legacy Leslie 145

Tape Eater Legacy Line 6 Original

Warble-Matic Legacy Line 6 Original

Random S&H Legacy Line 6 Original

Sweeper Legacy Line 6 Original

*See “U.S. Registered Trademarks” on page 71 All product names used in this document are trademarks of their respective owners and neither Yamaha Guitar Group nor Line 6 are associated or affiliated with them. 
These trademarks appear solely to identify products whose tones and sounds were studied by Line 6 during sound model development.
† The Poly Detune model utilizes polyphonic pitch shifting and, therefore, is extremely DSP-intensive—possibly utilizing up to half of all DSP available for Path 1 or Path 2!
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Delay Models
Model Subcategories Based On*

Simple Delay Mono, Stereo Line 6 Original

Mod/Chorus Echo Mono, Stereo Line 6 Original

Dual Delay Stereo Line 6 Original

Multitap 4 Stereo Line 6 Original

Multitap 6 Stereo Line 6 Original

Ping Pong Stereo Line 6 Original

Sweep Echo Mono, Stereo Line 6 Original

Ducked Delay Mono, Stereo TC Electronic® 2290

Reverse Delay Mono, Stereo Line 6 Original

Vintage Digital Mono, Stereo Line 6 Original

Vintage Swell Mono, Stereo Line 6 Original

Pitch Echo Mono, Stereo Line 6 Original

Transistor Tape Mono, Stereo Maestro Echoplex EP-3

Cosmos Echo Mono, Stereo Roland RE-201 Space Echo

Harmony Delay Stereo Line 6 Original

Bucket Brigade Mono, Stereo BOSS DM-2

Adriatic Delay Mono, Stereo BOSS DM-2 w/ Adrian Mod

Adriatic Swell Mono, Stereo Line 6 Original

Elephant Man Mono, Stereo Electro-Harmonix Deluxe Memory Man

Multi Pass Mono, Stereo Line 6 Original

Heliosphere Mono, Stereo Line 6 Original

Poly Sustain † Mono Line 6 Original

Glitch Delay Mono, Stereo Line 6 Original

Euclidean Delay Mono, Stereo Line 6 Original

ADT Mono, Stereo Line 6 Original

Crisscross Mono, Stereo Line 6 Original

Tesselator Mono, Stereo Line 6 Original

Ratchet Mono, Stereo Line 6 Original

Ping Pong Legacy TC Electronic 2290

Dynamic Legacy TC Electronic 2290

Model Subcategories Based On*

Stereo Legacy Line 6 Original

Digital Legacy Line 6 Original

Dig w/Mod Legacy Line 6 Original

Reverse Legacy Line 6 Original

Lo Res Legacy Line 6 Original

Tube Echo Legacy Maestro Echoplex EP-1

Tape Echo Legacy Maestro Echoplex EP-3

Sweep Echo Legacy Line 6 Original

Echo Platter Legacy Binson® EchoRec®

Analog Echo Legacy BOSS DM-2

Analog w/Mod Legacy Electro-Harmonix Deluxe Memory Man

Auto-Volume Echo Legacy Line 6 Original

Multi-Head Legacy Roland RE-101 Space Echo

Bubble Echo Legacy Line 6 Original

Phaze Eko Legacy Line 6 Original

Reverb Models
Model Subcategory Based On*

Dynamic Hall Mono, Stereo Line 6 Original

Dynamic Plate Mono, Stereo Line 6 Original

Dynamic Room Mono, Stereo Line 6 Original

Dynamic Ambience Mono, Stereo Line 6 Original

Dynamic Bloom Mono, Stereo Line 6 Original

Shimmer Mono, Stereo Line 6 Original

Hot Springs Mono, Stereo Line 6 Original

Nonlinear Mono, Stereo Line 6 Original

Glitz Mono, Stereo Line 6 Original

Ganymede Mono, Stereo Line 6 Original

Searchlights Mono, Stereo Line 6 Original

Plateaux Mono, Stereo Line 6 Original

Double Tank Mono, Stereo Line 6 Original

*See “U.S. Registered Trademarks” on page 71 All product names used in this document are trademarks of their respective owners and neither Yamaha Guitar Group nor Line 6 are associated or affiliated with them. 
These trademarks appear solely to identify products whose tones and sounds were studied by Line 6 during sound model development.
† The Poly Sustain model utilizes polyphonic pitch shifting and, therefore, is extremely DSP-intensive—possibly utilizing up to half of all DSP available for Path 1 or Path 2!
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Model Subcategory Based On*

Plate Legacy Line 6 Original

Room Legacy Line 6 Original

Chamber Legacy Line 6 Original

Hall Legacy Line 6 Original

Echo Legacy Line 6 Original

Tile Legacy Line 6 Original

Cave Legacy Line 6 Original

Ducking Legacy Line 6 Original

Octo Legacy Line 6 Original

‘63 Spring Legacy Line 6 Original

Spring Legacy Line 6 Original

Particle Verb Legacy Line 6 Original

Pitch/Synth Models
Model Subcategories Based On*

Pitch Wham Mono, Stereo Digitech Whammy®

Twin Harmony Mono, Stereo Eventide® H3000

Simple Pitch Mono, Stereo Line 6 Original

Dual Pitch Mono, Stereo Line 6 Original

Boctaver Mono/Stereo Boss OC-2 Octaver

3 OSC Synth Stereo Line 6 Original

Poly Pitch † Mono Line 6 Original

Poly Wham † Mono Line 6 Original

Poly Capo † Mono Line 6 Original

12 String † Mono Line 6 Original

3 Note Generator ‡ Mono, Stereo Line 6 Original

4 OSC Generator ‡ Mono, Stereo Line 6 Original

Bass Octaver Legacy EBS® OctaBass

Smart Harmony Legacy Eventide H3000

Octi Synth Legacy Line 6 Original

Synth O Matic Legacy Line 6 Original

Model Subcategories Based On*

Attack Synth Legacy Korg® X911 Guitar Synth

Synth String Legacy Roland GR700 Guitar Synth

Growler Legacy Line 6 Original

Buzz Wave Legacy Line 6 Original

Rez Synth Legacy Line 6 Original

Seismik Synth Legacy Line 6 Original

Analog Synth Legacy Line 6 Original

Synth Lead Legacy Line 6 Original

String Theory Legacy Line 6 Original

Synth FX Legacy Line 6 Original

Saturn 5 Ring Mod Legacy Line 6 Original

Synth Harmony Legacy Line 6 Original

Double Bass Legacy Line 6 Original

Filter Models
Model Subcategories Based On*

Mutant Filter Mono, Stereo Musitronics Mu-Tron III

Mystery Filter Mono, Stereo Korg A3

Autofilter Mono, Stereo Line 6 Original

Asheville Pattrn Mono, Stereo Moog® Moogerfooger® MF-105M MuRF Filter

Voice Box Legacy Line 6 Original

V Tron Legacy Musitronics® Mu-Tron III

Q Filter Legacy Line 6 Original

Seeker Legacy Z Vex Seek Wah

Obi Wah Legacy Oberheim® voltage-controlled S&H filter

Tron Up Legacy Musitronics Mu-Tron III (up position)

Tron Down Legacy Musitronics Mu-Tron III (down position)

Throbber Legacy Electrix® Filter Factory

Slow Filter Legacy Line 6 Original

Spin Cycle Legacy Craig Anderton’s Wah/Anti-Wah

Comet Trails Legacy Line 6 Original

*See “U.S. Registered Trademarks” on page 71 All product names used in this document are trademarks of their respective owners and neither Yamaha Guitar Group nor Line 6 are associated or affiliated with them. 
These trademarks appear solely to identify products whose tones and sounds were studied by Line 6 during sound model development.
† These indicated Pitch/Synth models utilize polyphonic pitch shifting and, therefore, are extremely DSP-intensive. Any one might take up half of all DSP available for Path 1 or Path 2!
‡ The 3 Note Generator and 4 OSC Generator models make sound without any instrument connected, therefore, their blocks are turned off by default. Be sure to first set your Helix volume to low, and press BYPASS to 
turn them on.
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Wah Models
Model Subcategories Based On*

UK Wah 846 Mono, Stereo Vox V846

Teardrop 310 Mono, Stereo Dunlop® Cry Baby® Fasel model 310

Fassel Mono, Stereo Dunlop Cry Baby Super

Weeper Mono, Stereo Arbiter Cry Baby

Chrome Mono, Stereo Vox V847

Chrome Custom Mono, Stereo Modded Vox V847

Throaty Mono, Stereo RMC® Real McCoy 1

Vetta Wah Mono, Stereo Line 6 Original

Colorful Mono, Stereo Colorsound Wah-fuzz

Conductor Mono, Stereo Maestro Boomerang

Volume/Pan Models
Model Subcategories Based On*

Volume Pedal Mono, Stereo Line 6 Original

Gain Mono, Stereo Line 6 Original

Pan Stereo Line 6 Original

Stereo Width Stereo Line 6 Original

Stereo Imager Stereo Line 6 Original

Common FX Settings
Parameter Description

Drive Adjusts the amount of overdrive, distortion, or fuzz.

Bass Adjusts the bass level.

Mid Adjusts the midrange level.

Treble Adjusts the treble level.

Speed

Adjusts the speed of the effect, with higher settings providing faster 
rates. Activate the model’s Note Sync parameter to toggle between 
Hz and note values. Choosing a Hz value provides a specific 
modulation speed in cycles per second; choosing a note value provides 
a time based on the current tempo. Not all Speed parameters can be 
synced to note values, as they may be non-linear and highly interactive.

Rate

Adjusts the rate of the effect, with higher settings providing faster 
rates. Activate the model’s Note Sync parameter to toggle between 
Hz and note values. Not all Rate parameters can be synced to note 
values, as they may be non-linear and highly interactive.

Time

Adjusts the delay/repeat time, with higher settings providing longer 
delays. Activate the model’s Note Sync parameter to toggle 
between Hz and note values. Choosing a ms value provides a 
specific time in milliseconds; choosing a note division value provides 
a time based on the current tempo. With a note division value, this 
parameter’s value is retained when changing models.

Depth Adjusts the intensity of the modulation. Higher settings result in more 
extreme pitch bending, wobble, or throb, depending on the effect.

Feedback Adjusts the amount of delayed signal fed back into the effect. Higher 
settings can provide more dramatic textures.

Decay Sets the length of time the reverb effect sustains.

Predelay Determines the time before the reverb effect is heard.

Scale

On stereo delays, the Scale offers control over the left & right channel 
repeats proportionately. The left channel repeats following the Time 
value and the right channel will repeat at a time that is the percentage 
of the left time. For example, if a delay’s Time is set for 1 second and 
the Scale set to 75%, the left channel will repeat at 1 second and the 
right at 750 milliseconds (ms).

Spread

Spread differs slightly among stereo delay effects. For most delays, 
it adjusts how widely the repeats bounce left and right. With the Ping 
Pong Delay, for example, 0 is in the middle (mono), and 10 is full left to 
right panning for the repeats.
For modulated stereo delays, Spread affects the LFOs’ (low frequency 
oscillators) stereo modulation behavior. At 0 the LFOs are in sync. At 
10, the two LFOs are 180 degrees out of sync, so that when one side is 
modulating up, the other side is modulating down.

*See “U.S. Registered Trademarks” on page 71 All product names used in this document are trademarks of their respective owners and neither Yamaha Guitar Group nor Line 6 are associated or affiliated with them. 
These trademarks appear solely to identify products whose tones and sounds were studied by Line 6 during sound model development.
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Parameter Description

Headroom

Some mod and delay pedals’ internal signal paths exhibit a bit of grit, 
especially when placed after a high-gain amp block. Negative values 
increase the perceived amount of grit; positive values clean things up a 
bit. At 0dB, the model behaves like the original pedal.

Low Cut Filters a portion of the block’s bass and/or treble frequencies, which 
can help remove rumble and/or high-end harshness.High Cut

Mix

Blends the effected “wet” signal vs. the “dry” signal passed through the 
block. When set to 0%, the path bypasses the effect completely. When 
set to 100%, the entire path is fed through the effect, and no dry thru 
signal is heard.

Level

Adjusts the overall output level of the effects block. Be careful not to 
boost this parameter too high on multiple blocks, as digital clipping 
could occur. You should typically leave this at 0.0dB for most blocks. 
Where the original pedal’s level or volume knob behavior doesn’t really 
apply to dB values, 0.0-10 may be used.

Trails

Trails Off: Any delay repeats or reverb decays are instantly muted when 
the block is bypassed. 
Trails On: Any delay repeats or reverb decays continue to decay 
naturally when the block is bypassed or a different snapshot is 
selected.* 

*TIP: Note that your Helix/HX device also offers a Trails On/Off option within its Tuner screen—
when set to “On,” the decays of your delays and reverbs, as well as the playback of an active 
Looper block, will continue to be heard when the Tuner is engaged.
(On Helix devices, in some configurations where path 1’s output is routed to path 2, the 
Tuner’s Trails On setting may not be able to pass audio since the signal may be fed only 
to the output blocks.)

Amp Models
The following guitar & bass amp models are found within the HX Edit Amp+Cab, 
Amp, and Preamp block category menus for all Helix devices, HX Stomp XL, and 
HX Stomp devices (firmware v3.50 and later). Note that you’ll see Guitar, Bass, and 
Legacy subcategories for the Amp+Cab & Amp categories and Guitar, Bass, and Mic 
subcategories for the Preamp category.

HX Effects Owners: Amp, Preamp, Speaker Cab, and Mic models are not supported 
by HX Effects devices, therefore, you will not see these categories or models within 
the HX Edit Model Browser when the HX Effects is in use.

•	 Amp+Cab blocks include an Amp plus a matched Cab model. You can change 
out the Cab for sonic variation. Note that, as of Helix Native v3.50, there are now 
Guitar, Bass, Legacy Guitar, and Legacy Bass Cab types to choose from—see 
“Legacy Cab Models” on page 69).

•	 Amp blocks are identical to Amp+Cab blocks, except they contain no matched 
Cab model. Using an Amp block is the best choice if you want to use separate, 
Single or Dual Cab or IR blocks, which can offer more flexibility in combining 
different speaker types and creating stereo routings.

•	 Preamp versions of each amp model are also included, which provide the tone 
of just the preamp stage of the amp. Preamp blocks require less computer 
processing than a full Amp block.

Amp and Preamp Models
Model Subcategory Based On*

WhoWatt 100 Guitar Hiwatt® DR-103 Brill

Soup Pro Guitar Supro® S6616

Stone Age 185 Guitar Gibson® EH-185

Voltage Queen Guitar Victoria Vintage Queen

Tweed Blues Nrm Guitar Fender Bassman® (normal channel)

Tweed Blues Brt Guitar Fender Bassman (bright channel)

Fullerton Nrm Guitar Fender 5C3 Tweed Deluxe (normal channel)

Fullerton Brt Guitar Fender 5C3 Tweed Deluxe (bright channel)

Fullerton Jump Guitar Fender 5C3 Tweed Deluxe (jumped channels)

GrammaticoLG Nrm Guitar Grammatico LaGrange (normal channel)

GrammaticoLG Brt Guitar Grammatico LaGrange (bright channel)

GrammaticoLG Jmp Guitar Grammatico LaGrange (jumped channels)

US Small Tweed Guitar Fender Champ®

US Princess Guitar Fender Princeton Reverb®

*See “U.S. Registered Trademarks” on page 71 All product names used in this document are trademarks of their respective owners and neither Yamaha Guitar Group nor Line 6 are associated or affiliated with them. 
These trademarks appear solely to identify products whose tones and sounds were studied by Line 6 during sound model development.
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Model Subcategory Based On*

US Deluxe Nrm Guitar Fender Deluxe Reverb (normal channel)

US Deluxe Vib Guitar Fender Deluxe Reverb (vibrato channel)

US Double Nrm Guitar Fender Twin Reverb® (normal channel)

US Double Vib Guitar Fender Twin Reverb (vibrato channel)

Mail Order Twin Guitar Silvertone® 1484

Divided Duo Guitar ÷13 JRT 9/15

Interstate Zed Guitar Dr Z® Route 66

Derailed Ingrid Guitar Trainwreck® Circuits Express

Grammatico GSG Guitar Grammatico GSG100

Jazz Rivet 120 Guitar Roland JC-120 Jazz Chorus

Essex A15 Guitar Vox AC-15

Essex A30 Guitar Vox AC-30 with top boost

A30 Fawn Nrm Guitar Vox AC-30 Fawn (normal channel)

A30 Fawn Brt Guitar Vox AC-30 Fawn (bright channel)

Matchstick Ch1 Guitar Matchless® DC30 (channel 1)

Matchstick Ch2 Guitar Matchless DC30 (channel 2)

Matchstick Jump Guitar Matchless DC30 (jumped)

Mandarin 80 Guitar Orange® OR80

Mandarin Rocker Guitar Orange Rockerverb 100 MkIII (dirty channel)

MOO)))N T Nrm Guitar Sunn® Model T (normal channel)

MOO)))N T Brt Guitar Sunn Model T (brite channel)

MOO)))N T Jump Guitar Sunn Model T (jumped channels)

Brit J45 Nrm Guitar Marshall® JTM-45 (normal channel)

Brit J45 Brt Guitar Marshall JTM-45 (bright channel)

Brit Trem Nrm Guitar Marshall JTM-50 (normal channel)

Brit Trem Brt Guitar Marshall JTM-50 (bright channel)

Brit Trem Jump Guitar Marshall JTM-50 (jumped)

Brit Plexi Nrm Guitar Marshall Super Lead 100 (normal channel)

Brit Plexi Brt Guitar Marshall Super Lead 100 (bright channel)

Brit Plexi Jump Guitar Marshall Super Lead 100 (jumped)

Brit P75 Nrm Guitar Park® 75 (normal channel)

Brit P75 Brt Guitar Park 75 (bright channel)

Model Subcategory Based On*

Brit 2203 Guitar Marshall JCM-800, 100W, 2203

Brit 2204 Guitar Marshall JCM-800, 50W, 2204

Placater Clean Guitar Friedman BE-100 (clean channel)

Placater Dirty Guitar Friedman BE-100 (BE/HBE channel)

Cartographer Guitar Ben Adrian Cartographer

German Mahadeva Guitar Bogner® Shiva

German Ubersonic Guitar Bogner Überschall®

Cali Texas Ch1 Guitar MESA/Boogie Lone Star® (clean channel)

Cali Texas Ch2 Guitar MESA/Boogie Lone Star (drive channel)

Cali IV Rhythm 1 Guitar MESA/Boogie Mark IV (channel I)

Cali IV Rhythm 2 Guitar MESA/Boogie Mark IV (channel II)

Cali IV Lead Guitar MESA/Boogie Mark IV (lead channel)

Cali Rectifire Guitar MESA/Boogie Dual Rectifier®

Archetype Clean Guitar Paul Reed Smith® Archon® (clean channel)

Archetype Lead Guitar Paul Reed Smith Archon (lead channel)

ANGL Meteor Guitar ENGL® Fireball 100

Solo Lead Clean Guitar Soldano SLO-100 (clean channel)

Solo Lead Crunch Guitar Soldano SLO-100 (crunch channel)

Solo Lead OD Guitar Soldano SLO-100 (overdrive channel)

PV Panama Guitar Peavey® 5150®

PV Vitriol Clean Guitar Peavey Invective (clean channel)

PV Vitriol Crunch Guitar Peavey Invective (crunch channel)

PV Vitriol Lead Guitar Peavey Invective (lead channel)

Revv Gen Purple Guitar Revv® Generator 120 (purple/gain ch. 3)

Revv Gen Red Guitar Revv Generator 120 (red/high gain ch. 4)

Das Benzin Mega Guitar Diezel VH4 (mega channel)

Das Benzin Lead Guitar Diezel VH4 (lead channel)

Line 6 Clarity Guitar Line 6 Original

Line 6 Aristocrat Guitar Line 6 Original

Line 6 Carillon Guitar Line 6 Original

Line 6 Voltage Guitar Line 6 Original

Line 6 Kinetic Guitar Line 6 Original

*See “U.S. Registered Trademarks” on page 71 All product names used in this document are trademarks of their respective owners and neither Yamaha Guitar Group nor Line 6 are associated or affiliated with them. 
These trademarks appear solely to identify products whose tones and sounds were studied by Line 6 during sound model development.
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Model Subcategory Based On*

Line 6 Oblivion Guitar Line 6 Original

Line 6 Ventoux Guitar Line 6 Original

Line 6 Elmsley Guitar Line 6 Original

Line 6 Elektrik Guitar Line 6 Original

Line 6 Doom Guitar Line 6 Original

Line 6 Epic Guitar Line 6 Original

Line 6 2204 Mod Guitar Line 6 Original

Line 6 Fatality Guitar Line 6 Original

Line 6 Litigator Guitar Line 6 Original

Line 6 Badonk Guitar Line 6 Original

Ampeg B-15NF Bass Ampeg B-15NF Portaflex®

Ampeg SVT Nrm Bass Ampeg SVT® (normal channel)

Ampeg SVT Brt Bass Ampeg SVT (bright channel)

Ampeg SVT-4 PRO Bass Ampeg SVT--4 PRO

US Dripman Nrm Bass Fender Bassman (Silverface)

Woody Blue Bass Acoustic® 360

Agua Sledge Bass Aguilar® Tone Hammer

Agua 51 Bass Aguilar DB51

Mandarin Bass 200 Bass Orange AD200 MkIII

Cali Bass Bass MESA/Boogie M9 Carbine

Cali 400 Ch1 Bass MESA/Boogie Bass 400+ (channel 1)

Cali 400 Ch2 Bass MESA/Boogie Bass 400+ (channel 2)

G Cougar 800 Bass Gallien-Krueger® GK 800RB

Del Sol 300 Bass Sunn® Coliseum 300

Busy One Ch1 Bass Pearce BC-1 preamp (channel 1)

Busy One Ch2 Bass Pearce BC-1 preamp (channel 2)

Busy One Jump Bass Pearce BC-1 preamp (jumped)

Studio Tube Pre Preamp > Mic Requisite Y7 mic preamp

Common Amp Settings
Parameter Description

Master
Adjusts the amount of power amp distortion. This parameter is highly 
interactive with all other power amp parameters—the lower the Master 
is set, the less effect the other controls will have.

Sag
Lower Sag values offer “tighter” responsiveness for metal and djent 
playing; higher values provide more touch dynamics & sustain for blues 
and classic rock riffs.

Hum Controls how much heater hum and AC ripple interacts with your tone. 
At higher settings, things get freaky.Ripple

Bias Changes the Bias of the power tubes. Lower values achieve a “colder” 
Class AB biasing. At maximum, the amp is operating in Class A.

Bias X
Determines how the power amp tubes’ voicing reacts when pushed 
hard. Set low for a tighter feel. Set high for more tube compression. 
This parameter is highly reactive with the Drive and Master settings.

*See “U.S. Registered Trademarks” on page 71 All product names used in this document are trademarks of their respective owners and neither Yamaha Guitar Group nor Line 6 are associated or affiliated with them. 
These trademarks appear solely to identify products whose tones and sounds were studied by Line 6 during sound model development.
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Speaker Cabinet Models
The following Speaker Cabinet models are available within the Amp+Cab and Cab 
block category menus. All Cab models also include your choice of Mic model type used 
on the Cab and several Mic parameters, as listed within the tables in this section.

NOTE: Amp, Preamp, Cab, and Mic models are not supported in HX Effects devices. 
Therefore, you will not see these categories or models within the HX Edit Model Browser 
menus when HX Effects is connected.

Adding an Amp+Cab block to your signal path conveniently allows you to choose one 
Guitar or Bass Amp model plus one Guitar or Bass Cab model, with the advantage 
of using only one block. Alternatively, you can choose an Amp block for your Guitar 
or Bass amp model, and then a separate Cab block for more flexibility. As of HX Edit 
v3.50, there are now Cab and Legacy types to choose from (more on these below). 
You can also choose between two subcategories of Cab blocks—Single and Dual. 
When you select a Dual Cab within the Model Browser menu, you’ll see two model 
tabs, allowing you to select the specific cab and settings for each. Dual Cab blocks are 
stereo, with each of the two cabs able to be independently panned hard left and right.

Link Dual Cabs Option
This option allows you to choose your preferred behavior when selecting the primary 
Cab model within a Dual Cab or Legacy Dual Cab block.

NOTE: The Link Dual Cabs option is a global “Preference” option, but we’ve 
added a handy button for it here within the Edit tab to make it easy to access and 
view its current On/Off state. Your setting is applied globally for all presets and 
remains until you change it again. (No current Cab model selections are affected.)

The Link Dual Cabs button - Off The Link Dual Cabs button - On

•	 Off: Selecting a new model for Cab A within a Dual Cab or Dual Legacy Cab 
block does not affect the currently-loaded Cab B model (the initial default).

•	 On: Selecting a new model for Cab A within a Dual block results in the same 
Cab model loaded for Cab B, with the Cab’s default settings.

Cab Model Types
As of HX Edit (and Helix/HX devices) version 3.50, the “Cab” model category now 
consists of new Single and Dual Impulse Response-based Cabs.* These IR-based 
Cabs were custom captured using the latest digital technology, resulting in even greater 
detail, with added mic positioning options, and even utilize as little as one-tenth the DSP 
of the pre-v3.50 Cab models! The new Dual Cabs additionally include stereo panning.

Don’t worry—all the pre-v3.50 factory Cab models are all still included, now renamed as 
Legacy Cabs and in their own menu category, as covered in “Legacy Cab Models” on 
page 69. Your pre-v3.50 presets will automatically load and utilize the Legacy Cabs, 
but you can certainly try out the new cabs in all your new and old presets!

Cab Models
The following table lists the new IR-Based Cab models available within the Model 
Browser’s Cab - Single and Dual, and Amp+Cab - Guitar and Bass categories. 

Model Subcategories Captured From*

Soup Pro Ellipse Single, Dual 1x6×9" Supro, S6616

1x8 Small Tweed Single, Dual 1×8" Fender Champ

1x10 US Princess Single, Dual 1x10" Fender Princeton Reverb

1x12 Fullerton Single, Dual 1×12" Fender 5C3 Tweed Deluxe

1x12 Grammatico Single, Dual 1x12" Grammatico LaGrange

1x12 US Deluxe Single, Dual 1x12" Fender Deluxe, Oxford

1x12 Open Cast Single, Dual 1x12" Custom open-back, EVM12L

1x12 Open Cream Single, Dual 1x12" Custom open-back, G12M-65

1x12 Cali EXT Single, Dual 1x12" MESA/Boogie Extension, EVM12L

1x12 Cali IV Single, Dual 1x12" MESA/Boogie MkIV Combo

1x12 Blue Bell Single, Dual 1x12" Vox AC-15, Blue Alnico

2x12 Blue Bell Single, Dual 2x12" Vox AC-30 Fawn, Blue Alnico

2x12 Silver Bell Single, Dual 2x12" Vox AC-30TB, Silver Alnico

2x12 Match H30 Single, Dual 2x12" Matchless DC30, Custom G12H-30

2x12 Match G25 Single, Dual 2x12" Matchless DC30, Custom G12M-35

2x12 Double C12N Single, Dual 2x12" Fender Twin, C12N

2x12 Interstate Single, Dual 2x12" Dr. Z Z Best, V30

2x12 Jazz Rivet Single, Dual 2x12" Roland JC-120

2x12 Mail C12Q Single, Dual 2x12" Silvertone 1484, Jensen C12Q

*See “U.S. Registered Trademarks” on page 71 All product names used in this document are trademarks of their respective owners and neither Yamaha Guitar Group nor Line 6 are associated or affiliated with them. 
These trademarks appear solely to identify products whose tones and sounds were studied by Line 6 during sound model development.
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Model Subcategories Captured From*

2x12 Mandarin30 Single, Dual 2x12" Orange, V30

4x10 Tweed P10R Single, Dual 4x10" Fender Bassman, P10R

4x12 WhoWatt Single, Dual 4x12" Hiwatt AP Fane®

4x12 Greenback20 Single, Dual 4x12" Marshall Basketweave G12M-20

4x12 Greenback25 Single, Dual 4x12" Marshall Basketweave G12M-25

4x12 Greenback30 Single, Dual 4x12" Marshall Basketweave G12H-30

4x12 1960A T75 Single, Dual 4x12" Marshall 1960A, G12T-75

4x12 Blackback30 Single, Dual 4x12" Park 75, G12H-30

4x12 Brit V30 Single, Dual 4x12" Marshall 1960AV, V30

4x12 Cali V30 Single, Dual 4x12" MESA/Boogie 4FB, V30

4x12 Mandarin EM Single, Dual 4x12" Orange, Eminence®

4x12 MOO)))N T75 Single, Dual 4x12" Sunn, G12T-75 

4x12 Uber T75 Single, Dual 4x12" Bogner Uberkab, G12T-75

4x12 Uber V30 Single, Dual 4x12" Bogner Uberkab, V30

4x12 XXL V30 Single, Dual 4x12" ENGL XXL, V30

1x12 Epicenter Single, Dual 1x12" Epifani® Ultralight

1x15 Ampeg B-15 Single, Dual 1x15" Ampeg B-15

2x15 Brute Single, Dual 2x15" MESA/Boogie, EV

2x15 US Dripman Single, Dual 2x15” Fender Bassman, JBL® D130

4x10 Garden Single, Dual 4x10" Eden D410XLT

4x10 Ampeg Pro Single, Dual 4x10" Ampeg PR-410HLF

6x10 Cali Power Single, Dual 6x10” MESA/Boogie PowerHouse®

8x10 SVT AV Single, Dual 8x10" Ampeg SVT-810AV

Microphone Models
Model Captured From*

- GUITAR -

57 Dynamic Shure® SM57

421 Dynamic Sennheiser MD 421-U

7 Dynamic Shure SM7B

906 Dynamic Sennheiser e906

30 Dynamic Heil Sound® PR 30

Model Captured From*

121 Ribbon Royer® R-121

160 Ribbon Beyerdynamic® M 160

4038 Ribbon Coles 4038

84 Ribbon AEA R84 

414 Cond AKG® C414XLS

47 Cond FET Neumann® U47 FET

67 Cond Neumann U67

- BASS -

57 Dynamic Shure SM57

421 Dynamic Sennheiser MD 421-U

7 Dynamic Shure SM7

88 Dynamic Beyerdynamic M88TG

52 Dynamic Shure Beta 52A

112 Dynamic AKG® D112

D6 Dynamic Audix® D6

40 Dynamic Heil Sound PR 40

4038 Ribbon Coles 4038

414 Cond AKG C414XLS

47 Cond FET Neumann U47 FET

67 Cond Neumann U67

Editing Cab Options
When a Single or Dual Cab block is selected from within the Model Browser, a graphical 
speaker/mic editor is displayed in the right pane of the Edit tab.* (This speaker/mic 
editor also appears within the Cab tab for an Amp+Cab block.) Here you can access 
the microphone positioning options, as well as adjust all available parameter sliders. If 
a Dual Cab block is in use, you’ll see two editable speaker/mic graphics, with individual 
Cab A and Cab B tabs to access their parameter sliders.

*NOTE: Legacy Cab and Legacy Amp+Cab type blocks include slightly different parameters 
and do not offer the graphical speaker/mic display—see “Editing Legacy Cab & Mic 
Settings” on page 70.

TIP: You can alternatively click and drag the microphone image itself left/right to adjust its 
Position, and up/down to adjust its Distance! For a Dual Cab, you can drag the mic for 
either cab to edit its Position & Distance, without having to select the opposite edit tab.

*See “U.S. Registered Trademarks” on page 71 All product names used in this document are trademarks of their respective owners and neither Yamaha Guitar Group nor Line 6 are associated or affiliated with them. 
These trademarks appear solely to identify products whose tones and sounds were studied by Line 6 during sound model development.
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The Edit View - Cab options for a Single Cab block

 
The Edit View - Cab options for a Dual Cab block

To follow are the parameters you’ll see available when a Cab - Single or Cab - Dual 
model is selected from the Model Browser. You’ll also see these parameters when 
editing the Cab on an Amp+Cab - Guitar or Bass block. When using a Dual Cab you’ll 
see this same set parameters within both the Cab A and Cab B Edit panels, allowing 
you to adjust the Cabs individually.

TIP: You can alternatively click and drag the microphone image itself left/right to adjust its 
Position, and up/down to adjust its Distance! For a Dual Cab, you can drag the mic for 
either cab to edit its Position & Distance, without having to select the opposite edit tab.

Single & Dual Cab Parameters
Parameter Description

Single & Dual Cab Parameters: The following are available for both Single & Dual Cabs

Mic † Selects one of the available Guitar or Bass cab mic models.

Distance † Sets the distance (1 inch to 12 inches) between the mic and the speaker. 

Position † Sets the left/right position of the mic, from the center to the edge of 
the speaker cone. 

Angle † Selects the angle of the mic in relation to the speaker: 0 degrees (on-
axis) or 45 degrees (off-axis).

Low Cut Filters a portion of the cab’s bass (from Off up to 500 Hz) and/or 
treble (from Off down to 500 Hz) frequencies, which can help remove 
rumble and/or high-end harshness.High Cut

Level Adjusts the overall output level of the Cab.

Dual Cab Parameters: The following are available for Dual Cabs only

Pan
Adjusts the selected Cab’s left/right stereo output balance. 
TIP: With a Dual Cab block, try using two different Cab models and 
panning each oppositely for a larger stereo effect.

Delay

Delays the selected Cab up to 50 ms. Use to delay the output of one 
Cab model to simulate a "double tracking" effect—most effective 
when the two Cab models are also panned opposite.  
The “Auto” option automatically applies a delay amount to approximate 
the selected cab's “Distance” parameter value. This results in a more 
accurate representation of the two cabs' mics blending together.

†NOTE: These parameters are not available for Expression Pedal, Variax Knob, or MIDI CC 
Controller assignment. 

*See “U.S. Registered Trademarks” on page 71 All product names used in this document are trademarks of their respective owners and neither Yamaha Guitar Group nor Line 6 are associated or affiliated with them. 
These trademarks appear solely to identify products whose tones and sounds were studied by Line 6 during sound model development.
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Legacy Cab Models
In addition to the preceding IR-based Cab Models, the following Legacy Cab Models 
are available within the Cab - Single Legacy and Dual Legacy, and Amp+Cab - 
Guitar+Legacy and Bass+Legacy categories for all Helix, HX Stomp XL, and HX 
Stomp devices (firmware v3.50). All Cab models also include your choice of Legacy 
Mic model type used on the Cab, as well as several Mic settings (see the list of “Legacy 
Microphone Models” on page 69).

When selecting a Dual Cab within the Model Browser, there are two model tabs, 
allowing selection of the specific cab and settings for each. Dual Cab blocks are 
stereo, with each of its two Cab models panned hard left and right.

Legacy Cab Models
Model Subcategories Based On*

Soup Pro Ellipse Single, Dual Legacy 1 x 6x9" Supro S6616

1x8 Small Tweed Single, Dual Legacy 1x8" Fender Champ

1x10 US Princess Single, Dual Legacy 1x10" Fender Princeton Reverb

1x12 Field Coil Single, Dual Legacy 1x12" Gibson EH185

1x12 Fullerton Single, Dual Legacy 1x12" Fender 5C3 Tweed Deluxe

1x12 Grammatico Single, Dual Legacy 1x12" Grammatico LaGrange

1x12 US Deluxe Single, Dual Legacy 1x12" Fender Deluxe Oxford

1x12 US Princess Single, Dual Legacy 1x12" Fender Princeton Reverb

1x12 Celest 12H Single, Dual Legacy 1x12" ÷13 JRT 9/15 G12 H30

1x12 Blue Bell Single, Dual Legacy 1x12" Vox AC-15 Blue

1x12 Lead 80 Single, Dual Legacy 1x12" Bogner Shiva CL80

1x12 Cali IV Single, Dual Legacy 1x12" MESA/Boogie Mk IV

1x12 Cali Ext Single, Dual Legacy 1x12" MESA/Boogie EVM12L

2x12 Double C12N Single, Dual Legacy 2x12" Fender Twin C12N

2x12 Mail C12Q Single, Dual Legacy 2x12" Silvertone 1484

2x12 Interstate Single, Dual Legacy 2x12" Dr Z Z Best V30

2x12 Jazz Rivet Single, Dual Legacy 2x12" Roland JC-120

2x12 Silver Bell Single, Dual Legacy 2x12" Vox AC-30TB Silver

2x12 Blue Bell Single, Dual Legacy 2x12" Vox AC-30 Fawn Blue

2x12 Match H30 Single, Dual Legacy 1x12" Matchless DC-30 G12H30

2x12 Match G25 Single, Dual Legacy 1x12" Matchless DC-30 Greenback 25

4x10 Tweed P10R Single, Dual Legacy 4x10" Fender Bassman P10R

Model Subcategories Based On*

4x12 WhoWatt 100 Single, Dual Legacy 4x12" Hiwatt AP Fane®

4x12 Mandarin EM Single, Dual Legacy 4x12" Orange Eminence

4x12 Greenback25 Single, Dual Legacy 4x12" Marshall Basketweave G12 M25

4x12 Greenback20 Single, Dual Legacy 4x12" Marshall Basketweave G12 M20

4x12 Blackback30 Single, Dual Legacy 4x12" Park 75 G12 H30

4x12 1960 T75 Single, Dual Legacy 4x12" Marshall 1960 AT75

4x12 Uber V30 Single, Dual Legacy 4x12" Bogner Uberkab V30

4x12 Uber T75 Single, Dual Legacy 4x12" Bogner Uberkab T75

4x12 Cali V30 Single, Dual Legacy 4x12" MESA/Boogie 4FB V30

4x12 XXL V30 Single, Dual Legacy 4x12" ENGL XXL V30

4x12 SoloLead EM Single, Dual Legacy 4x12" Soldano

1x12 Del Sol Single, Dual Legacy 1x12" Sunn Coliseum

1x15 Ampeg B-15 Single, Dual Legacy 1x15" Ampeg B-15

1x18 Del Sol Single, Dual Legacy 1x18" Sunn Coliseum

1x18 Woody Blue Single, Dual Legacy 1x18" Acoustic® 360

2x15 Brute Single, Dual Legacy 2x15" MESA/Boogie 2x15 EV

4x10 Ampeg HLF Single, Dual Legacy 4x10" Ampeg SVT 410HLF

6x10 Cali Power Single, Dual Legacy 6x10" MESA/Boogie Power House

8x10 Ampeg SVT E Single, Dual Legacy 8x10" Ampeg SVT

Legacy Microphone Models
To follow is the list of Mic Models offered for all Legacy Cabs.

Model Based On*

57 Dynamic Shure SM57

409 Dynamic Sennheiser MD 409

421 Dynamic Sennheiser MD 421-U

30 Dynamic Heil Sound PR 30

20 Dynamic Electro-Voice® RE20

121 Ribbon Royer R-121

160 Ribbon Beyerdynamic M 160

4038 Ribbon Coles 4038

*See “U.S. Registered Trademarks” on page 71 All product names used in this document are trademarks of their respective owners and neither Yamaha Guitar Group nor Line 6 are associated or affiliated with them. 
These trademarks appear solely to identify products whose tones and sounds were studied by Line 6 during sound model development.
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Model Based On*

414 Cond AKG C414 TLII

84 Cond Neumann KM84

67 Cond Neumann U67

87 Cond Neumann U87

47 Cond Neumann U47

112 Dynamic AKG D112

12 Dynamic AKG D12

7 Dynamic Shure SM7

Editing Legacy Cab & Mic Settings
To follow are the parameters you’ll see available in the Edit tab when a Cab - Single 
Legacy or Dual Legacy, or Amp+Cab - Guitar+Legacy or Bass+Legacy block is 
selected. When using a Dual Cab, you’ll see two sets of these parameters, allowing you 
to adjust Cabs A and B individually. (Note that the Legacy Cab models do not display 
the graphical speaker/mic interface within the Edit tab as the IR-based Cab Models 
do—each parameter appears as a slider).

Editing a Dual Legacy Cab’s parameters

Legacy Cab Parameters
Parameter Description

Mic Selects one of the 16 available mic models.

Distance Sets the distance (1 inch to 12 inches) between the mic and the 
speaker grille.

Low Cut Filters a portion of the cab’s bass and/or treble frequencies, which 
can help remove rumble and/or high-end harshness.High Cut

EarlyReflc Sets the amount of “early reflections.” Higher values add more 
reflective room sound to your Amp tone.

Level Adjusts the overall output level of the Cab.

*See “U.S. Registered Trademarks” on page 71 All product names used in this document are trademarks of their respective owners and neither Yamaha Guitar Group nor Line 6 are associated or affiliated with them. 
These trademarks appear solely to identify products whose tones and sounds were studied by Line 6 during sound model development.
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U.S. Registered Trademarks
All product names used in this document are trademarks of their respective owners and neither Yamaha Guitar Group nor Line 6 are associated or affiliated with them. These 
trademarks appear solely to identify products whose tones and sounds were studied by Line 6 during sound model development. 

5150 is a registered trademark of ELVH Inc.
Acoustic is a registered trademark of GTRC Services, Inc. 
Aguilar is a registered trademark David Boonshoft.
AKG and Digitech Whammy are registered trademarks of Harman International Industries, Inc. 
Arbiter is a registered trademark of Sound City Amplification LLC.
Ashly is a registered trademark of Ashly Audio, Inc.
Audix is a registered trademark of Audix Corporation.
Binson, Dytronics, LA-2A and Teletronix are registered trademarks of Universal Audio, Inc. 
Beyerdynamic is a registered trademark of Beyer Dynamic GmbH & Co. KG. 
Bogner and Überschall are registered trademarks of Bogner Amplification. 
BOSS and Roland are registered trademarks of Roland Corporation U.S.
Carvin is a registered trademark of Carvin Corp.
Celestion is a registered trademark of Celestion Corporation.
Colorsound is a registered trademark of Sola Sound Limited Corporation, UK. 
Cry Baby, Dunlop, Fuzz Face, MXR and Uni-Vibe are registered trademarks of Dunlop 
Manufacturing, Inc. 
Darkglass and Microtubes are registered trademarks of Darkglass Electronics, TMI Douglas 
Castro.
DOD is a registered trademark of DOD Electronics Corporation.
Dr. Z is a registered trademark of Dr. Z Amps, Inc.
EarthQuaker Devices and Plumes are registered trademarks of EarthQuaker Devices, LLC.
EBS is a registered trademark according of EBS Holding.
EchoRec is a registered trademark of Nicholas Harris. 
Electrix is a trademark or registered trademark of IVL Technologies, Ltd. in the U.S. and/or 
other jurisdictions.
Electro-Harmonix is a registered trademark of New Sensor Corp. 
Electro-Voice is a registered trademark of Bosch Security Systems, Inc. 
Eminence is a registered trademark of Eminence Speaker, LLC.
Engl is a registered trademark of Beate Ausflug and Edmund Engl. 
Epiphani is a registered trademark of Epifani Custom Sound Systems, Inc.
Eventide is a registered trademark of Eventide Inc. 
Fane is a trademark of Fane International Ltd. 
Fender, Twin Reverb, Bassman, Champ, Deluxe Reverb, Princeton Reverb, and Sunn are 
registered trademarks of Fender Musical Instruments Corp. 
Fulltone is a registered trademark of Fulltone Musical Products, Inc. 
Gallien-Krueger is a registered trademark of Gallien Technology, Inc. 
Gibson and Maestro are registered trademarks of Gibson Guitar Corp. 
Heil Sound is a registered trademark of Heil Sound Ltd. 
Hiwatt is a registered trademark of 9574565 Canada Inc. 
Ibanez is a registered trademark of Hoshino, Inc.

JBL is a registered trademark of Harman International Industries, Incorporated.
Klon is a registered trademark of Klon, LLC. 
Korg is a registered trademark of Korg, Inc. 
Leslie is a registered trademark of Suzuki Musical Instrument Manufacturing Co. Ltd. 
Marshall is a registered trademark of Marshall Amplification Plc. 
Matchless is a registered trademark of Matchless, LLC. 
MAXON is a registered trademark of Nisshin Onpa Co., Ltd. 
Mesa/Boogie, Lone Star, PowerHouse, and Rectifier are registered trademarks of Mesa/
Boogie, Ltd. 
Moog and Moogerfooger are registered trademarks of Moog Music, Inc.
Musitronics is a registered trademark of Mark S. Simonsen. 
Mu-Tron is a registered trademark of Henry Zajac. 
Neumann is a registered trademark of Georg Neumann GmbH.
Nobels is a registered trademark of Kurzke, Bernhard, DBA Music Center Bernhard Kurzke 
Individual Fed Rep Germany.
Orange is a registered trademark of Orange Brand Services Limited. 
Park is a registered trademark of AMP RX LLC. 
Paul Reed Smith and Archon are registered trademarks of Paul Reed Smith Guitars, LP. 
Peavey and Invective are registered trademarks of Peavey Electronics Corporation.
Revv is a registered trademark of Revv Amplification Inc.
RMC is a registered trademark of Richard McClish.
Royer is a registered trademark of Bulldog Audio, Inc. DBA Rover Labs. 
Sennheiser is a registered trademark of Sennheiser Electronic GmbH & Co. KG. 
Shure is a registered trademark of Shure Inc. 
Silvertone is a registered trademark of Samick Music Corporation. 
Supro is a registered trademark of DAG Audio Group LLC. 
TC Electronic is a registered trademark of MUSIC Group IP Ltd. 
Tech21 is a registered trademark of Tech21 Licensing Ltd.
Timmy is a registered trademark of Paul Cochrane AKA PAULCAUDIO. 
Trainwreck is a registered trademark of of Scott Alan Fischer and Mona Fischer. 
Tube Screamer is a registered trademark of Hoshino Gakki Co. Ltd. 
Tycobrahe is a registered trademark of Kurt Stier. 
Vox is a registered trademark of Vox R&D Limited.
Way Huge is a registered trademark of Saucy Inc.
Xotic is a registered trademark of Prosound Communications, Inc.
Yamaha is a registered trademark of Yamaha Corporation.
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Keyboard Shortcuts
The following keyboard shortcuts are available to speed up tasks when working in the HX Edit application. Where indicated, some shortcuts require that “focus” be placed on a window, 
panel, or specific control to be able to trigger its function. To place focus within the desired window, press your Tab key to cycle focus between the Librarian, Editor, and Inspector 
windows—the window is outlined in blue to indicate it has focus. Whenever the Command Center, Global EQ, or Preferences modal windows are opened from the app’s Window menu, 
they will automatically have focus. To place focus on a tabbed panel, click directly within the desired Presets, IRs, Favorites, Edit, or Controller Assign panel. To place focus on any block 
or on any parameter slider, button, or menu list, simply click directly on it to select it or use the Up/Down and Left/Right arrow keys to navigate through blocks, presets, IRs, or menu items.

HX Device Owners: Shortcuts listed in the following tables are the same for use with Helix and HX devices, except where noted.

Global Shortcuts
These shortcuts perform the following functions, regardless of focus.

Command Mac PC Function

Window Focus
(forward) Tab

Toggles focus between the Librarian, Signal Flow, and Inspector (as indicated by blue outline of selected window)

Window Focus
(reverse) Shift + Tab

Performs same focus action as above, but rotates through Librarian, Signal Flow and Inspector in reverse order

Enter Tap Tempo T “Tap” the key rhythmically to enter the system Tap Tempo value

Tap Tempo Mode 
Selection Shift T+ Changes the Tap Tempo Mode menu selection (Per Snapshot, Per Preset or Global)

HX Edit Pilot’s 
Guide N/A

F1 Launches this PDF document you are now reading 

About Box Window
N/A Alt

?
/+ Displays the About HX Edit window, containing application version information

Maximize Window

N/A +
On Windows, use the Windows + the Up Arrow key to maximize the HX Edit window, and Windows + Down Arrow key to 
return the window to its previous size (or minimize it). On macOS, you can hold the Option key and click on the HX Edit 
window’s green button at the top left to maximize the window. (Note this differs from the macOS Full Screen mode—see 
next item.)

Full Screen Mode

F+
+

command

control

⌘

⌃

N/A
Enters and exits the HX Edit application window into Full Screen mode. (In Full Screen, mode the HX Edit application 
window is maximized and the window frame and menu bar are hidden.)

HX Edit Menu Commands - Shortcuts (Mac Only)
These shortcuts perform the following functions, regardless of focus.

Command Mac PC Function

Preferences ,<+command
⌘ * Opens the Preferences window 

Quit HX Edit Q+command
⌘ * Quits the HX Edit application

*See the File Menu Commands table for PC equivalent shortcuts.)
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File Menu Commands - Shortcuts
Command Mac PC Presets/IRs/Favorites Tab Focus Signal Flow Panel Focus Inspector Tab Focus

Save Preset S+command
⌘

Ctrl S+ Saves the currently loaded preset

Save Preset As

S+
+

command

shift

⌘
Shift

Ctrl

S+
+ Displays the Save As window, where you can choose the destination setlist and preset 

Import Preset/IR/
Favorite

I+command
⌘

Ctrl I+ Imports a preset or IR into the currently-
selected librarian list slot, or imports a 
Favorite into the list, with prompt to add 
as new or to replace selected Favorite

These shortcuts are functional and act upon the Presets, IRs, or Favorites 
tab, whichever is currently displayed within the Library window

Export Preset/IR/
Favorite

E+command
⌘

Ctrl E+ Exports the currently-selected preset/IR/
Favorite

Import Setlist

I+
+option

⌥

command
⌘

Alt I+
+Ctrl

Imports a setlist, replacing the current 
setlist and its presets
No function for IRs or Favorites tabs

These shortcuts are functional whenever the Presets tab is currently 
displayed within the Library window

Export Setlist

E+
+option

⌥

command
⌘

Alt E+
+Ctrl

Exports the current setlist and its presets 
as a setlist file to your computer
No function for IRs or Favorites tabs

Import Bundle
(Helix devices)

I+
+

command

shift

⌘
Shift

Ctrl

I+
+ Imports a bundle, replacing all setlists 

and presets
No function for IRs or Favorites tabs

These shortcuts are functional whenever the Presets tab is currently 
displayed within the Library window

Export Bundle
(Helix devices)

E+
+

command

shift

⌘
Shift

Ctrl

E+
+ Exports all setlists and their presets as a 

bundle file to your computer
No function for IRs or Favorites tabs

Preferences *
Alt + Return

Enter Opens Preferences window (use ESC to close the window)

Quit *
Ctrl Q+ Quits HX Edit application

*See the HX Edit Menu Commands table for Mac equivalent shortcuts.

Edit Menu Commands - Shortcuts
Command Mac PC Presets/IRs/Favorites Tab Focus Signal Flow Panel Focus Inspector Tab Focus

Undo Z+command
⌘

Ctrl Z+ No function Reverses the last supported block or 
signal flow action

Reverses the last supported Edit tab 
action

Redo

Z+
+

command

shift

⌘
Shift

Ctrl

Z+
+ No function Reverses the last Undo action within 

the signal flow
Reverses the last Undo action within 
the Edit tab

Cut X+command
⌘

Ctrl X+ No function Copies the selected block & its 
settings to the clipboard and deletes 
the block from the signal flow

No function
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Command Mac PC Presets/IRs/Favorites Tab Focus Signal Flow Panel Focus Inspector Tab Focus

Copy C+command
⌘

Ctrl C+ Copies the currently-selected preset/
IR/Favorite (in its last-saved state) to 
the clipboard

Copies the selected block (with its 
current settings) to the clipboard

No function

Paste V+command
⌘

Ctrl V+ Pastes the last-copied preset/IR/
Favorite from the clipboard into the 
selected preset location

Pastes the last-copied block from 
the clipboard into the selected block 
location

No function

Clear + deletecommand
⌘

Delete
Clears the selected IRs or Favorites
No function for Presets tab

Deletes the block from the signal flow No function

Select All A+command
⌘

Ctrl A+ Selects all 128 preset/IRs/Favorites 
locations within the current setlist

No function

Rename R+command
⌘

Ctrl R+ Allows the selected preset/IR/Favorite 
to be renamed

Allows the currently loaded preset to be renamed

Snapshots Menu Commands - Shortcuts
Command Mac PC Presets/IRs/Favorites Tab Focus Signal Flow Panel Focus Inspector Tab Focus

Copy

C+
+

command

shift

⌘
Shift

Ctrl

C+
+ Copies the currently loaded snapshot to the clipboard

Paste

V+
+

command

shift

⌘
Shift

Ctrl

V+
+ Pastes the last-copied snapshot contents from the clipboard into the current snapshot 

Rename

R+
+

command

shift

⌘
Shift

Ctrl

R+
+ Allows you to enter in a new title to rename the current snapshot

Snapshot 1
(All Helix & HX devices)

1+command
⌘

Ctrl 1+ Loads Snapshot 1 

Snapshot 2
(All Helix & HX devices)

2+command
⌘

Ctrl 2+ Loads Snapshot 2

Snapshot 3
(All Helix & HX devices)

3+command
⌘

Ctrl 3+ Loads Snapshot 3

Snapshot 4
(Helix, HX Stomp XL, and 
HX Effects devices)

4+command
⌘

Ctrl 4+ Loads Snapshot 4

Snapshot 5 
(Helix devices)

5+command
⌘

Ctrl 5+ Loads Snapshot 5

Snapshot 6
(Helix devices)

6+command
⌘

Ctrl 6+ Loads Snapshot 6

Snapshot 7
(Helix devices)

7+command
⌘

Ctrl 7+ Loads Snapshot 7

Snapshot 8
(Helix devices)

8+command
⌘

Ctrl 8+ Loads Snapshot 8
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Window Menu Commands - Shortcuts
Command Mac PC Presets/IRs/Favorites Tab Focus Signal Flow Panel Focus Inspector Window Focus

Show/Hide Librarian Panel

E+
+option

⌥

command
⌘

Shift

Ctrl

L+
+ Shows or hides the Presets/IRs/Favorites Librarian panel

Command Center

M+
+

command

shift

⌘
Shift

Ctrl

M+
+ Opens (and places focus in) and closes the Command Center window

Global EQ
(Helix, HX Stomp XL, and 
HX Stomp devices) G+

+

command

shift

⌘
Shift

Ctrl

G+
+ Opens (and places focus in) and closes the Global EQ window 

Devices Menu Commands - Shortcuts
These shortcuts perform the following functions, regardless of focus.

Command Mac PC Function

Select Device’s HX Edit 
Window

0+
+option

⌥

command
⌘

 ...

Alt 0+
 ...

Displays and makes the chosen Helix or HX device’s application window the selected, foreground 
window. Devices are enumerated starting with “0,” and are selected using the respective device number 
in the shortcut

Librarian Window - Shortcuts
Command Mac PC Presets Tab Focus IRs Tab Focus Favorites Tab Focus

Presets Tab P Displays and changes focus to the 
Presets tab

No function No function

IRs Tab I No function Displays and changes focus to the IRs 
tab

No function

Favorites Tab F No function No function Displays and changes focus to the 
Favorites tab

Display Context 
Menu control +⌃

or

or

shift + return

or

Shift + Return
Enter

Displays the context menu for selected preset location

(Navigate an open menu using Up/Down Arrow keys and ENTER key to make selection. Use ESC key to dismiss menu)

Change Tab Focus Changes focus between the Presets, IRs, and Favorites tabs

Navigate Selection Navigates the preset/IR/Favorite selection within the currently displayed panel
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Command Mac PC Presets Tab Focus IRs Tab Focus Favorites Tab Focus

Extend Selection
Shift + Extends the preset/IR/Favorite selection within the currently displayed panel

Contiguous Multi-
select Shift + Selects contiguous, multiple presets/IRs/Favorites within the currently displayed panel

Non-contiguous 
Multi-select 

+command
⌘

Control +
Selects non-contiguous, multiple presets/IRs/Favorites within the currently displayed panel

Rename Preset/IR

Delay click

Renames the clicked preset/IR/Favorite (click once and then a 2nd time 1/3 of a second or later)

Rename Setlist
(Helix devices)

R Renames the current setlist No function

Setlist 1
(Helix devices)

1 Displays Setlist 1 No function

Setlist 2
(Helix devices)

2 Displays Setlist 2 No function

Setlist 3
(Helix devices)

3 Displays Setlist 3 No function

Setlist 4
(Helix devices)

4 Displays Setlist 4 No function

Setlist 5
(Helix devices)

5 Displays Setlist 5 No function

Setlist 6
(Helix devices)

6 Displays Setlist 6 No function

Setlist 7
(Helix devices)

7 Displays Setlist 7 No function

Setlist 8
(Helix devices)

8 Displays Setlist 8 No function

Signal Flow Window - Shortcuts
These shortcuts perform the following functions, regardless of focus.

Command Mac PC Function

Navigate Selection Selects and cycles through blocks within the Signal Flow 

Edit Tab
Return
Enter Activates the Edit tab, displays the edit options for the selected block, and gives focus to the Model Category of the 

selected block’s model

Display Block Context 
Menu shift + return

or  control +⌃

or  

Shift + Return
Enter

or  

Displays the block’s context menu*

Block Bypass Toggle Spacebar Toggles the bypass state of the selected block
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Command Mac PC Function

Amp Block Select
(Helix, HX Stomp XL, 
and HX Stomp devices)

A Selects and cycles through selecting the Amp, Amp+Cab and Preamp blocks within the current preset

Block Select
 Single-click

Selects a block or empty block location

Display Edit tab - 
Model Browser  Double-click

Double click on any block or empty block location to display the Model Browser to choose a model

*Open context menus can be navigated by arrow keys, where ENTER makes a selection, and ESC dismisses the open menu.

Inspector Window - Shortcuts
Command Mac PC Edit Tab Focus* Bypass/Controller Assign Tab Focus

Edit Tab E  or  H No function Displays and places focus on the Edit tabbed panel

Bypass/Controller 
Assign Tab

B  or C Displays and places focus on the Bypass/Controller 
Assign tabbed panel

No function

Select Previous/Next 
Parameter or List

Advances the focus to the previous or next parameter 
slider or list
(If Model Grid view is visible, Shift must be used to 
advance focus out of Model Grid—see next shortcut)

No function

Select Previous/Next 
Tabbed List

Shift + Advances the focus to the first parameter on the 
previous or next tabbed list (if Amp+Cab or Dual Cab, 
or if Variax input parameters are present)

No function

Snapshot Assign +option
⌥

Alt + Click directly on any parameter slider to quickly assign/
unassign its value to/from a Snapshots controller (or, 
when a parameter slider has focus, press S).

No function

Display Context 
Menu shift + return

or  control +⌃

or  

Shift + Return
Enter

or  

Display the context menu for the selected parameter 
slider 

Display the context menu for the selected Bypass or 
Controller Assignment within the Assignments list 

(Note that the Shift+Enter shortcut does not work within 
this tab, but right click actions do)

Reset to Default +command
⌘

Control +
Click on any block’s parameter slider to reset it to its 
default value (or, when a parameter slider has focus, 
press D).

Click on any assignment’s parameter slider to reset it to 
its default value (or, when a parameter slider has focus, 
press D)

Toggle Model List 
and Grid Views

G Toggles between displaying the Category/Model List 
View and Model Grid View

No function

*Focus within the Edit tab is indicated by turquoise colored outline surrounding a Model Browser item, or vertical line at left of parameter sliders. See next section for more details.
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Edit Tab - Model Browser Shortcuts
There are numerous keyboard shortcuts available for working within the multi-level Model 
Browser of the Inspector’s Edit tab. The functionality of these shortcuts is dependent 
upon the element within the Edit tab that currently has focus, as described below. 

List/Grid View Toggle

Category List Model List/Grid

Sub-category Menu

Parameter Sliders

Within the Model Browser, the element that currently has focus is indicated by a 
turquoise colored outline. You can set the focus by either clicking to select an item 
within the list or use your Up/Down/Left/Right arrow keys.

Model Focus (List View)

Model Category 
Focus 

Model Focus (Grid View)

Slider Focus 

Edit Tab: Category List or Model/Grid Focus Shortcuts
Mac or PC Function 

Changes category or model selection

Moves focus between Category List, Model List, and Parameter 
Sliders
(If Model Grid view is visible, Shift must be used to advance focus 
out of Model Grid)

Shift + For navigation when the Model Grid View is in use—Moves focus to 
the first parameter slider

Shift + For navigation when the Model Grid View is in use—Displays the 
Model Category Menu 
(Use Up/Down Arrow keys and ENTER keys to navigate and select 
Category within menu)

G Toggles between displaying the Category/Model List View and 
Model Grid View

Shift D+ Selects Distortion category

Shift Y+ Selects Dynamics category

Shift Q+ Selects EQ category

Shift M+ Selects Modulation category

Shift L+ Selects Delay category

Shift R+ Selects Reverb category

Shift S+ Selects Pitch/Synth category

Shift F+ Selects Filter category

Shift W+ Selects Wah category

Shift A+
+Option

Alt Selects Amp+Cab category (Helix, HX Stomp XL, and HX Stomp 
devices)

Shift A+ Selects Amp category (Helix, HX Stomp XL, and HX Stomp devices)

Shift P+ Selects Preamp category (Helix, HX Stomp XL, and HX Stomp 
devices)

Shift C+ Selects Cab category (Helix, HX Stomp XL, and HX Stomp)
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Mac or PC Function 

Shift I+ Selects IR category

Shift V+ Selects Volume/Pan category

Shift N+ Selects Send/Return category

Shift O+ Selects Looper category

Edit Tab: Parameter Slider Focus Shortcuts
Mac or PC Function 

 
or

 
_
-

+
=

Increments/decrements parameter value - fine adjustment

Shift + _
-

+
=

Shift +
or

Increments/decrements parameter value - coarse adjustment

Return
Enter Edits numerical parameter value or shows drop-down menu for 

discrete parameter choices. (Navigate an open menu using Up/
Down Arrow keys and ENTER key to make selection. Use ESC key 
to dismiss menu.)

Shift
+
Return
Enter

Opens the selected slider’s context menu for controller assignment 
options

N For “Note Sync” capable parameters (indicated by the  button to 
the right of the slider), this toggles the functionality between Note 
Sync and ms/Hz

D Sets the selected parameter to its default value

S For block parameters, assigns parameter to a Snapshot controller

Double-click Enters edit mode for numerical parameter value (tap Enter/Return 
key to accept edited value)

TIP: The above Parameter Slider Focus Shortcuts are also functional for parameter sliders 
within the Inspector - Bypass/Controller Assign tab.
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Command Center, Global EQ & Preferences Window Shortcuts
Focus within these windows is indicated by the turquoise-colored outline surrounding a control, or by the vertical line at the left of any parameter slider.

Command Center Window - Shortcuts
Command Mac PC Function 

Any Control Has Focus

Open Command 
Center Window

M+
+

command

shift

⌘
Ctrl

Shift

M+
+ Opens and moves the Command Center window to the foreground 

When the open Command Center window has focus, you can close it using Cmd+W (Mac) or Alt+F4 (Windows)

Focus Next
Tab

Move focus to next command parameter

Focus Previous
Shift + Tab

Move focus to previous command parameter

Parameter Slider Focus

Adjust Parameter  
Value - Fine

 
or

 

_
-

+
=

Adjusts the selected parameter slider’s value up or down using small increments

Adjust Parameter  
Value - Coarse

Shift + _
-

+
=

Shift +
or

Adjusts the selected parameter slider’s value up or down using large increments

Edit Numerical 
Parameter Value Return

Enter Edits the selected parameter’s numerical value, or displays a parameter’s drop-down menu for parameter options

Customize Label Control Focus

Edit Custom Label
Return
Enter Edits the text within the Customize label field to create a custom name for any Footswitch label

Remove Custom 
Label Delete

Deletes the text within an edited Customize label field and returns it to its default label

Controller Grid Focus

Select Controller 
Within Grid

When any Controller (Instant, Footswitch, Variax Knob or EXP Pedal) has focus within the Grid pane—Moves the 
selection to the next or previous Controller
(Use TAB to place focus on Command menu and then use Arrow keys to choose Command option)

Command Menu Focus (as indicated)

Command Menu 
Option Selection

_
-

+
=or

When the Command Menu has focus, but the menu is not open—chooses the next or previous option within the 
Command menu. Once the desired command within the menu list is highlighted, press the ENTER key to choose the 
command
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Command Mac PC Function 

Open Command 
Menu Return

Enter When the Command Menu has focus, but the menu is not open—use the ENTER key to open the menu, and then use 
the following shortcut keys to choose a command from the open menu list. 

Dismiss Command 
Menu

Esc When the Command Menu has focus and is open—use the ESC key to close the menu without making a selection

Change Command 
Menu Selection

When the Command Menu has focus and is open—use the Up/Down Arrow keys to highlight the desired command in 
the menu list, then use the ENTER key to select the highlighted command

Global EQ Window - Shortcuts (Helix, HX Stomp XL, and HX Stomp Devices)
Command Mac PC Function 
Any Control Has Focus

Open Global EQ 
Window 

G+
+

command

shift

⌘
Ctrl

Shift

G+
+ Opens and moves the Global EQ window to the foreground 

When the open Global EQ window has focus, you can close it using Cmd+W (Mac) or Alt+F4 (Windows)

Focus Next
Tab

Move focus to next control

Focus Previous
Shift + Tab

Move focus to previous control

Reset R Invoke the Reset button to set all parameters “flat”

Apply EQ
(Helix devices)

A Cycle through the Apply EQ menu’s output modes

Bypass B Toggle Bypass on/off 

EQ Graph Pane Focus

Low Cut 1 Selects the Low Cut node

Low Peak 2 Selects the Low Peak node

Mid Peak 3 Selects the Mid Peak node

High Peak 4 Selects the High Peak node

High Cut 5 Selects the High Cut node

Adjust Edit Node -
Fine

Adjusts the selected edit node in small increments
Use the numbered keys above to select the desired node, then use Up/Down keys to edit Gain and Left/Right arrow keys 
to edit Frequency

Adjust Edit Node -
Coarse Shift + Tab

Adjusts the selected edit node in large increments
Use the numbered keys above to select the desired node, then use Up/Down keys to edit Gain and Left/Right arrow keys 
to edit Frequency
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Command Mac PC Function 

Increment Q Value 
- Fine

Q Increments the selected node’s Q parameter value by 0.1

Increment Q Value 
- Coarse Shift Q+ Increments the selected node’s Q parameter value by 1.0

Decrement Q Value 
- Fine Ctrl Q+ Decrements the selected node’s Q parameter value by 0.1

Decrement Q Value 
- Coarse

Shift

Ctrl

Q+
+ Decrements the selected node’s Q parameter value by 1.0

Control-Specific Focus (as indicated)

Reset
Return
Enter When the Reset button has focus—Resets all parameters to default “flat” values

Bypass Spacebar When the Bypass button has focus—Toggles Global EQ Bypass

Close Window
Return
Enter When the Done button has focus—Triggers the Done button to exit the Global EQ window. Optionally, you can use the 

ESC key to close the window

Apply To
Output Options
(Helix devices)

_
-

+
=or

When the Apply To output menu has focus—Selects the Apply To output menu’s next or previous option. Optionally, you 
can use the ENTER key when the menu has focus to expand and view the menu list

Preferences Window - Shortcuts
Preferences Window - Shortcuts

Command Mac PC Function 

Open Preferences  
Window

+ <,command
⌘

+
Return
Enter

Alt
Opens the Preferences window 
You can use the ESC key to close the window
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Additional Mouse Behaviors
But wait, there’s more! To follow are additional time-saving gestures using your mouse 
wheel or mouse buttons. 

•	 Use your mouse wheel while hovering over...
•	 Any block within the Signal Flow to access the block’s Bypass and Clear 

buttons
•	 Any parameter slider and adjust its value
•	 Any scroll bar to scroll the panel’s contents, such as within the Presets, IRs, 

and Favorites panels, and Edit and Bypass/Controller Assign tabs
•	 The Snapshots menu to load a different snapshot
•	 The numerical Tap Tempo control to increment/decrement the tempo value
•	 The Setlist menu (Helix devices) to load a different setlist 

•	 Left-click and hold, or right-click on... 
•	 The Preset tab’s Setlist menu (Helix devices) to rename the current setlist
•	 The Snapshots menu to rename the current snapshot
•	 The numerical Tap Tempo control to edit the numerical tempo value

•	 Within the Presets Librarian tabbed window, Alt/Option + Left-click (Mac) or Ctrl 
+ Left-click (PC) and drag and drop any preset (or multiple selected presets) to 
copy into new preset slot locations, overwriting the presets that currently exist 
there. (Dragging and dropping a preset without using a modifier key moves the 
preset and reorders your preset list.)

•	 Just try Right-clicking (or Ctrl+Left-clicking on Mac) on different items within 
the application, and you may just discover a handy menu of commands you 
didn’t know about!
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Updater & Additional 
Resources
HX Edit and Device Firmware Updater
Upon launch of the HX Edit application, it will automatically check to see if you’re using 
the latest available version of both the HX Edit application and the firmware of your 
connected Helix or HX device. An active Internet connection is required for updates. It 
is highly recommended always to use the latest versions of device firmware, HX Edit, 
and Helix Native software to benefit from the latest features and the smoothest product 
compatibility.

To Check For and Install Updates
1.	 Connect your Helix or HX device, power it on, and launch HX Edit. 

2.	 Sign In - If you have not already done so, click the My Account button at the 
lower left of the HX Edit window and choose Sign In, enter your Username 
and Password, and click Sign in. If you have not yet created one, click Create 
a Line 6 Account in the Sign In window to go to the line6.com website, create 
your free account, and then return to HX Edit and sign in.

3.	 If a newer HX Edit application and/or firmware version is available, you’ll be 
prompted. 

4.	 Click OK, and you’ll be presented with the available updates and their version 
info. You’ll also see the  notification at the bottom right of the HX 
Edit app window, which you can click at any time to display the updates. 

There are available updates for both HX Edit and the firmware for the 
connected Helix Floor device in our example above.*

*IMPORTANT! Please be sure to click and read the Release Notes available updates 
first. There may be specific instructions for the order and procedure to perform the 
update, depending on your device and computer system.

Note that only the Update Now button for the HX Edit update is selectable—
you must update the application first before updating your device 

firmware. 

5.	 Click Update Now for HX Edit, and you will be prompted to download the 
application installer (this download allows you to have the installer on your 
computer in case you need to run it again in the future). Click OK and choose 
your download location to start the download. 

6.	 Once the download completes, you’ll be prompted to run the HX Edit 
application installer. 

Click OK to proceed. Follow the instructions in the installer screens and 
complete the HX Edit installation. 

https://line6.com/account/
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7.	 Launch the (now updated) HX Edit application. The HX Edit Updater will again 
prompt you that updates are available as in step 3. Click OK, and you’ll be 
presented with the Firmware update, as in step 4, but with its Update Now 
button now selectable. 

NOTE: If you wish to install an earlier firmware version and/or have no Internet connection 
on your computer, you must use the separate Line 6 Central application—please skip to 

“Using the Line 6 Central App” on page 87. 

8.	 Click the Update Now button and allow the Firmware updater to start and 
walk you through the following steps.

•	 Create Backup - You are prompted to create a backup, including all your 
device’s Presets, Setlists, IRs, Favorites, User Model Defaults, and Global 
Settings. Click OK to continue. 

•	 Optionally, you can customize the title, description, and save location for 
your Backup file within the Create Backup window (see “Creating & Restoring 
Complete Device Backups” on page 27 for details). Click the Create Backup 
button to proceed. 

•	 End User License Agreement: - You must agree to the terms of the License 
Agreement to perform the firmware installation - read and click OK to continue. 
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•	 Update Device: Click Update to proceed. 

•	 IMPORTANT! An alert is displayed to inform you that, for updating to firmware 
version 3.50 (or later) from versions earlier than 3.50, the update process actually 
has to run twice. This requires that your Helix or HX device restart during the 
process to reset itself. When your device restarts, you’ll see an error on your 
device’s screen, and you’ll see another IMPORTANT! app alert screen—this 
is expected! Simply click the Resume button in the Updater app to proceed. 

•	 Allow the update to run. You can watch the status bar at the bottom of the 
Updater window to see its progress. It is especially important not to 
disturb the device’s controls and cable connections until the update fully 
completes! 

•	 Update Complete: Once finished, you’ll see the Update Complete screen. 
Be sure to read and perform the Factory Reset on your device and any other 
specific steps that may be listed in the Updater app screen. Click Back to HX 
Edit to return to the HX Edit app and start using the new firmware!

While the presets on your device will not be altered, some minor sonic changes 
may still occur with some firmware updates, as noted within any firmware’s 
Release Notes.

TIP: For some updates, firmware versions will include new Factory Presets. However, the 
firmware update process does not install these new Factory Presets automatically (since 
we figure you really would not want any of your existing presets overwritten!). You can 
install them by performing a Factory Restore—please see your Helix or HX Owner’s 
Manual for details.

TIP: Alternatively, you can manually check for available HX Edit and device firmware 
updates anytime by clicking the Check For Updates button found within “The Preferences 
Window”.

https://www.line6.com/manuals
https://www.line6.com/manuals
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Using the Line 6 Central App
As mentioned in the previous section, it is recommended to use the HX Edit 
application’s built-in Firmware Updater to update to the latest Helix or HX 
device firmware. If for any reason you wish to “roll back” to or install an older 

firmware version, you must use the separate Line 6 Central application, available free 
from line6.com/software/.

IMPORTANT! Please be sure to carefully read the Release Notes for all Line 6 
application and device driver installations first, before performing updates or 

installations.

TIP: It is always a good idea to create a backup of your device’s contents before performing 
a firmware update! The best procedure is to perform the backup using your existing HX 

Edit version first—then update to the latest Helix/HX firmware versions. See “Creating & 
Restoring Complete Device Backups” on page 27.

Updating Helix or HX Device Firmware
Be sure to start by visiting line6.com/software/ and download and install the latest 
version of the Line 6 Central application on your computer. With your Helix/HX device 
connected and powered on, quit all other Line 6 and audio applications and launch the 
Line 6 Central application.

On Mac - Go to Applications > Line 6 > Line 6 Central

On Windows® - Go to the Start button menu > All Apps (or Programs) > Line 6 > 
Line 6 Central

•	 Once you’ve launched the Line 6 Central app, sign into your Line 6 account.* 
If you do not have an account, you must first create one. Follow the prompts 
through to the quick online registration.

*NOTE: If the computer you are using is not connected to the Internet, it is still possible to 
use Line 6 Central’s Update from File option to update your device offline. Please see the 

steps at the end of this section for details.

•	 Once logged in, your USB-connected Helix/HX device and its current firmware 
version appears listed within the Home screen, as shown in the following 
screen. If you happen to have multiple Helix/HX devices connected (and we 
love to hear that you do!) you’ll see them all appear in the app’s Home screen.

•	 In the example above, both a connected Helix Floor and HX Stomp device 
appear, with status indicators showing that a firmware update is available for 
each. 

•	 Click on a device to advance to the next screen. Depending on the selected 
device, you may see special instructions appear. Please be sure to read and 
follow any such steps. On the screen, you can select the desired firmware 
version to install—it is recommended to choose the latest firmware. 

•	 The Release Notes are displayed for the selected firmware version. Be sure to 
read the details since there could be special instructions.

•	 Click the yellow Download Update button and wait for the firmware to 
download. Once you see the blue Perform Update button, click it to proceed.

•	 The License Agreement is displayed in the next screen. Read through the 
agreement and click Accept to agree to the terms and conditions and start the 
update process. Read and follow any additional instructions that may appear. 

•	 Allow the application to complete the update process, which can take up 
to several minutes. It is especially important not to disturb the device’s 
controls and connection until the update fully completes!

Once the application lets you know the update process has completed, you can exit the 
Line 6 Central application and start using your updated device. 

NOTE: While the presets on your Helix/HX device will not be altered, some minor sonic 
changes may still occur with firmware updates, as noted within any firmware’s Release 

Notes. 

https://line6.com/software/
https://line6.com/software/
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Using Line 6 Central in Offline Mode
If the computer you are using to run the Line 6 Central app is not connected to the 
Internet, you can use the app’s Update from File option to perform an offline update 
for your Helix/HX firmware, as follows.

•	 You’ll need to first obtain the latest firmware for your specific Helix or HX device 
by downloading it from the line6.com/software/ web page, then manually copy 
the downloaded (.hxf) file to your computer where you’ll be running Line 6 
Central. Connect your Helix/HX device directly to the computer’s USB port. 

•	 Launch Line 6 Central and select your Helix/HX device which you want to update 
on the app’s Home screen. Be sure to read and follow any special instructions 
that might appear in the app window.

•	 Click the Update From File button in the next screen to browse your computer 
and select the Helix/HX (.hxf) firmware file you obtained in the first step.

•	 The License Agreement is displayed in the next screen. Read through the 
agreement and click Accept to agree to the terms and conditions and start the 
update process. Read and follow any additional instructions that may appear. 

•	 Allow the application to complete the update process, which can take up 
to several minutes. It is especially important not to disturb the device’s 
controls and connection until the update fully completes!

TIP: Whenever installing Helix/HX device firmware, you must be sure to also install the 
matching version number of the HX Edit application. Please visit line6.com/software/ to 

download the correct application installer.

Additional Resources
Looking for more info? We’ve got plenty of online resources, just a click away.

•	 Additional Help documentation covering Helix & HX hardware and Helix Native 
plugin is available on the Line 6 Support site at Line 6 Product Manuals. 

•	 Visit the Line 6 CustomTone site where you can share your presets with the 
world, and download free presets created by Line 6 and other users just like 
you.

•	 Looking for some professionally crafted presets and IRs for your Helix device 
or Helix Native plugin? Check out the new Marketplace, and be sure to check 
back often for news and product announcements.

•	 Can’t get enough Line 6 gear & accessories? Head on over to the Line 6 Online 
Shop.

•	 Check out the Line 6 Support page for access to helpful tips, videos, discussion 
forums, or to contact Line 6 Technical Support.

https://line6.com/software/
https://line6.com/software
http://line6.com/support/manuals/
http://line6.com/customtone/
https://line6.com/marketplace/
https://shop.line6.com/
https://line6.com/support


®


	HX Edit v3.70 Pilot's Guide
	Workflow
	What’s in it for Me?
	Marketplace
	Workflow Overview
	Computer Connectivity
	Multi-Device, Multi-Window Support

	Preset Compatibility
	Preset Compatibility with Helix Native Plugin
	Preset Translation
	Feature Compatibility

	GUI Overview
	Resizing the Application Window
	Application Menus
	Preferences, Help & Account Options

	Presets Panel
	Premium Marketplace Presets
	Selecting, Loading & Saving Presets
	Importing and Exporting Preset Files
	Renaming, Reordering, Copying, and Pasting Presets
	Importing and Exporting Setlists
	Importing and Exporting Bundles

	IRs Panel
	What are Impulse Responses?
	Importing and Exporting IRs
	Renaming, Loading, Copying, and Clearing IRs
	Single and Dual IR Blocks

	Favorites Panel
	Adding Blocks as Favorites
	To Insert a Favorite into your Current Preset
	Managing Favorites
	Importing and Exporting Favorites

	Working in the Editor
	Naming & Saving the Preset
	Configuring & Managing Snapshots
	Undo / Redo
	Editing the Tap Tempo
	Creating & Restoring Complete Device Backups
	Extracting Files from a Backup

	The Signal Flow Window
	Moving Blocks & Arranging the Signal Flow
	Split Path Options
	Cutting, Copying, Pasting, and Clearing Blocks
	Drag and Drop Blocks
	Adding a Block to Favorites
	Configuring a Model’s User Defaults

	The Edit Tab
	Selecting Models
	Editing Model Parameters
	Link Dual Cabs Option
	Editing Input, Output, Split & Mixer Blocks
	L6 LINK - Powercab Plus and DT 25/50 Amp Options

	The Bypass/Controller Assign Tab
	Editing an Existing Assignment
	Creating a Bypass Assignment
	Creating a Controller Assignment

	The Command Center Window
	Creating a Command Center Assignment
	HX Preset, Snapshot, and Looper Commands
	Customizing a Footswitch Label
	Customizing a Footswitch LED Color

	Global EQ Window
	Adjusting Global EQ Parameters

	Preferences and About Box
	The Preferences Window
	The About/Legal Box and Help Options

	Marketplace & Account Options
	Marketplace
	The My Account Menu Options
	Sign In / Sign Out
	Authorize / Deauthorize Your Computer

	Model Lists
	Effects Models
	Amp Models
	Speaker Cabinet Models
	Cab Models
	Microphone Models
	Legacy Cab Models
	Legacy Microphone Models

	Keyboard Shortcuts
	Command Center, Global EQ & Preferences Window Shortcuts
	Additional Mouse Behaviors

	Updater & Additional Resources
	HX Edit and Device Firmware Updater
	Using the Line 6 Updater App
	Additional Resources


